SAS® IT Resource Management 3.4 Reporting Guide
PART 1  Introduction to SAS IT Resource Management and Batch Reporting  1

Chapter 1 • About SAS IT Resource Management  ............................................. 3
Benefits of Using SAS IT Resource Management ...................................... 4
How Does SAS IT Resource Management Work? ..................................... 4
How to Locate Documentation and Help for SAS IT Resource Management .... 6

Chapter 2 • About Batch Reporting ................................................................. 9
Overview of How SAS IT Resource Management Works to Create Batch Reports ... 9
Overview of Batch Reporting ......................................................................... 10
Reporting Components across SAS Products and Applications .................... 14

Chapter 3 • Working with the Adapter Setup and Add Domain Category Wizards .... 19
What Are the Adapter Setup and Add Domain Category Wizards? ................ 19
How to Use the Adapter Setup or Add Domain Category Wizards ................. 20
Reporting Jobs and Objects Created by the Adapter Setup and
Add Domain Category Wizards .................................................................... 20
Using Domain Categories ........................................................................... 24
Types of Reports That the Adapter Setup and Add Domain
Category Wizards Create ............................................................................ 25
Viewing Batch Reports ................................................................................ 25

Chapter 4 • Exception Reporting .............................................................. 27
About Exception Reports .............................................................................. 27
Sample Exception Reports ......................................................................... 28

PART 2  Working with Batch Reports  29

Chapter 5 • About Creating and Modifying Batch Reports ......................... 31
Why Create or Modify Batch Reports? ....................................................... 31
How to Create or Modify Your Own Batch Reports ...................................... 31

Chapter 6 • Working with Supplied SAS Enterprise Guide Projects ............... 45
About SAS Enterprise Guide Projects ......................................................... 45
Preparing to Work with SAS Enterprise Guide ......................................... 50
How to Modify a Report in a Supplied SAS Enterprise Guide Project .......... 58

Chapter 7 • Working with the ITRM Report Definition Task in SAS Enterprise Guide .... 61
# Contents

### Chapter 8 • Working with Report Jobs and Performance Report Transformations
- About Report Jobs .................................................. 71
- Working with Report Jobs ........................................... 73
- About Performance Report Transformations ..................... 76
- Working with Performance Report Transformations ............. 78
- Specifying a Data Source Location .................................. 92
- About Templates and Style Sheets ................................. 93
- Working with Templates and Style Sheets ........................ 94

### Chapter 9 • Working with ITRM Report Center
- What Is ITRM Report Center? ....................................... 97
- Accessing ITRM Report Center Interface .......................... 100
- How to Get Help and Documentation for ITRM Report Center 101
- Features of ITRM Report Center .................................. 102

### PART 3 Report Administration 107

#### Chapter 10 • Administrative Tasks
- Overview of Administrator Tasks .................................... 109
- Working with the SAS Content Server ............................. 110
- Administrator Tasks ................................................. 110

### PART 4 Interactive Reporting and Using the SAS Portal and SAS BI Dashboard 125

#### Chapter 11 • About Interactive Reporting
- Overview of Interactive Reporting .................................. 127

#### Chapter 12 • Using SAS Enterprise Guide Interactively
- Overview of SAS Enterprise Guide ................................. 129
- Accessing SAS IT Resource Management Projects with SAS Enterprise Guide 130
- Locating SAS Enterprise Guide Documentation .................. 131

#### Chapter 13 • Using SAS Web Report Studio Interactively
- Overview of SAS Web Report Studio .............................. 133
- Access SAS IT Resource Management Information Maps to
  Generate a Report in SAS Web Report Studio .................. 135
- E-mailing SAS IT Resource Management Reports ................ 136
- Locating SAS Web Report Studio Documentation ............... 137

#### Chapter 14 • Using SAS Add-In for Microsoft Office Interactively
- SAS Add-In for Microsoft Office and SAS IT Resource Management Data 139
- Using SAS Add-In for Microsoft Office to Access SAS IT
  Resource Management Data ....................................... 140

#### Chapter 15 • Using SAS Portal for Communicating IT Domain Intelligence
- Overview of SAS Information Delivery Portal ................... 143
- Locating SAS Information Delivery Portal Documentation .... 146
Chapter 16 • Using SAS BI Dashboard ........................................... 147
  Overview of SAS BI Dashboard ........................................... 147
  Locating SAS BI Dashboard Documentation ......................... 149

Chapter 17 • Working with SAS Visual Analytics ............................ 151
  SAS Visual Analytics ....................................................... 151

PART 5  Appendixes  .......................................................... 153

Appendix 1 • Naming Standards for Reporting Objects .................. 155
  About Naming Standards for SAS IT Resource Management Reporting Objects ........................................ 155
  Naming Standards and Location of Objects ............................ 155

Appendix 2 • Reporting Standards for SAS IT Resource Management Reports .............................. 161
  About Reporting Standards for SAS IT Resource Management Reports ................................................. 161
  Standards for SAS IT Resource Management Report Elements ............................................ 162
  Standard Specifications for Report Tasks ............................... 166

Appendix 3 • Troubleshooting and Debugging Tips ......................... 169
  How to Verify the SAS IT Resource Management Enterprise Guide Installation and Configuration .................. 170
  Why SAS Enterprise Guide Reports Do Not Display Correctly .......................................................... 172
  Why Are Reports Missing from ITRM Report Center? ........................................................... 179
  Why Report Jobs Are Not Generating Reports ......................... 182
  Removing Duplicate Reports That Are Stored in the SAS Content Server .............................................. 184
  Error Message: Select a SAS Content Server .......................... 184
  How to Debug a Middle-tier Connection Problem in a Report Job .................................................. 185
  How to Access ITRM Report Center Reports in the SAS Content Server ........................................... 186
  How to Refresh the Cache for ITRM Report Center Reports .................................................. 187
  How to Back Up Reports ..................................................... 187
  Technical Support ............................................................. 187

Appendix 4 • Best Practices ....................................................... 189
  Run Report Jobs at Night or during Low Usage Periods ............................... 189
  Add a User-Defined Report Occurrence to ITRM Report Center .................................................. 190
  Managing SAS Enterprise Guide Projects for SAS IT Resource Management ........................................ 192
  Designing Reports for Batch Jobs ........................................ 195
  Create Tile Charts with Web Links ....................................... 195
  Override Report Expiration Dates to Purge Reports from the SAS Content Server .................................. 196
  Back Up Your Data and Reports ......................................... 196
  Schedule Report Jobs Based on the Available Data .................... 196
  Override the Graph Type ................................................ 197

Appendix 5 • Setting Up Web Links in Tile Charts ........................... 199

Appendix 6 • Report Conversion Guide ......................................... 205
  Converting Reports ........................................................ 206
  Creating Bar and Pie Charts Using SAS Enterprise Guide .................... 213
  Creating Line and Other Plots Using SAS Enterprise Guide ...................... 225
  Creating Tabular Reports Using SAS Enterprise Guide ...................... 237
  Working with SAS IT Resource Management ...................................... 246

Index ................................................................. 249
About This Book

Audience

The purpose of the *SAS IT Resource Management: Reporting Guide* is to present all topics that are related to SAS IT Resource Management reporting. For information about system administration and data preparation topics, see the *SAS IT Resource Management: Administrator's Guide*.

The *SAS IT Resource Management: Reporting Guide* is designed for the following users:

- Performance analysts are responsible for analyzing IT performance data and communicating the results of this analysis. Performance analysts use SAS IT Resource Management to design and create reports for the purposes of IT performance management and capacity planning.

  These users understand how to analyze the IT resource measurement data that is managed by data administrators. They analyze this data to measure the utilization, availability, and performance of IT resources. They also plan the proper adjustments to the IT infrastructure to meet the current and projected demands of the business. Performance analysts often function as capacity planners, system administrators, and business analysts. Their job responsibilities require them to analyze data and to communicate IT intelligence by designing, generating, sharing, and viewing reports.

  Performance analysts typically use the documentation that is found in this reporting guide. They might also refer to all SAS IT Resource Management documentation or SAS product documentation for those products that are included in the SAS IT Resource Management solution such as SAS Enterprise Guide.

- Information consumers are responsible for analyzing report data and making decisions based on that data.

  These users are business people who are interested in the overall performance aspects of IT at a company. They often function as system architects, IT managers, and IT executives. Information consumers use the reports that are generated by SAS IT Resource Management to support decisions that they make regarding the IT infrastructure. They need to access IT intelligence reports from the office as well as from remote locations.

  Information consumers typically use the documentation that is found in this reporting guide, especially the sections about interpreting reports and using SAS Web Report Studio. They might also refer to the *Introduction to SAS IT Resource Management* and the *SAS IT Resource Management 3.4: Report Center Guide*.

- Data administrators are responsible for administering the IT data mart and setting up the jobs that stage and aggregate IT performance data so that report-ready data is available for generating reports.
These users are responsible for administering the IT data mart and adapters; handling the extract, transform, and load (ETL) processes; and managing reporting processes. Data administrators typically deploy and schedule the batch production jobs that prepare and generate IT performance reports. They often function as IT performance managers and capacity planners.

Data administrators primarily use the documentation that is found in the *SAS IT Resource Management: Administrator's Guide*. They might also refer to all SAS IT Resource Management documentation or SAS product documentation for those products that are included in the SAS IT Resource Management solution such as SAS Enterprise Guide.

**Requirements**

Here are the prerequisites for using SAS IT Resource Management:

- A user ID and password that is appropriate for the type of access that is needed to accomplish designated IT Resource Management functions.

  *Note:* Data administrators use SAS Management Console to define the logins for users and groups of users, based on their roles and the SAS products with which they need to work. For more information, see the “Preparing to Work with the SAS IT Resource Management Client” chapter in the *SAS IT Resource Management: Administrator’s Guide*.

- An operating environment that includes a supported client, middle tier, and server.

- Depending on your role, you might need access to SAS software that is used by SAS IT Resource Management.

  *Note:* To log on to the SAS products in the following list, select **Programs ⇒ SAS**. From the list of software that is displayed, select the application that you want to work with. Then enter your user ID and password.

  - SAS IT Resource Management

    *Note:* The SAS IT Resource Management solution provides additional IT-specific features and functionality to the data management capabilities of SAS Data Integration Studio. These additional features and functions are seamlessly integrated with those of SAS Data Integration Studio. The enhanced capabilities of SAS Data Integration Studio that are delivered by SAS IT Resource Management are commonly referred to as the SAS IT Resource Management client, throughout this document.

  - SAS Information Map Studio
  - SAS Enterprise Guide with add-in for SAS IT Resource Management
  - SAS Management Console
  - SAS Add-In for Microsoft Office

You might also want to access SAS products that are web-based.

  *Note:* To log on to the SAS products in the following list, open your web browser and point it to the URL address of the product that you want to use.

  - *SAS IT Resource Management 3.4: Report Center*, referred to as ITRM Report Center throughout the remainder of this document
  - SAS Web Report Studio
• SAS BI Dashboard
• SAS ID Portal

Online Help is available for all SAS software. Click **Help** within the product in order to access it. In addition, documentation for SAS software is available at [http://support.sas.com/documentation/index.html](http://support.sas.com/documentation/index.html). Use the A-Z index to locate the documentation that you want to access.
About This Book
Accessibility

Accessibility Notice

SAS IT Resource Management includes the following accessibility and compatibility features that improve usability of the product for users with disabilities. These features are related to accessibility standards for electronic information technology that were adopted by the U.S. Government under Section 508 of the U.S. Rehabilitation Act of 1973, as amended.

If you have questions or concerns about the accessibility of SAS products, send e-mail to accessibility@sas.com.

SAS IT Resource Management addresses several areas of 508 compliance:

- Software accessibility compliance applies to software.
  In SAS IT Resource Management, software accessibility compliance applies to the SAS Data Integration Studio user interface. SAS IT Resource Management uses the functionality of SAS Data Integration Studio for data manipulation functions. As such it has the same accessibility features as that product. For information about these features, see the SAS Data Integration Studio: User's Guide. This documentation is located at this address: http://support.sas.com/documentation/index.html. Use the Product Index A-Z to locate this document.

- Windows accessibility compliance applies to Windows applications, such as SAS Enterprise Guide and SAS Add-In for Microsoft Office.
  SAS Enterprise Guide conforms to accessibility standards for the Windows platform. In addition, SAS Enterprise Guide has keyboard shortcuts for the following areas: the Import Data task, the main workspace, menus, the project tree, a process flow, the properties window for an object, and the code editor. For more information, see the Keyboard Shortcuts in the Help for SAS Enterprise Guide.
  You can also use keyboard navigation to navigate through the options in a drop-down list by pressing Alt and the up and down arrow keys.
  In some instances, you can use the Enable accessibility features option. This option makes additional accessibility features available in the task windows and the windows that appear when you run a stored process. This option is available from the Options dialog box.


  - Documentation about SAS Add-In for Microsoft Office is located at this address: http://support.sas.com/documentation/onlinedoc/addin/index.html.
For information about the accessibility of this product, see Accessibility Features of *SAS IT Resource Management 3.4: Report Center Guide* at [http://support.sas.com](http://support.sas.com).

Web accessibility compliance applies to browser-based content and web-based applications, such as SAS Web Report Studio, SAS ID Portal, SAS BI Dashboard.

To locate the appropriate documentation for a SAS product, use the A-Z index at this location: [http://support.sas.com/documentation/index.html](http://support.sas.com/documentation/index.html).
Recommended Reading

• *SAS IT Resource Management: Overview*
• *SAS IT Resource Management: Administrator’s Guide*
• *SAS IT Resource Management: Report Center Guide*
• *SAS IT Resource Management: Migration Guide*
• *SAS IT Resource Management Adapter for SAP: User’s Guide*

For a complete list of SAS books, go to support.sas.com/bookstore. If you have questions about which titles you need, please contact a SAS Book Sales Representative:

SAS Books
SAS Campus Drive
Cary, NC 27513-2414
Phone: 1-800-727-3228
Fax: 1-919-677-8166
E-mail: sasbook@sas.com
Web address: support.sas.com/bookstore
Recommended Reading
Part 1

Introduction to SAS IT Resource Management and Batch Reporting

Chapter 1
  About SAS IT Resource Management ........................................... 3

Chapter 2
  About Batch Reporting ............................................................... 9

Chapter 3
  Working with the Adapter Setup and Add Domain Category Wizards ........................................... 19

Chapter 4
  Exception Reporting ................................................................. 27
Chapter 1
About SAS IT Resource Management

What Is SAS IT Resource Management?

SAS IT Resource Management is an IT performance management and capacity planning solution that enables the analysis of any IT data source. The solution creates an IT performance data warehouse, and delivers and applies the advanced analytic capabilities of SAS to that warehouse for the purposes of IT performance management, capacity planning, and exception analysis. It renders the IT Intelligence necessary to optimize the IT infrastructure. In addition, the solution leverages the IT performance data warehouse and the SAS product capabilities that are included in the solution for purposes beyond the scope of IT performance management such as IT financial management or IT service management. With SAS IT Resource Management, IT departments can manage and plan the usage of their resources to provide a stable yet scalable IT environment for its current and future operations.

To meet the challenges of today’s competitive business environment, the IT department must solicit information from the leaders of the business about the demands that directly affect the IT infrastructure. Concurrently, the IT department must deliver enough information about the performance, capacity, and exceptional conditions of IT resources to allow the business’s decision makers to understand and evaluate their current consumption of IT. As such, the communication of IT performance and capacity information must be in a language and format that is suitable for its intended purpose and audience. It is the role of IT performance management and capacity planning software to facilitate this communication so that the IT department can plan and implement adjustments to the IT infrastructure. In the end, this ensures that the business remains competitive and responsive to its customers.
Benefits of Using SAS IT Resource Management

SAS IT Resource Management can be used to resolve a variety of systems management challenges within an organization. It provides the functionality to do the following tasks:

- Establish IT data marts that contain all the resource management data, over various periods of time, that is associated with an enterprise.
- Define and create aggregated data that is specific to a site's analysis and reporting requirements.
- Create common references to common measurements that are available in disparate data sources. This ensures that the IT data mart provides an independent set of measurements that can be analyzed across the IT enterprise.
- Provide graphical and textual reports that contain information that is needed to manage current day IT operations.
- Use SAS IT domain knowledge for performance management, capacity planning, IT resource forecasting, peak period and seasonality analysis, workload analysis, and enterprise IT performance summaries. This information complements existing IT utilization, availability, and performance analysis capabilities.
- Provide exception analysis processing and reporting in order to discover anomalies within the data source.
- Provide a variety of report output mediums to accommodate the needs of the data administrators, performance analysts, and high-level information consumers.

How Does SAS IT Resource Management Work?

SAS IT Resource Management supports adapters for many of the most popular network system and application management tools across the Windows, UNIX, and z/OS operating environments. It also provides the tooling for the creation of user-written adapters for any data source that is not natively supported by the solution. In doing so, it takes advantage of SAS®9 and the enterprise-class solutions that SAS 9 provides, such as these solutions:

- SAS Data Integration Studio
  This solution provides flexible data integration and specific IT Resource Management services for most data sources. These services perform most of the data preparation and aggregation work that is needed to analyze and report on resource performance. These services enable you to perform the following tasks:
  - Create and maintain the IT data marts that are the containers for the staging, aggregation, information map, exception, and report jobs. Create and maintain the staged tables and libraries, the aggregation tables and libraries, the information maps, report definitions, and exception definitions that are created by or used by SAS IT Resource Management.
  - Create, maintain, and deploy the jobs that populate the IT data mart.
  - Calculate new columns and statistics, percentiles, percent changes, and so on, from the input data.
• Create and run the jobs that aggregate the data.
• Create analysis and report-ready data sources from the aggregated data.
• Create and run jobs that produce IT intelligence and exception reports.
• SAS Enterprise Guide

This solution provides comprehensive reporting definition services. Report tasks can be run interactively in SAS Enterprise Guide projects by running the branches of a project that include those report tasks.

Each SAS Enterprise Guide project that is supplied by SAS IT Resource Management includes one or more ITRM Report Definition tasks. ITRM Report Definition tasks publish the report definitions to the SAS Metadata Server. The SAS IT Resource Management client can include that report definition in a report job. Those jobs are then deployed and scheduled for execution in batch mode. The resulting report output can be accessed by ITRM Report Center.

• ITRM Report Center

This web-based application manages and organizes report output that is stored in the SAS Content Server. Filters are available to use in organizing the report output in galleries.

ITRM Report Center provides access to Home, Gallery, Resource, and Administration workspaces. These workspaces enable users and administrators to manage reports, galleries, resources, and to administer the SAS IT Resource Management the SAS Content Server.

• SAS Business Intelligence Platform

This platform uses the SAS Foundation technology, which includes the following software: Base SAS, SAS/GRAPH, the Output Delivery System (ODS), and other technologies. It also uses the following components:

• SAS Information Map Studio: This product provides easy access to data using business-oriented terminology. Information maps that are created by the information map transformation in the SAS IT Resource Management client can be read and modified by SAS Information Map Studio.

• SAS Metadata Repository: This repository of centralized metadata stores information about the objects that are created and used by SAS IT Resource Management. These objects include IT data marts, ETL jobs, information maps, report tasks, report jobs, and more.

• SAS Web Report Studio: This web-based, interactive query and analysis tool simplifies and standardizes access to and reporting of performance information.

• SAS Information Delivery Portal: This customizable portal provides corporate decision makers with easy access to the data that is most pertinent to them by means of reports and dashboards. This data includes key performance indicators (KPIs), filter reports, and more. SAS Information Delivery Portal enables the selective and secure dissemination of information throughout an organization.

• The BI Dashboard is a web-based interface that is displayed within SAS Information Delivery Portal. Using data and information maps from multiple sources, information consumers and performance analysts users can create dashboards that display information that is pertinent to their areas of interest.

• SAS Add-In for Microsoft Office: This product enables integration with commonly used Microsoft products such as Microsoft Word and Microsoft Excel.
SAS Statistics, High-Performance Forecasting, and Econometric Time Series: These solutions provide a complete set of SAS statistical methods for IT data analysis.

For more information, see Chapter 1, "General Overview" in SAS IT Resource Management 3.4: Administrator's Guide.

How to Locate Documentation and Help for SAS IT Resource Management

Accessing SAS IT Resource Management Online Help

Online Help is available for anyone who performs tasks with the user interface.

Note: The Help that is provided with this release of the SAS IT Resource Management software briefly describes the fields on the windows that are specific to IT Resource Management.

To display the field-based Help window for an active window or tab, click Help or press the F1 key. To search for topics about concepts or features that are identified by specific words, such as "information maps," click the Search tab (magnifying glass icon) in the Help window. Enter the text to be found and press the Enter key.

Online Help is available for all SAS technology products on which SAS IT Resource Management is built.

Accessing SAS IT Resource Management Documentation

The following SAS IT Resource Management documentation is available from http://support.sas.com/itrm:

• What's New in SAS IT Resource Management

This document provides a brief description of the new features that are included in this release of the SAS IT Resource Management software and documentation.

• SAS IT Resource Management 3.4: Overview

This document provides information about the extensive domain intelligence that is available with SAS IT Resource Management.

The audience for this introductory document is anyone who works with SAS IT Resource Management or who uses the reports that are generated by the software.

• SAS IT Resource Management 3.4: Administrator's Guide

This document contains detailed information about the tasks that are required to set up and manage the IT data mart. It also describes how to set up the IT Resource Management adapters so that they can process the IT resource data that is stored in the IT data mart. This guide provides information about how to set up and maintain IT data marts. It also describes how to work with simple and summarized aggregations, information maps, and the wizards, especially the Adapter Setup and the Add Domain Category wizards. These wizards facilitate the specification of the extract, transform, and load (ETL) processes that are required for administering a site's IT resource data. The guide also provides information about exception analysis processes that enable the discovery and reporting of anomalies within the specified data source.
This document provides information about the other functional components of the software, such as the SAS Metadata Repository (SMR) and the like.

The audience for this document is SAS IT Resource Management data administrators or capacity planners.

- **SAS IT Resource Management 3.4: Reporting Guide**
  
  This document contains detailed information about the tasks that are required to generate, view, and manage reports. It describes how to work with the ITRM Report Definition task in SAS Enterprise Guide, the Performance Report transformations that are available from the SAS IT Resource Management client, and the ITRM Report Center application. It also provides general information about other SAS products that support the reporting processes, such as SAS Web Report Studio, SAS Information Delivery Portal, and SAS Add-in for Microsoft Office.

  A “Report Conversion” appendix provides a description of the steps that are performed in order to re-create reports that were generated using SAS IT Resource Management 2.7 report macros. These steps use SAS Enterprise Guide, which is included in SAS IT Resource Management. Separate instructions are provided for converting report macros to the current version of SAS Enterprise Guide.

- **SAS IT Resource Management 3.4: Report Center Guide**

  This document contains detailed information about the tasks that are required to view, organize, filter, and share SAS IT Resource Management performance and exception reports.


  This document contains detailed information about the tasks that are required to install, customize, and use the SAS IT Resource Management adapter for SAP.

- **System Requirements—SAS IT Resource Management**

  This document provides a list of the requirements needed to support the server tier, middle tier, and client tier for SAS IT Resource Management.

- **SAS IT Resource Management 3.4: Migration Guide**

  This document provides a description of the steps that are performed in order to move a site's processing from the earlier versions of the software to the current version.

- **Demand Technology Performance Sentry Data Collection Sets for SAS IT Resource Management**

  This HTML resource contains data collection sets for ITRM Windows Server and ITRM Exchange.

- **SAS IT Resource Management 3.4: Supplied Staged and Aggregation Tables for Supported Adapters**

  This HTML resource contains detailed information about the columns of the staged tables and aggregation tables that are generated by the Adapter Setup and the Add Domain Category wizards.

- **SAS IT Resource Management 3.4: Supplied Report Samples**

  *Note:* Information about the system requirements, supported adapter metrics, and the SAS IT Resource Management data models is also available at [http://support.sas.com/itrm](http://support.sas.com/itrm).

  Documentation is available for the business intelligence and data integration components of the SAS Intelligence Platform and all the SAS products that are referenced in this
document. To access this documentation, navigate to the website at this location: http://support.sas.com/documentation/onlinedoc/index.html. On this page, use the Select a Product drop-down menu to choose the documentation for the product or solution that you want to view. Then click Go.
Chapter 2

About Batch Reporting

Overview of How SAS IT Resource Management Works to Create Batch Reports ........................................... 9

Overview of Batch Reporting .......................................................................................................................... 10
  Batch Reporting Architecture ....................................................................................................................... 10
  Information Map ........................................................................................................................................... 12
  SAS Enterprise Guide Project ....................................................................................................................... 12
  ITRM Report Definition Task ...................................................................................................................... 12
  Report Definition ......................................................................................................................................... 12
  Performance Report Transformation ........................................................................................................... 13
  Report Job ................................................................................................................................................... 13
  Report Output .............................................................................................................................................. 13
  SAS Content Server .................................................................................................................................... 13
  ITRM Report Center .................................................................................................................................... 13

Reporting Components across SAS Products and Applications ................................................................. 14

Overview of How SAS IT Resource Management Works to Create Batch Reports

SAS IT Resource Management provides the processes and the supporting technology that are required to regularly collect, aggregate, analyze, and report on the IT performance evaluation data that is vital to the health of an enterprise.

The processes that gather and monitor IT performance evaluation data consist of the following steps.

Prepare IT performance data for reporting:
  1. Collect the raw data about a resource.
  2. Process (stage) the raw data.
  3. Aggregate the data from the staged tables.
  4. Generate information maps.

Generate and analyze IT reports:
  5. Define and generate the reports.
  6. View the reports.
The first four steps in the preceding process prepare your IT performance data for reporting. The *SAS IT Resource Management: Administrator’s Guide* provides detailed information about each of these processes and describes how a systems administrator might work with SAS IT Resource Management to prepare raw IT data for reporting.

*Note:* You can also analyze staged or aggregation tables for exceptional conditions. This feature is optional.

The last two steps in the process make up the reporting process. These steps define the IT reports that you want to generate and enable you to view the report output to analyze your data. This book, the *SAS IT Resource Management: Reporting Guide*, provides detailed information about each of these processes and their components.

---

**Overview of Batch Reporting**

**Batch Reporting Architecture**

The Adapter Setup wizard in SAS IT Resource Management enables you to easily invoke and create the components that are needed for batch reporting on various adapters and domain categories. These reporting components are supplied by SAS IT Resource Management (such as supplied SAS Enterprise Guide projects and report definitions). Alternatively, these reporting components can be created when the Adapter Setup or the Add Domain Category wizard executes the reporting jobs that contain Performance Report transformations.
The following figure shows the basic components of the batch reporting process and how these components work together to create batch reports.

**Figure 2.1  Overview of Reporting Components and Batch Reporting Architecture**

Each component of the batch reporting process contributes to the final report output. It also specifies characteristics of the report such as its content, appearance, location, filters for viewing, and expiration date. You can use the supplied components and predefined process flows for your batch reports. You can also use these supplied components as templates to customize the supplied batch reports for your business needs or create your own batch reports with different reporting parameters.
The following topics in this section describe how each of the reporting components in the batch reporting architecture work together to generate IT reports and make them available for viewing. After you understand the function of each component, where it fits in the batch reporting architecture, and how it affects the other reporting components, then you can work with these components to create or modify your own batch reports if necessary.

**Information Map**

Information maps are data sources that include a collection of data items and filters that describe and present a report-ready view of your IT resource data. Information maps are stored in IT data marts.

Report definitions in the report jobs use information maps to locate and filter the physical data for report input. Pointers to information maps are also included in the SAS Enterprise Guide projects that SAS IT Resource Management supplies.

**SAS Enterprise Guide Project**

SAS IT Resource Management supplies SAS Enterprise Guide projects for several supported adapters and domain categories. These projects manage references to data, related report tasks, code, and report results that determine how data appears in the batch reports that the Adapter Setup or the Add Domain Category wizard creates.

An ITRM Report Definition task is appended to each branch of a project. This task extracts the generated code of the branch and additional metadata to include it in a report definition that it creates and saves on the SAS Metadata Server. The report definition can be used by Performance Report transformations that are in report jobs.

**ITRM Report Definition Task**

The ITRM Report Definition task is the last component of a supplied SAS Enterprise Guide project process flow. The ITRM Report Definition task specifies the filters and metadata that are used to view the report output in ITRM Report Center. When run, the ITRM Report Definition task creates a report definition that includes all of the metadata and SAS code from a given branch of your SAS Enterprise Guide project. The report definition also includes the filters and additional metadata that are specified in the task.

The resulting report definitions are saved on the SAS Metadata Server and used by Performance Report transformations that are in report jobs.

**Report Definition**

A report definition is created by an ITRM Report Definition task and stored in the SAS Metadata Server. It contains the SAS code that defines one or more reports. Report definitions include the metadata values that can be used as filters to subset reports in ITRM Report Center. These properties are specified in the ITRM Report Definition task that creates the report definition. The properties include filter values for domain category, domain subcategory, job schedule frequency, and possibly other keywords that might be specific to the report.

The Performance Report transformation is a component of a SAS IT Resource Management report job. It identifies the report definitions that are used to create the report output when the job is run.
**Performance Report Transformation**

Performance Report transformations are part of the report jobs that support the reporting functions of SAS IT Resource Management. A Performance Report transformation specifies how to group together report definitions that generate reports. It stores output in the SAS Content Server. A Performance Report transformation can also adjust the expiration date of report output. It can do this by overriding the parameter that is specified in the associated report definitions.

When executed, the report job that contains the Performance Report transformation uses the report definitions that the transformation identifies in order to generate report output.

**Report Job**

Report jobs consist of Performance Report transformations. When executed, these transformations generate SAS code that creates reports from the report definitions that are identified in the Performance Report transformation. The report jobs are stored in the IT data mart. They create and delete report output.

**Report Output**

Report output is the report that the report job creates when it is executed. The reports are stored in folders in the SAS Content Server. This server is used by SAS IT Resource Management for remote content management. The SAS Content Server stores report content and the associated report properties. It also provides version control and distribution of the stored reports.

After the SAS IT Resource Management reports are available in the SAS Content Server, you can use ITRM Report Center to view the reports.

**SAS Content Server**

The SAS Content Server is a content repository where SAS IT Resource Management stores reports and report metadata that is the output of report jobs. These report jobs include Performance Report transformations that specify the repository folder path, relative to the SAS Content Server, in which to store the reports. These reports are generated and stored in the SAS Content Server in corresponding subfolders of the `sasdav/` folder.

*Note:* The SAS Content Server also stores exception reports that result from exception analysis jobs that detected exceptional conditions.

**ITRM Report Center**

ITRM Report Center is a web-based application that enables you to view and organize the SAS IT Resource Management performance and exception reports that are available in the SAS Content Server.
When working with batch reporting for SAS IT Resource Management, you might need to work with several of the reporting components that are described in this chapter. These components are accessible in various SAS products and applications that you use to create, modify, and view SAS IT Resource Management reports.

For example, to modify a supplied report might require that you access ITRM Report Center, SAS Enterprise Guide, and the SAS IT Resource Management client to complete modifications for the reporting process. Access to these clients enable you to do the following tasks:

- view the properties of a report in ITRM Report Center
- identify the reporting components that correspond to that report
- modify the reporting components as needed

For more information, see “How to Create or Modify Your Own Batch Reports” on page 31.

The Report Properties dialog box of the Performance Report transformation can be accessed from the Report Definitions tab of that transformation. It displays the SAS Enterprise Guide project, process flow, and Report Definition task names. It also provides the domain category and information map (the data source from which the report is generated) that are associated with a report. This report metadata enables you to locate the corresponding SAS Enterprise Guide project, process flow, information map, and ITRM Report Definition task from which the report was designed and created. This report metadata also enables you to use the SAS IT Resource Management client to locate the domain category, information map, report job, and Performance Report transformation that are created and deployed to produce the report.

The following three figures show the relationships of these reporting components as they are represented in each of the SAS products and applications that you might use to identify and specify them.
In ITRM Report Center, click the properties icon to display the Expanded Report Properties.

**Figure 2.2** Expanded Report Properties Viewed in ITRM Report Center

<table>
<thead>
<tr>
<th>Domain Category</th>
<th>VMware_HostSystem</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT data mart name</td>
<td>VMwareSampleReports</td>
</tr>
<tr>
<td>job name</td>
<td>VMware-vCenter 2 HostSynByCluster Daily Reporting</td>
</tr>
<tr>
<td>SAS Enterprise Guide project name</td>
<td>VMware-HostSystem</td>
</tr>
<tr>
<td>information map or data source</td>
<td>Details:HostSynByCluster</td>
</tr>
<tr>
<td>SAS Enterprise Guide process flow name</td>
<td>Day,Job:Details:HostSystem</td>
</tr>
<tr>
<td>ITRM Performance Report transformation name</td>
<td>HostSynByCluster Daily</td>
</tr>
<tr>
<td>ITRM report definition name</td>
<td>HADR3MemoryHighUsageReportIntervalForTheDay</td>
</tr>
</tbody>
</table>

1. domain category
2. IT data mart name
3. job name
4. SAS Enterprise Guide project name
5. information map or data source
6. SAS Enterprise Guide process flow name
7. ITRM Performance Report transformation name
8. ITRM report definition name
Select the **Report Definitions** tab of the Performance Report transformation to view its properties.

**Figure 2.3** Properties of the Performance Report Transformation in the SAS IT Resource Management Client

1. domain category
2. IT data mart name
3. reporting job name
4. information map or data source
5. ITRM Performance Report transformation
6. ITRM report definition name

**Note:** Scroll down the Properties of report definition section of this dialog box to see the other properties of the Performance Report transformation. For example, you can see the SAS Enterprise Guide project name and the SAS Enterprise Guide process flow name.
Figure 2.4  Project and Process Flow in SAS Enterprise Guide

1  SAS Enterprise Guide project name
2  information map or data source
3  SAS Enterprise Guide process flow name
4  ITRM report definition task name

Note: To view comprehensive lists of the report properties for performance and exception reports, see Appendix 1, “Report Properties,” in the SAS IT Resource Management 3.4: Report Center Guide.
Chapter 2 • About Batch Reporting
Chapter 3
Working with the Adapter Setup and Add Domain Category Wizards

What Are the Adapter Setup and Add Domain Category Wizards? 19
How to Use the Adapter Setup or Add Domain Category Wizards 20
Reporting Jobs and Objects Created by the Adapter Setup and Add Domain Category Wizards 20
  About Reporting Jobs Created by the Adapter Setup Wizard and Add Domain Category Wizards 20
  How to Determine Whether the Adapter Setup Wizard or Add Domain Category Wizard Will Create Reporting Jobs for Your Selections 21
  Deploy and Run Jobs That the Adapter Setup or Add Domain Category Wizard Creates 23
Using Domain Categories 24
Types of Reports That the Adapter Setup and Add Domain Category Wizards Create 25
Viewing Batch Reports 25

What Are the Adapter Setup and Add Domain Category Wizards?

The SAS IT Resource Management client includes an Adapter Setup wizard and an Add Domain Category wizard. These wizards enable you to define and create staging, aggregation, information map, and reporting jobs that process the raw data for an IT resource. These jobs include predefined configurations that are based on industry intelligence that represents a best estimate about the types of aggregations and reports that most sites need for analysis.

The wizards create reporting jobs that produce reports that are good choices for many users. To examine the reports that SAS IT Resource Management provides, use a wizard to process a sample set of data and then create and run the resulting information map jobs and report jobs. You can then use ITRM Report Center to view the reports that are generated. Alternatively, you can view the sample reports on the SAS IT Resource Management website. To access these reports, navigate to this site: http://support.sas.com/documentation/onlinedoc/itsv/#itrm34. Then scroll down to the Samples of Supplied Reports section where the supplied sample reports are located.

If the supplied reports do not meet all of the specific reporting needs for your environment, you can identify the modifications that you want to make to the reporting
jobs. You can then work with the corresponding supplied SAS Enterprise Guide projects and reporting architecture to implement your modifications. For more information, see “How to Create or Modify Your Own Batch Reports” on page 31.

Note: Your site might not process data from any of the data sources for which SAS IT Resource Management provides an adapter. In that case, you can use an alternate data source to process a sample set of data to run the Adapter Setup wizard and view the reports that are generated. You can also view sample reports on the SAS IT resource Management product page, which is located here: http://support.sas.com/documentation/onlinedoc/itsv. To view the reports, scroll down to the Samples of Supplied Reports section of the page.

After the wizard creates the appropriate jobs, you can schedule and run each as needed. The jobs process the raw data in a manner that is specified by or based on a selected adapter and domain category.

For more information about using the Adapter Setup or the Add Domain Category wizard, see “How to Use the Adapter Setup or Add Domain Category Wizards”.

---

How to Use the Adapter Setup or Add Domain Category Wizards

The Adapter Setup and Add Domain Category wizards guide you through several steps that help define staging, aggregation, and reporting components. These components are used to create the ETL jobs that process your IT resource data.

The following information provides instructions for completing the wizards:

- For more detailed information about the Adapter Setup wizard, see “Creating Jobs Using the Adapter Setup Wizard” in Chapter 10 of SAS IT Resource Management: Administrator’s Guide.

- For more detailed information about the Add Domain Category wizard, see “Creating Jobs By Using the Add Domain Category Wizard” in chapter 11 of SAS IT Resource Management: Administrator’s Guide.

---

Reporting Jobs and Objects Created by the Adapter Setup and Add Domain Category Wizards

About Reporting Jobs Created by the Adapter Setup Wizard and Add Domain Category Wizards

The Adapter Setup and Add Domain Category wizards programmaticallly create reporting jobs for many of the domain categories and time periods that you select. These reporting jobs are named using the convention <domain subcategory> <time period> (such as Daily, Weekly, and Monthly) Reporting, and they are stored in the same domain category folder as the aggregation and information map jobs.

Reporting jobs include Performance Report transformations that use report definitions that also use information maps to generate reports using data for IT resources. When a reporting job executes, it creates the necessary report packages and reports based on the information maps that are in the same domain category folder. The reports are then
saved as tabular or graphic files (such as HTML or PNG files) in the Repository folder path of the SAS Content Server that you selected in the Adapter Setup or Add Domain Category wizards. For more information about the reporting jobs that the wizards create for specific domain categories and time periods, see “How to Determine Whether the Adapter Setup Wizard or Add Domain Category Wizard Will Create Reporting Jobs for Your Selections”.

**Note:** The metadata server and SAS Content Server must be running when reporting jobs execute or the jobs cannot generate output.

After a reporting job is deployed, scheduled, and executed, the resulting report output is available for viewing with ITRM Report Center. Among other features, this application enables you to access, filter, and manage your report content from a web browser. For more information, see “Working with ITRM Report Center” on page 97.

### How to Determine Whether the Adapter Setup Wizard or Add Domain Category Wizard Will Create Reporting Jobs for Your Selections

SAS IT Resource Management supplies predefined report definitions for several domain categories and time periods. These report definitions include information such as the names of the variables, the report style, and other attributes that are used to build tabular and graphical reports from your IT resource data. The Adapter Setup and Add Domain Category wizards use these prepackaged report definitions in the reporting jobs that they create for the domain categories and time periods that you select.

**Note:** The prepackaged report definitions that the Adapter Setup and Add Domain Category wizard jobs use were created by the supplied SAS Enterprise Guide projects. You might want to modify a report that the Adapter Setup or Add Domain Category wizard creates. Similarly, you might want to create your own report that is similar to one that the wizards create. If so, then you can use the corresponding supplied SAS Enterprise Guide project as a template. To do so, copy the supplied project and make the necessary modifications to create a modified report definition. For more information about how to complete this and other related tasks, see How to Create or Modify Your Own Batch Reports on page 31 and “Managing SAS Enterprise Guide Projects for SAS IT Resource Management” on page 192.

If you select a domain category and time period for which SAS IT Resource Management supplies report definitions, then the Adapter Setup or Add Domain Category wizard creates the appropriate reporting jobs. To determine whether the wizards are going to create reporting jobs for the domain category and time periods that you selected, view the Summary page of the wizard before you select Finish.
The Summary page lists the report jobs that the Adapter Setup and Add Domain Category wizard will create. It also shows the report definitions that the report jobs use, as shown in the following image:

**Display 3.1 Example of a Summary Page Listing Report Jobs**

Note: The Summary page also includes a note if no reporting jobs are to be created.

You can also determine whether the Adapter Setup or Add Domain Category wizard is going to create reporting jobs based on your selections. To do so, view the list of supplied report definitions for a given domain category and time period. If SAS IT Resource Management supplies report definitions for a given adapter, domain category, and time period, then the wizard creates a reporting job for those selections based on the configuration level that you selected. If there are no supplied report definitions for a given adapter, domain category, and time period, then the wizard does not create reporting jobs for those selections.

To view the supplied report definitions, perform the following steps:

1. In the Folders tree, select **Shared Data ➔ SAS IT Resource Management ➔ 3.4 IT Report Definitions**.
2. Select an <adapter> folder.
3. Select a <domain category> folder.
4. Select Supplied.
5. Select a <time period> folder.
You can also create your own report definitions, Performance Report transformations, and reporting jobs. You can also add reporting jobs for the domain categories and time periods for which the wizards do not create reporting jobs. Report definitions that you create should be stored in the **User Defined** folder within the domain category folder. For more information about how to create your own report definitions, see “About the ITRM Report Definition Task” on page 61.

If you decide to create your own reporting objects and jobs, maintain consistency and efficiency by using the same naming conventions and folder structure that SAS IT Resource Management uses for supplied reports. For more information, see Link to “How to Create and Modify Your Own Batch Reports” on page 31 and “Naming Standards and Location of Objects” on page 155.

### Deploy and Run Jobs That the Adapter Setup or Add Domain Category Wizard Creates

The Adapter Setup and the Add Domain Category wizards create jobs. You must run those jobs as needed. These jobs depend on one another to process the raw data for reporting.

The following list shows the types of jobs that the wizards create and the dependencies of each. Each job type in the list is dependent on the job type that precedes it.

1. staging job
2. aggregation job
3. information map job
4. reporting job
Jobs that run the Exception transformation can be created manually and run if the source table for that job has been successfully created.

For more information, see “Deploying and Running Report Jobs” on page 75.

Note: Based on your specifications, the Adapter Setup and Add Domain Category wizards might not create all four types of jobs (staging, aggregation, information map, and reporting) when they execute. For example, you might specify in a wizard to create only a staging job. Or, you might select a supported adapter for which the wizards do not create reporting jobs.

Using Domain Categories

Domain categories are categories of tables and related objects that are organized logically to represent subsets of the IT resource measurements that are available from an adapter. This organization helps you create reports from one or more related aggregation tables of IT performance measurements.

Note: The domain categories that the Adapter Setup or Add Domain Category wizard displays are not necessarily all of the available domain categories for an adapter. You can view all of the domain categories for an adapter by opening the Folders tree view and expanding Products ⇒ SAS IT Resource Management ⇒ Adapters ⇒ <adapter name> ⇒ IT Template Tables. The template tables are the metadata used to create staged tables and are grouped by domain category. All of the domain categories for an adapter are in this list.

The domain categories that are associated with an adapter vary based on the requirements and capabilities of each adapter. If SAS IT Resource Management provides aggregation and information map jobs for a given adapter, then the Adapter Setup and Add Domain Category wizards enable you to select the domain categories that you want to use. If an adapter does not have aggregation and information map jobs available from the wizard, then the wizard creates only a staging job.

You can manage system performance by selecting the specific domain categories that are essential to the performance management and capacity planning processes for your enterprise. The amount of time that the Adapter Setup or Add Domain Category wizard takes to create the resulting jobs varies based on the number of staged tables, aggregation jobs and tables, information map jobs, and reporting jobs that are generated for the domain categories that you select.

Note: The Adapter Setup and Add Domain Category wizards create ETL jobs based on the domain categories that you select. However, the domain categories for some adapters are divided further into domain subcategories. In these cases, the jobs that are created are based on the domain subcategories instead. This prevents jobs from being too large. When working with the ETL jobs that the wizard creates, you might notice that the jobs are categorized into these subcategories.

For more information about the types of jobs that the Adapter Setup and Add Domain Category wizards create for each adapter and domain category, see the “Jobs That the Adapter Setup and Add Domain Category Wizards Create for Domain Categories” appendix in the SAS IT Resource Management: Administrator’s Guide.
Types of Reports That the Adapter Setup and Add Domain Category Wizards Create

The Adapter Setup and Add Domain Category wizards provide a wide variety of report types that provide analytical intelligence about IT resources. These reports are designed and configured to show your IT data in a format that is visually appealing and accurate. The selection of a report type to communicate an IT domain intelligence fact is best made by understanding both the message and the audience for which that message is targeted.

Some of the reports that the wizards create include tabular and line plots, bar charts, tile charts (also known as tree maps), and bubble plots. For more information and examples of report types that the Adapter Setup and Add Domain Category wizards create, see the “Domain Intelligence Offered by SAS IT Resource Management” topic in the SAS IT Resource Management: Overview.

Viewing Batch Reports

The Adapter Setup and Add Domain Category wizards enable you to create reporting jobs that can be run to generate batch reports. These batch reports are saved in the SAS Content Server. To view, manage, and sort these reports, use ITRM Report Center.

ITRM Report Center is a web-based application that enables performance analysts and information consumers to access, filter, and manage galleries of report content. For more information about these and other features, see “Working with ITRM Report Center” on page 97.
Chapter 4
Exception Reporting

About Exception Reports

Exception reports are generated when an exceptional condition is detected in the source data. The condition that defines an exception is specified in an Exception transformation. That transformation enables you to specify the exception definition as well as other pertinent information such as filters, report parameters, report attributes, and more. For more information about this transformation, see Chapter 9, “Exception Analysis Processing” in the SAS IT Resource Management: Administrator’s Guide.

If an exception is detected, the Exception transformation generates two types of reports:

- An overview report lists the exceptions that were found. Here is an example of an expanded overview report:

  Display 4.1  Exception Analysis Overview Report

```
Exception Analysis Overview Report
For transformation: CPU Utilization For ITRM Servers

Low CPU Utilization (3)
OpSys=SunOS, Machine=meb4a
OpSys=SunOS, Machine=meb5a
OpSys=SunOS, Machine=meb6a

There are no documents associated with this transformation.

Generated on July 08, 2013 at 11:42:41 AM
```

- Individual reports provide graphs of the individual exceptions that were found. Here is an example of an individual report:

Sample Exception Reports
You can access these reports in ITRM Report Center.

Note: For more information, see Chapter 9, “Exception Analysis Processing” in the SAS IT Resource Management: Administrator’s Guide.

Sample Exception Reports

SAS IT Resource Management is installed with sample exception reports. The reports are located in a folder called \sasdev\SampleReports on the SAS Content Server. Log on to ITRM Report Center to view the exception reports. (The sample reports are identified by the “ITRMDomainIntelligence” domain category.)

For more information, see “Working with Sample Reports” in Chapter 3, “The Gallery Workspace” in the SAS IT Resource Management 3.4: Report Center Guide. This topic also includes information about how to create a gallery of sample exception reports.
Part 2

Working with Batch Reports

Chapter 5
    About Creating and Modifying Batch Reports  31

Chapter 6
    Working with Supplied SAS Enterprise Guide Projects  45

Chapter 7
    Working with the ITRM Report Definition Task in SAS Enterprise Guide  61

Chapter 8
    Working with Report Jobs and Performance Report Transformations  71

Chapter 9
    Working with ITRM Report Center  97
Chapter 5
About Creating and Modifying Batch Reports

Why Create or Modify Batch Reports?

The topics in this chapter describe the various ways that you can create your own batch reports or modify the batch reports that SAS IT Resource Management supplies. These topics also provide information about the reporting components that you must modify to perform various tasks and how to find detailed information about these components.

The recommended process to create or modify batch reports is to first run the Adapter Setup wizard and the jobs that it creates. This practice enables you to visually review the reports that SAS IT Resource Management offers.

Note: If you modify report definitions, remember to redeploy the associated jobs.

How to Create or Modify Your Own Batch Reports

Understanding the Batch Reporting Process

The batch reporting process consists of several reporting components that are interconnected within a process flow. The components of this process flow are specified and then executed in a standard sequence in order to generate batch reports. For an example of the reporting components and how they work together in the process flow, see “Overview of Batch Reporting” on page 10.

The Adapter Setup wizard and the Add Domain Category wizard enable you to automatically create and connect the reporting components for several adapters and domain categories that you select. However, you might choose to modify elements of
specific reports or add to the existing set of reports. SAS IT Resource Management enables you to do so by making each reporting component modifiable. You can make a copy of the supplied components and then modify the copies as needed to accommodate the reporting needs for your organization.

**TIP** When you modify or add a specific reporting component, you might need to modify the other reporting components downstream in the process flow to accommodate your change. For example, you might add an ITRM Report Definition task in a SAS Enterprise Guide project to create a new report definition. You must then add or modify a corresponding Performance Report transformation in the report job to specify the new report definition.

**Prepare to Create or Modify Your Own Batch Reports**

Before you decide to create or modify your own batch reports, visually review the reports that the Adapter Setup or Add Domain Category wizard creates. Then you can determine whether these reports meet your needs. To do so, perform the following steps:

1. In SAS IT Resource Management, run the Adapter Setup or Add Domain Category wizard for selected adapters and domain categories.
   
   For more information, see “How to Use the Adapter Setup or Add Domain Category Wizards” on page 20.

   **TIP** For best results, use more than one day of data that spans across the week and month boundaries. For example, include data that includes at least the last day of a week and month as well as the first day of the following week and month. This scope of data ensures that you can generate daily, weekly, and monthly reports. If you use data from one day only, then you cannot generate weekly or monthly reports.

2. Deploy and run the resulting jobs.
   
   For more information, see the “Jobs” chapter in the *SAS IT Resource Management: Administrator's Guide*.

3. In the *Gallery* workspace of ITRM Report Center, review the reports and identify the ones that you want to modify, if necessary. For more information, see “What Is ITRM Report Center?” on page 97.

**Modifying the Data Source**

**Ways to Modify the Information Map**

An information map is the data source for a batch report that is generated from Adapter Setup or Add Domain Category wizard report jobs. If you modify the information map for a batch report, then you might need to modify the other reporting components in the batch reporting process to accommodate your change throughout the process.

The following modifications to an information map do not require that you modify the other reporting components in the process:

- Modify an information map filter expression.
- Add or remove a data item or information map that is not used in any other currently deployed jobs or SAS Enterprise Guide projects.
The following modifications to an information map require that you also modify the corresponding SAS Enterprise Guide project, report definitions, and deployed jobs:

- Change the name of an information map or data item that is used in a SAS Enterprise Guide project that is in use or a report job that is currently deployed.
- Add a data item or information map filter that you want to use in a report.

For instructions about how to perform these tasks, see “How to Modify the Information Map”.

### How to Modify the Information Map

You might want to modify an information map in order to add a new filter or to modify a filter value. For example, you might want to change a “Top 10” filter to a “Top 20” filter. In addition, you might want to change data source or an information map in order to add a new calculated measure.

To modify the data source or information map that a batch report uses, perform the following steps:

1. Using ITRM Report Center, view or select the report for which you which to modify the information map and click the Properties icon [ ] . This action opens the Expanded Report Properties window.

#### Figure 5.1 Expanded Report Properties Viewed in ITRM Report Center

- **a** domain category
- **b** IT data mart name
- **c** job name
- **d** SAS Enterprise Guide project name
- **e** information map or data source
2. Note the following information:

**Domain Category**
The value in this field is an abbreviated representation of the adapter and the domain category that corresponds to the report and the reporting components that created it.

**IT Data Mart Name**
The value in this field is the name of the IT data mart that contains the report job.

**DataSource**
The value in this field is the name of the information map and information map transformation for the report.

3. In the SAS IT Resource Management client, navigate to the IT data mart and domain category that you noted in the previous step.

4. In the SAS IT Resource Management client, locate the IT data mart where the Adapter Setup or the Add Domain Category wizard stored the corresponding jobs for the report.

   For more information, see the “Adapter Setup Wizard” chapter or the “Add Domain Category Wizard” in the *SAS IT Resource Management: Administrator's Guide*.

5. Open the information map job for the domain category. In the job, locate the information map transformation that has the same name as the **DataSource** for the report.

6. Right-click the information map transformation and select **Properties**. The Properties dialog box appears and enables you to make modifications to the information map that the transformation creates when executed.

   For more information about working with information maps, see the “Information Maps” chapter in the *SAS IT Resource Management: Administrator's Guide*.

7. Redeploy and run the information map job.

8. Modify the other reporting components if necessary.

   For more information, see “Ways to Modify the Information Map” on page 32.

For more information about working with information maps in SAS IT Resource Management, see Chapter 10, “Information Maps” in the *SAS IT Resource Management: Administrator's Guide*.

### Modifying How Batch Reports Look

#### Ways to Modify How Batch Reports Look

SAS IT Resource Management supplies SAS Enterprise Guide projects that include several components such as report tasks and ITRM report definition tasks. The parameters that are specified in these components affect how batch reports look. These parameter specifications are included in the report definition that the Performance Report transformation identifies in the corresponding report job.
The following modifications require that you modify components in the SAS Enterprise Guide project, run the ITRM Report Definition task to create a new report definition, and then redeploy the report job:

- Change the title or footnote of a report.
- Change or add a data item in a report such as an analysis variable or a BY variable.
- Change the report style for one report.
- Change the graph format, style sheet, or colors for one report.

You might want to change the style sheet, the graph format, or the colors for all reports in the report job. If so, you can modify the Performance Report transformation only and then redeploy the report job.

For instructions about how to perform these tasks, see “How to Modify the Way a Specific Batch Report Looks”.

How to Modify the Way a Specific Batch Report Looks

To modify how a specific batch report looks, perform the following steps:

1. Using ITRM Report Center, view or select the report that you want to change, and click the Properties icon. This action opens the Expanded Report Properties window.

Display 5.1  Expanded Report Properties

2. Note the following information:

   **IT Data Mart Name**
   
   The value in this field is the name of the IT data mart that contains the report job.

   **Job Name**
   
   The value in this field is the name of the job that generates the report job.
Project
The value in this field is the name of the supplied SAS Enterprise Guide project that is associated with the report.

ProcessFlow
The value in this field is the page of the SAS Enterprise Guide project that is associated with the report. This page includes the ITRM Report Definition task that creates the report definition for the report.

Report Definition
The value in this field is the name of the report definition and the ITRM Report Definition task in SAS Enterprise Guide that creates the report definition for the report.

3. Navigate to the location on the client workstation where you installed SAS IT Resource Management. The projects are located at SASITResourceManagementSASEnterpriseGuideComponents\3.4. For example, if you installed SAS IT Resource Management on a 64-bit machine, the projects might be located at C:\Program Files\SASHome \SASITResourceManagementSASEnterpriseGuideComponents\3.4.

4. Copy the supplied SAS Enterprise Guide project that you want to modify.

**CAUTION:**
Modify a copy of a supplied SAS Enterprise Guide project only. Do not modify a supplied SAS Enterprise Guide project directly. The supplied SAS Enterprise Guide projects include specifications and IT domain intelligence that SAS IT Resource Management provides for reporting. If you modify supplied projects directly, then you will lose the specifications and benefits that these projects provide for future reference. Also, when SAS IT Resource Management provides project updates, your modifications are overwritten. For more information, see “Managing SAS Enterprise Guide Projects for SAS IT Resource Management” on page 192.

5. Verify that you have set up SAS Enterprise Guide and migrated your projects so that they can work with the SAS IT Resource Management 3.4 IT data marts. For more information about how to perform these tasks, see “About Preparing to Work with SAS Enterprise Guide” on page 50.

6. Review the Project Notes and Process Flow Notes for the project if they are available. You can use the information in these notes files to determine the types of reports that the project creates. They can help you understand the general conventions that are used to specify the reports.

7. Modify the reports in the copy of the supplied project. You can use the ProcessFlow and Report Definition properties that you identified previously to locate the specific branch of components in the project that affect the report.

For more information, see “Working with Supplied SAS Enterprise Guide Projects” on page 45.

8. Open the ITRM Report Definition task and click **Deploy** to run it and create an updated report definition.

**Note:** Report definitions that you create are stored in a User Defined folder. Report definitions that you create do not and should not overwrite the supplied report definitions that are in a Supplied folder.

For more information, see “Working with the ITRM Report Definition Task” on page 62.
9. Your modifications might have included adding a new report definition or changing the name of an existing report definition. If so, you must also update the Performance Report transformation in the corresponding report job to add the new report definition or specify the updated report definition with the new name.

For more information, see “Working with Performance Report Transformations” on page 78.

10. Using the IT Resource Management Client redploy and run the corresponding report job.

You can use the IT Data Mart Name and Job Name to locate the report job that you want to redeploy.

For more information, see “Deploying and Running Report Jobs” on page 75.

**How to Modify the Look of All Batch Reports That a Report Job Creates**

You might want to change only the style sheet, the graph format, or the colors for all reports that a report job creates. If so, you can modify the Performance Report transformation of the report job and redeploy the job. To do so, perform the following tasks:

1. In SAS IT Resource Management, locate the IT data mart where the Adapter Setup or the Add Domain Category wizard stored the report job that you want to modify.

   *Note:* If you do not know where the report job is stored, then you can use the Gallery workspace to view the properties for one of the reports that the report job creates. Use the Domain Category, Report Definition Task, IT Data Mart Name, and Job Name properties to deduce the IT data mart folder where the job is stored and the report definition that the report job uses to create the report. For more information, see “What Is ITRM Report Center?” on page 97.

   For more information, see the “What Does the Adapter Setup Wizard Create” topic in the SAS IT Resource Management: Administrator's Guide.

   *Note:* The Add Domain Category wizard creates the same type of objects as the Adapter Setup wizard.

2. Double click the report job to open it in the process flow window.


4. Click the Report Parameters tab. The parameters on this tab enable you to specify the style sheet and graph format that affect the look for all of the reports that the corresponding Performance Report transformation and report job create. You can create your own style sheet and design template to change the look of the report output. You can also specify the location for the ActiveX Control and the override location for temporary physical files on the server.

   For more information about designating the style sheet that a report uses, see “Working with Performance Report Transformations” on page 78.

5. Redeploy and run the report job.

   For more information, see “Deploying and Running Report Jobs” on page 75.
Modifying the Metadata for the Reports Generated by a Report Definition

About Modifying Report Definitions for Batch Reports
You might choose to create or modify report definitions for your batch reports if you want to perform the following tasks:

• Change the report content by adding or removing reports from the list of reports in the report definition.

• Change a setting or property that is used in a filter.

• Modify how a report graph looks (graph type) or how many instances of a report are kept (aging).

For more information, see “How to Modify a Report Definition for Batch Reports” on page 38.

How to Modify a Report Definition for Batch Reports
To modify the report definition for batch reports, perform the following steps:

1. Using ITRM Report Center, view or select the reports for which you which to modify a report definition.

2. Click the Properties icon. This action opens the Expanded Report Properties window.

Display 5.2 Expanded Report Properties

Note the following information:
Domain Category
The value in this field is an abbreviated representation of the adapter and the
domain category that corresponds to the report and the reporting components that
created it.

IT Data Mart Name
The value in this field is the name of the IT data mart that contains the report job.

Job Name
The value in this field is the name of the job that generates the report job.

Project
The value in this field is the name of the supplied SAS Enterprise Guide project
that is associated with the report.

Process Flow
The value in this field is the page of the SAS Enterprise Guide project that is
associated with the report. This page includes the ITRM Report Definition task
that creates the report definition for the report.

Report Definition
The value in this field is the name of the report definition and the ITRM Report
Definition task that creates the report definition for the report.

3. If you installed the supplied SAS Enterprise Guide projects, they can be accessed by
navigating to the location on a workstation where you installed the SAS IT Resource
Management client. The projects are located at $SASITResourceManagement\SASEnterpriseGuideComponents\3.4$. For
example, if you installed SAS IT Resource Management on a 64-bit machine, the
projects might be located at $C:\Program Files\SASHome\SASITResourceManagement\SASEnterpriseGuideComponents\3.4$.

4. In this folder, use the Project Name that you recorded in step 2 to locate and make a
copy of the supplied SAS Enterprise Guide project that you want to modify.

CAUTION:
Modify a copy of a supplied SAS Enterprise Guide project only. Do not
modify a supplied SAS Enterprise Guide project directly. The supplied SAS
Enterprise Guide projects include specifications and IT domain intelligence that
SAS IT Resource Management provides for reporting. If you modify supplied
projects, maintain a copy of the original supplied projects. Otherwise, you could
lose the specifications and benefits that these projects provide for future
reference. For more information, see “Managing SAS Enterprise Guide Projects
for SAS IT Resource Management” on page 192.

5. Verify that you have set up SAS Enterprise Guide and migrated your projects so that
they can work with the SAS IT Resource Management 3.4 IT data marts. For more
information about how to perform these tasks, see “About Preparing to Work with
SAS Enterprise Guide” on page 50.

6. Review the Project Notes and Process Flow Notes for the project if they are
available. You can use the information in these notes files to determine the types of
reports that the project creates. They can help you understand the general
conventions that are used to specify the reports.

7. In the copy of the supplied project, run the process flow and then modify the ITRM
Report Definition task that corresponds with the report.

For more information, see “Working with the ITRM Report Definition Task” on
page 62.
8. Select **Deploy** in the ITRM Report Definition task to create an updated report definition.

   *Note:* Report definitions that you create should be stored in a **User Defined** folder. Report definitions that you create do not and should not overwrite the supplied report definitions that are in a **Supplied** folder.

9. Your modifications might have included adding a new report definition or changing the name of an existing report definition. If so, you must also update the Performance Report transformation in the corresponding report job to add the new report definition or specify the updated report definition with the new name. Use the IT Resource Management client to do so.

   For more information, see “Working with Performance Report Transformations” on page 78.

10. Using the IT Resource Management Client redeploy and run the corresponding report job.

    You can use the IT Data Mart name, Domain Category name, and Job name to locate the report job that you want to redeploy.

    For more information, see “Deploying and Running Report Jobs” on page 75.

---

**Creating New Reports Using a Supplied Project as a Template**

**Why Use a Supplied Project as a Template When Creating New Reports?**

The batch reports that the Adapter Setup wizard and the Add Domain Category wizard jobs create include supplied report definitions that are based on IT domain intelligence. These reports also include standard and consistent styles, colors, and filters that are proven to improve legibility and report categorization in ITRM Report Center. All of these report definitions are specified in the supplied SAS Enterprise Guide projects that are used to create them for the batch reports. These SAS Enterprise Guide projects are supplied by SAS IT Resource Management and stored on the client workstation during installation.

You might want to create a new batch report that the Adapter Setup wizard jobs do not create. If so, use a supplied SAS Enterprise Guide project as a template to build the report definition for your new report. You can make a copy of the supplied project that is most closely associated with the type of report that you want to create. Then modify only the parameters that are necessary.

*TIP* The supplied SAS Enterprise Guide projects include standard titles, footnotes, axis statements, names, labels, styles, colors, and filters that SAS IT Resource Managements supports and recommends for a given adapter and domain category. Using these supplied projects as templates for the new reports that you create, enables you to maintain consistency among the reports that you create and those that SAS IT Resource Management provides.

For example, you might choose to create a new report using a supplied SAS Enterprise Guide project as a template if you want to perform the following tasks:

- Replicate reports for a domain category for which the Adapter Setup or the Add Domain Category wizards do not already provide reports.
- Create reports for a user-written adapter.
How to Create or Modify Your Own Batch Reports

For more information, see “How to Create New Reports Using a Supplied Project as a Template” on page 41.

**How to Create New Reports Using a Supplied Project as a Template**

To create a new report by using a supplied SAS Enterprise Guide project as a template, perform the following steps:

1. **Navigate to the location on the client workstation where you installed SAS IT Resource Management.** The projects are located at `SASITResourceManagementSASEnterpriseGuideComponents\3.4`. For example, if you installed SAS IT Resource Management on a 64-bit machine, the projects might be located at `C:\Program Files\SASHome\SASITResourceManagementSASEnterpriseGuideComponents\3.4`.

2. **Identify the supplied SAS Enterprise Guide project that most closely resembles the type of adapter and domain category that you want to work with.** You can use one of the following two methods to determine the supplied project that is most appropriate for your new reports:
   - **Use the supplied project that corresponds to the adapter and domain category for your new report.** The name of each supplied project begins with the adapter name followed by the domain category. For example, if you are creating a report for the DT Perf Sentry adapter and the Server Disk domain category, then you might choose the `DTPerfSentryServerDisk.egp` supplied project.
   - **Use a supplied project that creates reports that are similar to the report that you want to create.** SAS IT Resource Management does not supply a SAS Enterprise Guide project for every domain category. If a project for your domain category does not already exist, then you can use a project for another adapter that has a similar domain category. Review the reports that SAS IT Resource Management provides to identify the supplied project for a report that you want to imitate.

3. **Copy the supplied SAS Enterprise Guide project that you want to use as a template.**

   **CAUTION:**
   **Modify a copy of a supplied SAS Enterprise Guide project only. Do not modify a supplied SAS Enterprise Guide project directly.** The supplied SAS Enterprise Guide projects include specifications and IT domain intelligence that SAS IT Resource Management provides for reporting. If you modify supplied projects, maintain a copy of the original supplied projects. Otherwise, you could lose the specifications and benefits that these projects provide for future reference. For more information, see “Managing SAS Enterprise Guide Projects for SAS IT Resource Management” on page 192.

4. **Verify that you have set up SAS Enterprise Guide and migrated your projects so that they can work with the SAS IT Resource Management 3.4 IT data marts.** For more information about how to perform these tasks, see “About Preparing to Work with SAS Enterprise Guide” on page 50.

5. **Review the Project Notes and Process Flow Notes for the project if they are available.** You can use the information in these notes files to determine the types of reports that the project creates. They can help you understand the general conventions that are used to specify the reports.

6. **In the copy of the supplied project, modify the components as needed to specify the report configurations for the new report.**

   For more information, see “Working with Supplied SAS Enterprise Guide Projects” on page 45 and “Working with the ITRM Report Definition Task” on page 62.
7. Run the SAS Enterprise Guide project and then run the ITRM Report Definition task separately to create a new report definition.

8. Using the IT Resource Management client, create a new report job or modify the Performance Report transformation in an existing report job. The Performance Report transformation in the report job must specify the name and location of the report definition that the modified SAS Enterprise Guide project creates.

For more information, see “Working with Performance Report Transformations” on page 78.

9. Deploy and run the report job.

For more information, see “Deploying and Running Report Jobs” on page 75.

Creating New Reports from Scratch

Why Create a New Report from Scratch?
SAS IT Resource Management and SAS Enterprise Guide enable you to create batch reports from scratch, without using supplied SAS Enterprise Guide projects or reporting components as templates or models. You might choose to create your own reports from scratch if a similar counterpart is not provided by SAS IT Resource Management.

To create new reports from scratch, you must identify or create all of the reporting components that are required to generate reports. For more information, see “How to Create a New Report from Scratch”.

How to Create a New Report from Scratch

TIP SAS IT Resource Management uses specific naming conventions and locations when naming and saving reporting objects such as tables, information maps, information map filters, data items, report titles, report footnotes, and report definitions. These conventions simplify the management and maintenance of the various objects that are interrelated. For best results, if you choose to create or edit reporting objects, then use the same naming and storage conventions that SAS IT Resource Management uses for consistency and efficiency. For more information, see “About Naming Standards for SAS IT Resource Management Reporting Objects” on page 155 and “About Reporting Standards for SAS IT Resource Management Reports” on page 161.

To create a new report from scratch, perform the following steps:

1. Identify a data source for the report. The reports created by the Adapter Setup and the Add Domain Category wizard use information maps as data sources. However, SAS IT Resource Management supports other SAS data sets as sources such as aggregation tables.

For more information, see the ”Aggregating Your Data” or “Information Maps” chapters in the SAS IT Resource Management: Administrator's Guide.

2. Create a SAS Enterprise Guide project that includes at least the following components:
   • the input data source
   • one or more report tasks to specify the report parameters
   • one or more ITRM Report Definition tasks to specify the report definitions
For more information, see “Working with Supplied SAS Enterprise Guide Projects” on page 45 and “Working with the ITRM Report Definition Task” on page 62.

3. Run the SAS Enterprise Guide project interactively to verify that the report output meets your needs.

4. Then run the ITRM Report Definition task manually to create a new report definition.

5. Using the IT Resource Management client, create a new report job that includes a Performance Report transformation. The Performance Report transformation must specify the name and location of the report definition that the SAS Enterprise Guide project created.

   For more information, see “Working with Performance Report Transformations” on page 78.

6. Deploy and run the report job.

   For more information, see “Deploying and Running Report Jobs” on page 75.
Chapter 6
Working with Supplied SAS Enterprise Guide Projects

About SAS Enterprise Guide Projects

What Are SAS Enterprise Guide Projects?

In SAS Enterprise Guide, you can work with projects, process flows, branches, and tasks in order to manage the reporting process.

Here are some of the SAS Enterprise Guide components that are used in SAS IT Resource Management reporting:

- **Projects**
  
  Projects are used by SAS Enterprise Guide to manage each collection of related tasks, code, references to data, and results.

- **Process Flows**
  
  A process flow is a view within a project that shows a set of related data sets, tasks, and results that are linked and can be executed in a single stream. You can run a portion of the process flow or the entire process flow. A project can have multiple process flows that can be selected from the Project tree.

- **Branches**
  
  A branch is a set of related tasks that are linked and can be executed in a single stream. Branches can be accessed from a process flow window in SAS Enterprise Guide.

- **Tasks**
In SAS Enterprise Guide, tasks generate SAS code and formatted results. Tasks include SAS procedures that can generate many types of reports, from simple data listings to complex analytical procedures.

SAS IT Resource Management supplies an ITRM Report Definition task that creates report definitions.

**SAS Enterprise Guide Projects Supplied by SAS IT Resource Management**

During installation, SAS IT Resource Management provides several SAS Enterprise Guide projects. They can be accessed by navigating to the location where you installed SAS IT Resource Management on the client workstation. The projects are located at `SASITResourceManagementSASEnterpriseGuideComponents\3.4`. For example, if you installed SAS IT Resource Management on a 64-bit machine, the projects might be located at `C:\Program Files\SASHome\SASITResourceManagementSASEnterpriseGuideComponents\3.4`.

These projects, when executed, generate reports that provide domain intelligence for IT resources. The following two displays show the tree view and workspace view for the supplied project called `SARDisk.egp` and the process flow called `DayJobDetailDisk`.

- The tree view provides a hierarchical representation of data, tasks, results, and other objects that are associated with your projects. All of the process flows that are associated with this project are displayed in the tree view of the project.
Display 6.1  Tree View of the DayJobDetailDisk Process Flow in the SARDisk.egp Project

- The workspace view shows the process flow diagram of the objects in one process flow of your project.
Display 6.2  Workspace View of the DayJobDetailDisk Process Flow in the SARDisk.egp Project
The tree and workspace views of the SARDisk.egp project provide examples of these terms:

- The project name is SARDisk.egp.
- The process flow name is DayJobDetailDisk.
- The first task in the process flow is the information map called DetailDisk.
- The process flow contains two branches that each start with a Map Import task called ImportDetailDisk.
  - The import task in the first branch creates a table that provides the source data for the three report tasks that generate line plots and a treemap.
  - The import task in the second branch creates a table that provides the source data for two report tasks that generate two lines plots.

Note: After the SAS Enterprise Guide project is run, the resulting reports are rendered in HTML.

- An ITRM Report Definition task is appended to each branch. This task creates the generated code of the branch as a report definition. When the report definition is run in a report job, it creates output in the SAS Content Server.

Tip Many supplied SAS Enterprise Guide projects include Project Notes and Process Flow Notes. The Project Notes file provides useful information about the reports that the project creates for the adapter and domain category. The Process Flow Notes file provides specific information about the columns and filters that are used in the various process flows of the project. You can use the information in these notes files to determine the types of reports that the project creates. The information can also help you understand the general conventions that are used to specify the reports.

Properties of Supplied SAS Enterprise Guide Reports

SAS Enterprise Guide reports that are supplied by SAS IT Resource Management conform to a set of reporting standards. These conventions, based on IT intelligence and best practices, designate standard specifications for report footnotes, titles, fonts, colors, filters, and so on.

Supplied projects use process flow names that typically suggest which job the reports should run in (for example, the daily job, the weekly job, or the monthly job). The process flow name also indicates the name of the information map that is used. The supplied SAS Enterprise Guide project called SARDisk.egp includes a process flow named DayJobDetailDisk. The name of this process flow suggests that it contains reports that should run in a daily job and that use the DetailDisk information map. This naming convention enables you to associate reports with their report jobs and identify the information maps and SAS tables on which the reports are based.

If you choose to create or edit IT reports, then you should follow these reporting standards so that the reports that you create have the same look as those that SAS IT Resource Management supplies.

For more information, see “Naming Standards for Reporting Objects” on page 155 and “About Reporting Standards for SAS IT Resource Management Reports” on page 161.
Preparing to Work with SAS Enterprise Guide

About Preparing to Work with SAS Enterprise Guide

Before you begin working with the supplied SAS Enterprise Guide projects, you must use the functions of SAS Enterprise Guide in order to perform the following tasks:

• Set up SAS Enterprise Guide so that it can work with SAS IT Resource Management data.

• Migrate SAS Enterprise Guide projects so that they can work with your SAS IT Resource Management 3.4 IT data marts, in which you created the report data.

Note: Supplied SAS Enterprise Guide projects include pointers to information maps. These information maps are created when you run the corresponding information map jobs that the Adapter Setup or Add Domain Category wizard creates. Before you begin working with a supplied SAS Enterprise Guide project, you should run the Adapter Setup or Add Domain Category wizard for the corresponding adapter and domain category. You must then run the jobs, including the information map job, to create the information map that the supplied project uses.

Setting Up SAS Enterprise Guide for SAS IT Resource Management Data

In order to work with the data from SAS IT Resource Management, SAS Enterprise Guide must access the SAS Metadata Repository. To access a SAS Metadata Repository for use by SAS Enterprise Guide, perform the following steps:

1. Invoke SAS Enterprise Guide. To do so, select Start ➔ Programs ➔ SAS ➔ Enterprise Guide.

2. From the menu bar, select Tools ➔ Options. The Options dialog box appears. From the list in the left pane, select Administration.
3. If you want to create a profile or change your profile, click **Modify**, which opens the Connections window. Select the profile that you want to change and click **Modify**.

4. The Modify Profile window appears and enables you to create or revise the profile. Enter or revise the following information.
   a. The name of the profile is required. The description is optional.
   b. Specify whether the machine is remote or local by clicking the appropriate button.
   c. Enter the machine and port number of the server that you want to connect to.
   d. Enter the user ID and password for the person who can access this server.
   e. Click **Save** to save all specified values and close the window, or **Cancel** to discard all values and close the window.

5. To connect to the server, select the appropriate profile and click **Set active**. The active server is the source for all resource definitions (such as servers and libraries).
   
   If the Credentials Required dialog box appears, enter your user ID and password and click **OK**.

   The selected repository is identified by the active repository icon: 🔐.

6. Click **Close** to return to the Administration window.

7. Click **OK** to return to the main SAS Enterprise Guide workspace.
For information, see Administering SAS Enterprise Guide. To locate this documentation, navigate to http://support.sas.com/documentation/index.html. From the list of products, select the SAS Enterprise Guide.

**Migrating SAS Enterprise Guide Projects to Work with SAS IT Resource Management 3.4**

**About the Migration Wizard**
The Migration Wizard for SAS Enterprise Guide enables you to migrate report projects that are created with earlier versions of SAS IT Resource Management and SAS Enterprise Guide. The migrated report projects can then be used with your current version of SAS IT Resource Management and SAS Enterprise Guide.

SAS Enterprise Guide projects supplied by SAS IT Resource Management, and typically those created for use with SAS IT Resource Management, use information maps in the report projects. Therefore, you must change the map paths of the supplied information maps to point to the information maps that you created with the Adapter Setup or Add Domain Category wizard. The easiest way to change the map paths is to use the Migration Wizard for SAS Enterprise Guide.

**Prerequisites to Running the Migration Wizard**
Before you run the Migration Wizard for SAS Enterprise Guide and the SAS Add-in for Microsoft Office, you must run the staging, aggregation, and information map jobs that create the information maps for the adapter and domain category that you want to work with.

If you installed the supplied SAS Enterprise Guide projects, they can be accessed by navigating to the location where you installed SAS IT Resource Management on the client workstation. The projects are located at SASITResourceManagementSASEnterpriseGuideComponents\3.4. For example, the projects might be located at C:\Program Files\SASHome\SASITResourceManagementSASEnterpriseGuideComponents\3.4.

**Tip** Make a copy of the SAS Enterprise Guide projects and migrate only the copied projects. The original projects should be kept unchanged as a backup.

**Tip** Make sure the copied projects are not read-only projects. To do this, right-click each project and select Properties. On the General tab, make sure that the Attributes box is not checked. Then click OK.

**Running the Migration Wizard**
To run the Migration Wizard for SAS Enterprise Guide and the SAS Add-in for Microsoft Office, perform the following steps:

1. Navigate to the location where the current version of SAS Enterprise Guide is installed. Then select MigrationWizard.exe. Click Enter to invoke the Migration wizard. The first page of the Migration wizard appears. This page contains information about why you should use this wizard and what you should do before you run it.
2. On page 2 of the wizard, verify the connection profile of the application server where your information maps are located. You can click **Modify** to change your connection profile.

3. On page 3 of the wizard, select the projects that you want to migrate. To do so, perform the following steps:
   a. In the **Available files** column, navigate to the location of the SAS Enterprise Guide projects that you want to migrate.
   b. Check the boxes next to the projects to be migrated.
   c. Click the right arrow to move the projects to the **Selected files** column.

4. On page 4 of the wizard, information is displayed that explains the next steps of the migration process. Click **Next** to run the process that parses the files. The progress of the wizard is displayed as it locates all the references to the projects that you selected.
Click **Done** when the progress indicator shows that this task is complete.

5. On page 5 of the wizard, you must enter the new mapping information for the selected projects. To do so, perform the following steps:

   a. Use the **Show** field to shorten the number of entries on this page. From the drop-down list, select **Global references only**. (This setting removes the information maps from this page, which significantly simplifies the contents of this page.)
b. Expand the page to the full width of your screen. This action enables you to have space to see the complete path information for the current and new mappings.

c. Resize or hover over the **Current Mapping** column width so that you can see the complete path. This path is the path that was used in the SAS Enterprise Guide project when it was last saved. It identifies the adapter and domain category for which the project was developed. As shown in the following display, a typical path is quite long (for example, `/Shared Data/SAS IT Resource Management/IT Data Marts/VMwareForReporting2/VMware vCenter 1/Domain Categories/Guest System/`).
d. If you want to change the information map path globally, click the ellipsis button (…) in the **New Mapping** column. The Change Resource dialog box appears. Use the **Browse** button to display the list of servers from which you can select the **Server name** that you want to use in your paths. If you want to apply this change to all the object references that contain this value, check the corresponding box.

e. You must enter the mapping information for your new IT data mart in the **New Mapping** column for each of the project folders that are shown on this page. To do so, perform the following steps:

- Select the folder and click the ellipsis button (…) in the **New Mapping** column. The Change Resource dialog box appears.

- Use the **Browse** button to display the list of folders to which the projects can be migrated. Expand the **Folders** tree until you locate the IT data mart from which you ran the Adapter Setup wizard for these projects.
Display 6.8  Locating the IT Data Mart

- Continue expanding the folders within the IT data mart until you find the location of the adapter and the domain category that corresponds to the path in the Current Mapping field. In the Select a Location dialog box, the Selected location field displays the complete path for the new location.

  Note: Make sure that the box is checked that specifies to apply this change to all object references that contain this value.

- When you have entered the new mapping information for all the SAS Enterprise Guide project folders, click Next.

  f. On the Begin the migration process page, you can also enter the path to your Migration Record File. You can also change the path to the Log File, specify whether to create automatic backups of the original files, and specify whether to verify the existence of all resources that were changed.

    Tip For best results, specify that the original files should be backed up automatically.

  g. Click Finish to perform the migration. The Migrating files window displays the progress of your migration. When the migration is complete, the status of the processing is displayed. If a processing error occurred, you can view the log file. Otherwise, click Done to exit from the Migration wizard. The jobs that contain the projects that were successfully migrated can be opened in the IT data mart and run.
How to Modify a Report in a Supplied SAS Enterprise Guide Project

The supplied SAS Enterprise Guide projects are the source of the reports that the Adapter Setup wizard creates. Each report in a supplied SAS Enterprise Guide project corresponds to a report definition that SAS IT Resource Management provides. After you have run the Adapter Setup wizard for a given adapter and run the resulting report jobs, you can review the reports that these jobs create. You can then determine whether the reports that SAS IT Resource Management provides meet the needs of your organization.

Note: Your site might not process data from any of the data sources for which SAS IT Resource Management provides an adapter. In that case, you can use an alternate data source to process a sample set of data to run the Adapter Setup wizard and view the reports that it generates. For example, some data sources that are commonly available in IT enterprises are SAR for UNIX systems, SNMP for IP networks, or a trial license of Demand Technology Performance Sentry for Windows systems. Alternatively, you can access samples of reports on the SAS IT Resource Management website that is located here: http://support.sas.com/documentation/onlinedoc/itsv/#itrm34. Scroll down to the section called Samples of Supplied Reports.

If you want to modify a supplied report that you view in ITRM Report Center, then you can use the report properties to identify the supplied project that is associated with it. You can then copy the corresponding SAS Enterprise Guide project and modify the copied project as needed. To do so, perform the following steps:

2. Select an <adapter> folder.
3. Select a <domain category> folder.
4. Select Supplied.
5. Select a <time period> folder.
6. On the workstation where the SAS IT Resource Management client is installed, navigate to `SASITResourceManagement\SASEnterpriseGuideComponents\3.4`. For example, if you installed SAS IT Resource Management on a 64-bit machine, the projects might be located at `C:\Program Files\SAS\SASITResourceManagement\SASEnterpriseGuideComponents\3.4`.

7. Copy the supplied SAS Enterprise Guide project that you want to modify.

**CAUTION:**

*Modify a copy of a supplied SAS Enterprise Guide project only. Do not modify a supplied SAS Enterprise Guide project directly.* The supplied SAS Enterprise Guide projects include specifications and IT domain intelligence that SAS IT Resource Management provides for reporting. If you modify supplied projects and do not maintain a copy of the original supplied projects, then you will lose the specifications and benefits that these projects provide for future reference. For best results, maintain and save the original copies of all supplied projects and report definitions in the `Supplied` folder and save your modified copies in the `User Defined` folder. For more information, see “Managing SAS Enterprise Guide Projects for SAS IT Resource Management” on page 192.

8. If the project includes notes, then review the Project Notes and Process Flow Notes files. You can use the information in these notes files to determine the types of reports that the project creates. These files can also help you understand the general conventions that are used to specify the reports.

9. Modify the reports in the copy of the supplied project. You can use the `ProcessFlow` and `Performance ReportTask` properties that you identified previously to locate the specific branch of components in the project that affect the report.

For more information, see “Working with Supplied SAS Enterprise Guide Projects” on page 45.
10. Run the ITRM Report Definition task to create an updated report definition.
    For more information, see “Working with the ITRM Report Definition Task” on page 62.

11. Your modifications might include adding a new report definition or changing the name of an existing report definition. In that case, you must use the IT Resource Management client to update the Performance Report transformation in the corresponding report job to add the new report definition or specify the updated report definition with the new name.
    For more information, see “Working with Performance Report Transformations” on page 78.

12. From the IT Resource Management client, redeploy and run the corresponding report job.
    For more information, see “Deploying and Running Report Jobs” on page 75.
Chapter 7
Working with the ITRM Report Definition Task in SAS Enterprise Guide

About the ITRM Report Definition Task

The ITRM Report Definition task enables you to use SAS Enterprise Guide to specify and create report definitions. These report definitions include all of the metadata and SAS code from a given branch of your SAS Enterprise Guide project. After the ITRM Report Definition task creates the performance report definition, you can use the Performance Report transformation that is available in the SAS IT Resource Management client to include the report definition in your report jobs.

Report definitions provide greater flexibility when executing and specifying your report jobs and output. For example, report definitions perform the following actions:

• run in a report job that can execute on any SAS Application Server such as Windows, UNIX variants, and z/OS. This provides the flexibility of using the batch capabilities of enterprise class systems instead of a Windows client when running the large number of reports that are necessary for IT performance management and capacity planning activities.

• attach metadata to each report so that ITRM Report Center can locate, subset, and filter all of the reports individually. This metadata includes values that you specify as filters when using ITRM Report Center to view and sort only a portion of the available reports.

• create separate pages, metadata, and filters for each report so that every report can be easily searched within ITRM Report Center.

After you use the ITRM Report Definition task to define and create a report definition, it is stored on the SAS Metadata Server. You can use the SAS IT Resource Management client to access the report definition later and include it in a Performance Report transformation that is part of a report job. When the report job executes, the report definition generates reports and report metadata that are written to the SAS Content Server. You can then use ITRM Report Center to view these reports or subsets of these reports.
In addition to enabling you to create your own report definitions, SAS IT Resource Management supplies report definitions that were generated from the supplied projects in SAS Enterprise Guide. The supplied report definitions provide extensive domain intelligence about IT resources for the supported adapters. The Adapter Setup and Add Domain Category wizards use these report definitions in the report jobs that they create. You can use these supplied report definitions instead of, or in addition to, the report definitions that you create with the ITRM Report Definition task. The supplied report definitions are loaded into a predefined folder for supplied report definitions on the SAS Metadata Server after SAS IT Resource Management is installed. For more information about supplied projects in SAS Enterprise Guide, see “SAS Enterprise Guide Projects Supplied by SAS IT Resource Management” on page 46.

Working with the ITRM Report Definition Task

Access and Navigate the ITRM Report Definition Task

To access the ITRM Report Definition task, perform the following steps:

1. Open or create a SAS Enterprise Guide project that includes one or more report tasks, custom tasks, or program nodes.

2. Access the ITRM Performance Report Task from the SAS Enterprise Guide task list or from Tools ⇒ Add-In ⇒ ITRM Performance Report.

To navigate through the pages of the ITRM Report Definition task, use the following buttons:

- **Back**
  - displays the previous window in the ITRM Report Definition task.

- **Next**
  - displays the next window in the ITRM Report Definition task.

- **Save**
  - saves the current specifications set in the ITRM Report Definition task and creates an ITRM Report Definition object in the process flow diagram of the SAS Enterprise Guide project. The save option does not create a report definition. It simply saves the ITRM Report Definition task object that you can use to create a report definition.

  **CAUTION:**

  *When working with SAS Enterprise Guide, you must always save your projects frequently to keep updates to the tasks in the project.* If you select **Save** in the ITRM Report Definition task, then the specifications for the ITRM Report Definition task are saved for the current instance of the project. However, if you do not also save the SAS Enterprise Guide project, then the updates are lost when the project is re-opened.

- **Deploy**
  - performs the same functions as **Save** and creates a report definition that is stored on the SAS Metadata Server.

  **Note:** You must click **Deploy** to create a report definition. The save option alone does not create a report definition.

- **Cancel**
  - abandons changes that were made and closes the task.
Help
displays a Help topic for the current page. For information about each field on the
ITRM Report Definition task pages, see the Help.

Create Report Definitions Using the ITRM Report Definition Task

To name and define report definitions for a SAS Enterprise Guide project, perform the
following steps:

1. Open or create a SAS Enterprise Guide project that includes one or more report
tasks, custom tasks, or program nodes.

2. Select Tools $\Rightarrow$ Add-In $\Rightarrow$ ITRM Report Definition from the task list in SAS
Enterprise Guide to display the Name page of the ITRM Report Definition task.

Display 7.1 ITRM Report Definition Task Name and Description Page

3. In the Name field, enter the name of the ITRM Report Definition task. The name
must be unique for the current metadata path, or the new ITRM Report Definition
task overwrites the report definition that has the same name. The Name field can
contain no more than 60 characters. The Name field cannot contain any special
characters.

Note: SAS IT Resource Management supplies SAS Enterprise Guide projects that
name ITRM Report Definition task objects and report definitions by using
descriptive words that indicate the following: the measures that are reported, the
filters that are used, and the time period that is reported. For example, a report
definition might be named
SystemCpuHighUsagePlotIntervalsForTheDay. For best results, use
this naming convention or your own to create consistent names that are easy to
understand and locate in the SAS Metadata Server.

4. In the Description field, enter a description of the ITRM Report Definition task.
Entering a description in this field is optional but recommended.
5. In the **Specify path for report definition** field, specify a metadata path where you want to save the report definition. Click **Browse** to select the folder that you want to contain the report definition task.

The metadata folder that you select resides in the SAS Metadata Repository and is available from the SAS IT Resource Management client. The folder that you select will contain the report definitions for the reports that are included in the ITRM Report Definition task.


**CAUTION:**

Do not save your user-defined report definitions in the folder that is named `Supplied` in the preceding path. The Adapter Setup and Add Domain Category wizards use the report definitions in the `Supplied` folder when generating reporting jobs. If you add or modify report definitions in the `Supplied` folder, then the jobs of the associated Adapter Setup and Add Domain Category wizards might lose the IT intelligence that SAS IT Resource Management provides. Your modified report definitions might also be overwritten when you install any software updates for SAS IT Resource Management.

6. Use the **Include data path in report definition** option to enable or disable the storing of the current data path in the report definition. The default and recommended value is **No** because it provides greater flexibility and portability of report definitions. In this case, the data path value in the report definition is left blank. In addition, the Performance Report transformation that uses the report definition searches for the data within the corresponding folder for the given job.

The **Yes** value indicates that the report definition explicitly specifies the data path as the current data path that was used when the report definition was created. Select **Yes** only if your data path is unique, unchanging, and outside the job folder for the report definition. The Performance Report transformation that uses the report definition then searches for the data within the same data path that was used when the report definition was created.

For more information, see “Specifying a Data Source Location” on page 92.

7. Click **Next** to access the **Options** page.
8. On the **Options** page, you must select one or more reports from the list of report tasks that are in the current process flow. All of the reports that you select are going to use the same specifications and report filter settings.

**Note:** If you want to assign different settings to various reports, you must create a separate ITRM Report Definition task. For example, line plots use the graph format of ActiveX for dynamic features while tile charts are most useful when Java is used. If you have a project that includes both line plots and tile charts, then you perform the following steps:

- Create at least one ITRM Report Definition task for the line plots that use ActiveX.
- Create one ITRM Report Definition task for the tile charts that use Java.

9. In the **Specifications** box, specify the following options:

**Graph Format**

determines the type of graph that you want to generate (ActiveX, Java, or PNG) for the report definition. The default value is **ActiveX**.

**Note:** List reports that are included in your ITRM Report Definition task ignore this option.

**Expire Reports After \(N\) Days**

calculates the expiration date, relative to the system date when the report is generated. If a report is expired and its report job is run again, the expired report is deleted and replaced with the new report. If a report is not expired and its report job is run again, the previous report remains in the system with the new report that is generated. You can specify an expiration range from 1 to 999 days. The default value is **1**. In this case, reports that are older than one day are deleted when the report job is run.

**Note:** This parameter calculates expiration by number of days. When setting the expiration for reports that are run on a schedule other than daily, account for
the number of days within the time period in which the reports are run. For example, the expiration value for a weekly report should be some multiple of seven because there are seven days in a week.

10. In the **Report Filters** box, specify the filter values that you want to use when viewing reports in ITRM Report Center. These values do not appear on the report. However, they do appear as filter options in ITRM Report Center.

The options for each filter type can include supplied values and user-defined values. To create, delete, save, or share user-defined values for the filter types, click **Manage User-Defined Settings**. For more information about managing user-defined values, see “Managing User-Defined Settings for Report Filters” on page 67.

**CAUTION:**

Carefully select the appropriate filters for your reports and ensure that you use correct spellings for user-defined values. Assigning an incorrect or misspelled filter to a report does not affect the data or the accuracy of the report content. However, an incorrect filter makes the corresponding report difficult to locate when filtering subsets of reports in ITRM Report Center. In addition, make sure that the values for each of the filters are less than 33 characters in length.

**Domain Category**

specifies the adapter and domain category that you assign to the reports for filtering in ITRM Report Center. The options for this field include the values for the adapters that the Adapter Setup and Add Domain Category wizards support as well as any user-defined values. The values are sorted alphabetically in this list. This field is required.

**Domain Subcategory**

specifies the report category, a subset of the domain category that you selected. The options for this field include only the subcategories for the domain category that you selected. If the selected **Domain Category** does not include supplied subcategories, then only the user-defined values for domain subcategory are available.

**Job Schedule Frequency**

indicates when the corresponding reports should be scheduled to run and specifies the time period that you assign to the reports for filtering in ITRM Report Center. The options for this field include daily, weekly, monthly, quarterly, yearly, and any user-defined values.

*Note:* This value is a report filter in metadata only. It does not schedule report jobs. You can use this value as an indicator to include this report definition in report jobs that are scheduled to run on an interval that corresponds with this value. This value is also used as a filter in ITRM Report Center.

**Keywords Available**

lists the keywords that you can assign to reports for filtering in ITRM Report Center. This list includes supplied and user-defined keywords. To add keywords to reports, select one or more keywords from the **Keywords Available** list and then click **. The keywords are added to the **Selected Keywords** list. To remove keywords from the **Selected Keywords** list, select one or more variables from the **Selected Keywords** list and click 

11. Click **Deploy**. All values are saved in the ITRM Report Definition task object and a report definition is created on the metadata server. In addition, an ITRM Report Definition task object appears in the process flow diagram with a link to all of the
selected reports tasks and program nodes. A message box notifies you when the report definition is created successfully.

CAUTION:
Running a SAS Enterprise Guide process flow or project does not automatically run the ITRM Report Definition task and create a report definition. You must open the ITRM Report Definition task separately and click Deploy to create and publish a report definition.

When a report definition is created successfully, it does not appear as a separate object in the process flow or in a format that is viewable from SAS Enterprise Guide. SAS Enterprise Guide manages the ITRM Report Definition tasks that create report definitions but it does not manage the report definitions. You can use SAS IT Resource Management and SAS Management Console to view and access the report definitions that the ITRM Report Definition tasks create.

The following display shows two ITRM Report Definition task objects, boxed in red, in a SAS Enterprise Guide process flow.

Display 7.3 ITRM Report Definition Task Objects in a Process Flow

12. Save the SAS Enterprise Guide project.

Delete User-Written Report Definitions from the Metadata
If you created a user-written report definition and stored it in a folder within My Folder, you can delete it. To do so, right-click the report definition. Then, click Delete. A warning dialog box appears if the report definition is used in any report job.

Managing User-Defined Settings for Report Filters

About the Manage User-Defined Settings Window
When planning to filter and subset your reports, you might need to create domain categories, domain subcategories, job schedule frequencies, and keyword values that are unique to your business. The ITRM Report Definition task enables you to create and manage your own unique filter values that you can assign to report definitions. You can use these filter values later in ITRM Report Center when viewing and searching for reports. You can also share these user-defined filters with other clients that might want to filter reports in a similar way.

The Manage User-Defined Settings window of the ITRM Report Definition task enables you to share, add, and delete user-defined values for report filters. The user-defined values that you specify on this window are then available from ITRM Report Center.
They are also available for report definitions that are created with an ITRM Report Definition task in SAS Enterprise Guide.

**Create User-Defined Values**

To create user-defined values, perform the following steps:

1. Open an ITRM Report Definition task in a SAS Enterprise Guide project.
2. Click **Next** to navigate to the **Options** page.
3. Click **Manage User-Defined Settings**.

![Display 7.4 Manage User-Defined Settings Option on the Options Page](image)

The Manage User-Defined Settings window appears.

4. From the list on the left of the pane, select the type of filter for which you want to add a value. For example, you can select **Domain Category**, **Domain Subcategory**, **Job Schedule Frequency**, or **Keywords**.

![Manage User-Defined Settings](image)

5. Enter the new filter value in the field at the top of the window. This field accepts only letters, numbers, hyphens, and underscores.

*Note:* Misspellings, typing errors, and differences in capitalization standards can create inconsistencies in this field. An error in the value can make the associated reports difficult to find when using ITRM Report Center to filter your reports. Inconsistencies can also lead to multiple filter values that mean the same thing but are listed separately.
6. Click **Add** to create the filter value.

7. Click **Save** to add the user-defined value to the list of available filters in the ITRM Report Definition task. New filter values appear in ITRM Report Center after they are used in a report definition that is part of a run report job.

**Delete User-Defined Values**

When you delete a user-defined value, the value is removed from the list of available filters in an ITRM Report Definition task. If an ITRM Report Definition task uses the deleted value, then the setting is replaced with a blank value the next time you open the ITRM Report Definition task. However, the deleted value is still available for selection in ITRM Report Center until all of the reports that include the deleted value are purged from the SAS Content Server. It is also still in the metadata of report definitions and report output that were generated before the change.

To delete a user-defined value, perform the following steps:

1. From the Manage User-Defined Settings window of the ITRM Report Definition task, select the type of filter for which you want to delete a value. For example, you can select **Domain Category**, **Domain Subcategory**, **Job Schedule Frequency**, or **Keywords**.

2. Select the value that you want to delete.

3. Click **Delete**.

4. Click **Save** to delete the user-defined value from the list of available filters in the ITRM Report Definition task.

**Share User-Defined Values between Clients**

To share user-defined values between clients, perform the following steps:

1. From the Manage User-Defined Settings window of the ITRM Report Definition task, select **General**. The General window enables you to import user-defined values from another user and to save or export your user-defined values in a physical file for another user.

2. Specify how you want to share the user-defined values:
   - Click **Export Settings** to save your user-defined values in a physical file that you can share with other clients. A Save File window appears, enabling you to save your user-defined values in a physical file and folder location.
Note: You can also use the Export Settings feature to simply save and back up your settings.

- Click Import Settings to add a set of user-defined values from a shared settings file. An Open File window appears, enabling you to navigate to and select a shared settings file that includes the user-defined values that you want to use.

3. Click Save.

Modify Report Definitions Using the ITRM Report Definition Task

You can use the ITRM Report Definition task to modify a SAS IT Resource Management report definition. The ITRM Report Definition task must be run manually (as described in this topic) to create or modify a report definition. Simply running a project, process flow, or a branch in SAS Enterprise Guide does not update the report definitions.

To modify report definitions using the ITRM Report Definition task, perform the following steps:

1. Open the appropriate SAS Enterprise Guide project and run the branch that is associated with the report definition that you want to modify.

2. Right-click the ITRM Report Definition task object and select Modify <ITRM Report Definition Task Name>.

3. Navigate the ITRM Report Definition task pages and modify the settings as needed.

4. Click Deploy. A message box notifies you when the report definition is created successfully. All new values are saved in the ITRM Report Definition task object, and the report definition is updated on the metadata server. You must then run the corresponding report job to see updates in the report output.

   Note: Save does not create a report definition. It simply saves the ITRM Report Definition task object that you can use to create a report definition later.

5. Save the SAS Enterprise Guide project to save the ITRM Report Definition task update.

   Note: If you modify report definitions, remember to redeploy the associated jobs.
# Chapter 8

## Working with Report Jobs and Performance Report Transformations

### About Report Jobs

**What is a Report Job?**

Report jobs can be run from the SAS IT Resource Management client or can be deployed and run in a batch process. When run, these jobs create reports and save them.
to the SAS Content Server. Each report job includes a Performance Report transformation that, when executed, generates SAS code to perform the following tasks:

- create reports in the SAS Content Server repository
- delete older versions of the same reports that have expired
- update the ITRM Report Center cache
- create a summary in the report job log that shows the URL of all reports generated in SAS Content Server

For more information, see “About Performance Report Transformations” on page 76.

Report jobs can be generated in two ways:

- automatically, by using the Adapter Setup and the Add Domain Category wizards
- manually, by using the Performance Report transformation that is in the SAS IT Resource Management folder of the Transformations tree in SAS IT Resource Management

**Report Jobs Created by the Adapter Setup and Add Domain Category Wizards**

The Adapter Setup and Add Domain Category wizards create report jobs that contain Performance Report transformations for several of the adapters and domain categories that SAS IT Resource Management supports. For more information about the specific adapters and domain categories for which the Adapter Setup and Add Domain Category wizards create reporting jobs, see the “Jobs That the Adapter Setup Wizard and Add Domain Category Wizard Create for Domain Categories” appendix in the *SAS IT Resource Management: Administrator’s Guide*.

For example, the following image shows the report job that the Adapter Setup wizard created for the Server Disk domain category of the DT Perf Sentry adapter. The report job (Disk Daily Reporting) is located in the Domain Categories subfolder of the IT data mart folder. The Performance Report transformation (Disk Daily) is available from the process flow diagram of the open report job. A similar report job can be created by the Add Domain Category wizard.

**Display 8.1 Report Job Created by the Adapter Setup Wizard**

Using the Adapter Setup or the Add Domain Category wizard is the most convenient way to create report jobs for selected adapters. When generated by the Adapter Setup or Add Domain Category wizard, report jobs use Performance Report transformations that
reference supplied report definitions. These report definitions provide extensive domain intelligence about IT resources for the supported adapters. For more information, see the “Adapter Setup Wizard” and the “Add Domain Category Wizard” chapters in the *SAS IT Resource Management: Administrator’s Guide*.

However, you might choose to create your own report jobs or modify those that the Adapter Setup or the Add Domain Category wizard creates. For more information, see “Working with Report Jobs”.

---

### Working with Report Jobs

**Create a Report Job**

The Adapter Setup and the Add Domain Category wizards create report jobs for several adapters and domain categories. You can view these supplied reports here: *Samples of Supplied Reports*. These reports are organized by adapter and domain category.

However, you might need to create or modify your own report job. For example, you might want to create batch reports for a domain category for which SAS IT Resource Management does not already provide reports.

To create a report job, you must first create a job and then add a Performance Report transformation to that job. To do so, perform the following steps:

1. In the SAS IT Resource Management client, open or create a job. If you want to work with an existing job, double-click on that job to open it on the **Diagram** tab of the Job Editor window of SAS IT Resource Management.

   If you need to create a new job, you can invoke the New Object wizard from the **File** menu of SAS IT Resource Management. For information about how to perform this task, see the “Create a Job” topic in the *SAS IT Resource Management: Administrator’s Guide*.

   The new job opens on the **Diagram** tab of the Job Editor window.


3. Drag the **Performance Report** transformation onto the job in the **Diagram** tab of the Job Editor window.

   *Note:* A Performance Report transformation does not have an input or output object that is displayed in the process flow diagram of a report job. Thus, a report job can include one Performance Report transformation as the only object in the process flow diagram of the job and still be valid.

4. Modify the Performance Report transformation parameters as needed to meet the reporting needs of your organization. For more information, see “Add a Performance Report Transformation to a Report Job” on page 78. Then save the job.

5. Deploy and run the report job. For more information, see “Deploying and Running Report Jobs” on page 75.
Modify a Report Job

To edit an existing report job, perform the following steps:

1. In the IT Data Marts tree of SAS IT Resource Management, double-click the report job that you want to edit.
2. Edit the report job.

   To Edit the Properties of the Report Job
   a. Right-click the report job in the IT Data Marts tree.
   b. To rename the report job, select Rename.
   c. To view and modify the properties of the report job, select Properties. For more information about the properties for a report job, see the Help for SAS IT Resource Management.
   d. Click OK. Save the job.

To Edit the Properties of a Performance Report Transformation in the Report Job

   a. Right-click the Performance Report transformation in the process flow diagram and select Properties. A Properties dialog box is displayed and enables you to modify the various parameters that are specified for the Performance Report transformation and the code that it generates. For more information, see “Edit a Performance Report Transformation” on page 91.
   b. Click OK. Save the job.

For more information about the specific parameters that are available for configuration in the Performance Report transformation, see the detailed steps in “Add a Performance Report Transformation to a Report Job” on page 78.

3. Deploy and run the report job. For more information, see “Deploying and Running Report Jobs” on page 75.

Copy a Report Job

To copy a report job, perform the following steps:

1. Navigate to the location of the job in the IT Data Marts tree.
2. Right-click the job.
3. Select Copy.
4. Right-click the folder where you want the copy of the job to reside.
5. Select Paste. A copy of the report job is saved in the folder and is assigned the default name Copy of <original job name>.
6. Double-click the new job to open it in the Diagram tab of the Job Editor.
7. Right-click the Performance Report transformation in the process flow and select the Server tab.
8. Specify the name and location of the SAS Content Server for the Performance Report transformation.
9. Click OK. Save the job.
Delete a Report Job

To delete a report job, perform the following steps:

1. Navigate to the location of the job in the IT Data Marts tree.
2. Right-click the job.
3. From the menu that is displayed, select Delete.
4. In the confirmation box, click Yes to delete the job.

If you delete a report job that has already run, then the reports that the job created remain in the SAS Content Server until an administrator deletes them manually. The only way that a report is programmatically deleted from the SAS Content Server is when the report has expired and its report job is rerun to remove and replace the report.

Note: If you delete a report job in an IT data mart but the report job has already been deployed, then the deployed job can still be run in batch.

Deploying and Running Report Jobs

About Deploying and Running Report Jobs

After you create or modify a report job, you can deploy and run the job to purge expired reports, and create new reports in the SAS Content Server where ITRM Report Center can access them. Report jobs are the last step in the batch reporting process flow. Therefore, they rely on the successful completion of all the jobs and components that precede it in the data extraction, transformation, loading, and reporting process.

Deploying a job enables you to execute the job outside of SAS IT Resource Management, such as when scheduling a job to run at a specified time. SAS IT Resource Management enables you to deploy as well as run jobs. For more information about how to deploy and run jobs, see the “Jobs” chapter in the SAS IT Resource Management: Administrator’s Guide.

Deploy and Run Report Jobs That the Adapter Setup or Add Domain Category Wizard Creates

The Adapter Setup and the Add Domain Category wizards create a set of jobs that compartmentalize each step of the extract, transform, load, and reporting process for IT data. These jobs depend on one another to process the raw data for reporting. For example, aggregation jobs include aggregations that rely on the staged tables that are generated when the staging job is run. As a result, each job should be run only after the jobs that it depends on have been run. The following list shows the types of jobs that the Adapter Setup and the Add Domain Category wizards create and the dependencies of each. Each job type in the list is dependent on the job type that precedes it.

1. staging job
2. aggregation job
3. information map job
4. reporting job

Note: An exception analysis job is not automatically created by the Adapter Setup or the Add Domain Category wizard. Instead, you must specify it using the Exception transformation. This transformation can be run on any source file. However, it is
typically run after the staging and Aggregation transformations have run. It can use the output of those transformations as its data source. For information about this transformation, see the “Exception Analysis Processing” chapter in *SAS IT Resource Management: Administrator’s Guide*.

For more information about the Adapter Setup and Add Domain Category wizards, see “Working with the Adapter Setup and Add Domain Category Wizards” on page 19.

**Deploy and Run Your Own Report Jobs**

You can create, deploy, and run your own report jobs manually, without using the Adapter Setup or Add Domain Category wizard. However, like the report jobs that these wizards create, your report jobs must also rely on other processing components that extract, transform, and load your IT data. For consistency and efficiency, use the same naming conventions and job structure that these wizards use when you create your own jobs and components for this process. For information about what the Adapter Setup or Add Domain Category wizards create, see the “Adapter Setup Wizard” and “Add Domain Category Wizard” chapters in the *SAS IT Resource Management: Administrator’s Guide*.

After you confirm that all of the extract, transform, and load components for your report job are prepared and successfully executed, you can deploy and run your report job.

---

**About Performance Report Transformations**

**What Is a Performance Report Transformation?**

Performance Report transformations are among the final components of the batch reporting process. These transformations are part of report jobs, and they identify one or more of the report definitions that a report job uses to create report output. This process enables you to run report jobs and their report definitions in batch mode.

Report definitions provide a majority of the specifications for report output. However, the Performance Report transformation enables you to specify (and in some cases, override) a few additional parameters for all of the reports that the corresponding report job creates. The Performance Report transformation compiles the specified values and generates the SAS program that are run as scheduled in the report job.

In the following example, a Performance Report transformation named *System Monthly* is in the *System Monthly Reporting* job for the DT Perf Sentry adapter and the Server System domain category.
For more information, see “About Report Jobs” on page 71.

Properties of Performance Report Transformations

To access the Performance Report transformation properties, right-click a Performance Report transformation in a report job and select Properties. A Properties dialog box appears and enables you to view properties and specifications for the SAS Content Server, report parameters, and report definitions.

The Properties dialog box contains the following tabs:

- The General tab displays information that identifies the Performance Report transformation such as name and description.

- The Server tab enables you to specify the SAS Content Server name and the Repository folder path where the report output is to be stored.

- The Report Parameters tab enables you to view or modify the parameters that apply to the reports that the transformation generates.

- The Report Definitions tab enables you to identify the report definitions that you want to use and to specify their purging criteria.
The Options tab displays information about how to further customize and generate the code.

The Code tab enables you to manage the code that is generated by the transformation.

Note: This tab should not be used to modify the code that is generated by the Performance Report transformation. Changes that you make can result in code that is error prone or is out of alignment with the report definition that was created by SAS Enterprise Guide.

The Precode and Postcode tab enables you to specify that user-written code should be inserted at the beginning or end of the current transformation.

The Notes tab displays any notes or documents that are associated with the transformation.

The Extended Attributes tab displays the custom properties that are available for the transformation.

For more information about the tabs that are available from the Properties dialog box, see the Help for SAS IT Resource Management.

Performance Report Transformations Created by the Adapter Setup or Add Domain Category Wizard

The Adapter Setup and Add Domain Category wizards create Performance Report transformations for several of the adapters and domain categories that SAS IT Resource Management supports. Performance Report transformations are saved as components of the reporting jobs that are stored in the IT data mart folders that the wizard creates. These Performance Report transformations reference supplied report definitions that provide extensive domain intelligence about IT resources for the supported adapters. For more information, see the “Adapter Setup Wizard” and “Add Domain Category Wizard” chapters in the SAS IT Resource Management: Administrator’s Guide.

Using the Adapter Setup and Add Domain Category wizards is the most convenient way to create Performance Report transformations and report jobs for selected adapters. However, you might choose to create your own Performance Report transformations or modify those that these wizards create. For more information, see “Working with Performance Report Transformations” on page 78.

For more information about the Performance Report transformations and report jobs that the Adapter Setup and wizard creates, see “Report Jobs Created by the Adapter Setup and Add Domain Category Wizards” on page 72. For more information about the specific adapters and domain categories for which the Adapter Setup and Add Domain Category wizards create reporting jobs, see the “Jobs That the Adapter Setup and the Add Domain Category Wizards Create for Domain Categories” appendix in the SAS IT Resource Management: Administrator’s Guide.

Working with Performance Report Transformations

Add a Performance Report Transformation to a Report Job

The Adapter Setup and Add Domain Category wizards create Performance Report transformations and report jobs automatically for a number of supplied adapters and
To create a Performance Report transformation and add it to a report job, perform the following steps:

1. In SAS IT Resource Management, open the report job that is to contain the new Performance Report transformation. The job appears on the Diagram tab of the Job Editor window.

   Note: If you want to add a Performance Report transformation to a new job, you must first create the job. For more information about how to create a job, see the “Create a Job” topic in the SAS IT Resource Management: Administrator’s Guide.

3. Drag and drop the **Performance Report** transformation onto the Job Editor window. The Performance Report transformation appears in the process flow diagram for the job.
4. Right-click the Performance Report transformation and select **Properties**.

5. On the **General** tab, specify the name and description of the transformation.

**Note:** SAS IT Resource Management uses the naming convention `<domain category> <time period>` to name Performance Report transformations. For example, a Performance Report transformation that generates weekly reports for the Server System domain category of DT Perf Sentry is named **System Weekly**. For best results, use the same naming convention that SAS IT Resource Management uses for consistency and efficiency. For information, see appendix 8, “Naming Standards” in the *SAS IT Resource Management: Administrator’s Guide*. 
6. On the **Server** tab, select the SAS Content Server folder path for the transformation.

In this dialog, all SAS Content Server folder locations that are available to ITRM are displayed. SAS Content Server folder locations are created in the ITRM Report Center **Administration** workspace. For more information about creating ITRM folder locations on the SAS content server, see “How to Create and Assign Access to a SAS Content Server Location Using ITRM Report Center” on page 113.

**Display 8.6  Server Tab of a Performance Report Transformation**

The **Server** tab includes the following parameters:

- **SAS Content Server** specifies the name of the SAS Content Server that stores the report output for the Performance Report transformation.

- **Repository folder path** specifies the root path, relative to the SAS Content Server, in which to store the reports.

  *Note:* Use the **Administration** workspace of ITRM Report Center to add a repository folder path. If you must delete a repository root path, do so in SAS Management Console.

7. On the **Report Parameters** tab, specify the following attributes:

- the style and graph formats for the reports that the transformation creates
• the location for the ActiveX Control
• the override location for temporary physical files on the server

**Display 8.7 Report Parameters Tab of a Performance Report Transformation**

The **Report Parameters** tab includes the following parameters:

- **Style template** specifies the name of the style template that is used by all of the reports that the Performance Report transformation creates. The style template determines graph colors and other attributes inside the graph portion of a report.

  You can use the standard style template that SAS IT Resource Management provides (named **ITRMDefault**). Alternatively, you can create your own style template that includes your own custom colors and visual design. For more information, see “About Templates and Style Sheets” on page 93.

  **Note:** The content, report titles, and footnotes of the individual exception reports that are generated by the Exception transformation honor the style template that you specify. However, this style sheet does not affect the exception overview report.

- **Location for style sheet** specifies the cascading style sheet (.css file) that is used when viewing a report. It controls colors and other attributes outside of the graph portion of a report.

  Any of the following location types are valid values for this field:
  
  - a full URL to the style sheet folder on a specified server (such as `http://<server>:8080/<folder name>/`).
  - a URL to a style sheet folder on all the clients where the web browser was initiated (such as `file:///c:/programfiles/<folder name>/`).
  - a relative URL to the style sheet folder on the middle tier where the graphs are installed (such as `/<folder name>/<subfolder name>`).

  The **Report Parameters** tab includes the following parameters:

  - **Style template** specifies the name of the style template that is used by all of the reports that the Performance Report transformation creates. The style template determines graph colors and other attributes inside the graph portion of a report.

    You can use the standard style template that SAS IT Resource Management provides (named **ITRMDefault**). Alternatively, you can create your own style template that includes your own custom colors and visual design. For more information, see “About Templates and Style Sheets” on page 93.

    **Note:** The content, report titles, and footnotes of the individual exception reports that are generated by the Exception transformation honor the style template that you specify. However, this style sheet does not affect the exception overview report.

    - **Location for style sheet** specifies the cascading style sheet (.css file) that is used when viewing a report. It controls colors and other attributes outside of the graph portion of a report.

      Any of the following location types are valid values for this field:

      - a full URL to the style sheet folder on a specified server (such as `http://<server>:8080/<folder name>/`).
      - a URL to a style sheet folder on all the clients where the web browser was initiated (such as `file:///c:/programfiles/<folder name>/`).
      - a relative URL to the style sheet folder on the middle tier where the graphs are installed (such as `/<folder name>/<subfolder name>`). The
option to use only the relative path provides portability of this value. For example, the name or location of the middle tier might change. In that case, the location value does not need to change as long as the folder names in the middle tier remain the same.

The default value (/SASContentServer/repository/default/sasadav/Stylesheets/) provides a path to the default style sheet for SAS IT Resource Management reports. You can create a style sheet that includes your own custom colors, logos, and visual design. For more information, see “About Templates and Style Sheets” on page 93.

• **Graph format override** specifies the graph format to use when generating the reports, regardless of the graph format indicated in the corresponding report definition. The available formats are ActiveX, PNG, or JAVA type images. A value is optional in this field, and the default value is blank. When this field is blank, the reports use the graph format that is specified in the report definition.

• **Location for graph applet JAR files** specifies the path to the SAS code that is used only to render reports that are specified as Java reports. A value is optional in this field, and the default value is /sasweb/graph.

Any of the following location types are valid values for this field:

• a full URL on a specified server.

• a URL to a folder on all the clients where the web browser was initiated (such as file://c:/program files/<folder name>).

• a relative URL to a folder on the middle tier where the graphs are installed (such as /<folder name>/<subfolder name>). The option to use only the relative path provides portability of this value. For example, the name or location of the middle tier might change. In that case, the location value does not need to change as long as the folder names in the middle tier remain the same.

**Note:** If this field is blank, then the Performance Report transformation uses the path that is specified for the –APPLETLOC option in the SAS configuration file.

• **Location for ActiveX Control** specifies the path to the ActiveX Control. (ActiveX Control is the software that displays an ActiveX graph.) In most cases, the ActiveX Control is installed on your system. If it is not installed on your system, you can do one of the following actions:

  • Use the default path to install the control for you. The default path is specified as the following: /codebase/graph/v94/sasgraph.exe#version=9,4. This path points to a URL location on the SAS website from which the ActiveX Control can be installed.

  **TIP** Access to the Internet is necessary in order to install the ActiveX Control from the SAS website.

  • Enter the path to a location from which the ActiveX Control can be installed.

  **Note:** Installation of the ActiveX Control is done only one time per client.

• **Override location for temporary physical files on server**

Temporary disk space is used to store reports that are generated by a report job. After the reports have been published to the SAS Content Server, these files and any associated folders are deleted. The default value for this field is blank.
If the override path exists and is specified, it is used as the location for the reports generated by the report job. If it is not specified or if it does not exist, the following paths are used, based on your operating environment:

- For Windows operating environments, SAS IT Resource Management uses one of the following paths to the temporary files. The path is selected from this list in the following order:
  - the value of the TEMP environment variable (for the user)
  - the value of the TEMP environment variable (for the system)
  - the value of the USERPROFILE environment variable
  - ...

- For UNIX operating environments, the path is selected from this list in the following order:
  - the value of the TEMP environment variable
  - /tmp
  - the value of the HOME environment variable
  - ...

- For z/OS operating environments, the path is selected from this list in the following order:
  - The value of the FILETEMPDIR option if it is specified, if it exists, and if FILESYSTEM=HFS
  - /tmp
  - ...

Note: If the macro variable ITRMDebug is set to a value of 1 in your report job, the files and any associated folders are not deleted.

The Report Parameters tab also enables you to reset the parameter values on the tab to their original default values. To do so, select Reset next to a specific field to reset the value for that parameter to the default value. Or, select Reset to defaults to reinstate the default value for all parameters on the tab.

8. On the Report Definitions tab, you can specify the report definitions and expiration date criteria for the reports that the transformation creates.
As shown in the previous display, the **Report Definitions** table at the top of the page provides a list of report definitions. These report definitions are used by the Performance Report transformation to generate reports.

This table includes the following parameters:

- **Report Definition Name** specifies the name of the report definition.
- **Report Definition Folder** specifies the folder where the report definition is stored.
- **Data Source Folder** specifies the folder where the data source for the report is located. If this field is blank, then the report job looks for the data source in the data path that is specified in the report definition or in the same IT data mart folder as the report job, respectively.

You can double-click a **Data Source Folder** cell to open the Select a Location dialog box. This dialog box enables you to navigate to and select a folder that contains the data source for the corresponding report definition.

For more information, see “Specifying a Data Source Location” on page 92.

The **Report Definitions** tab enables you to add report definitions to the Performance Report transformation. To do so, perform the following steps:

a. Click **Add**. The Select Report Definitions dialog box appears.

b. Navigate to the report definition folders that corresponding to the adapter and domain category that you are using.

The report definitions that the Adapter Setup and the Add Domain Category wizards use are in **Supplied** folders at Shared Data/SAS IT Resource Management/3.4 IT Report Definitions/<adapter>/<domain>.
The report definitions that you have modified or created on your own are, by default, in User Defined folders at Shared Data/SAS IT Resource Management/3.4 IT Report Definitions/<adapter>/<domain category>/User Defined/<time period (such as Day, Week, or Month)>.

Note: The supplied SAS Enterprise Guide projects that you can use to create your own report definitions provide this default location. However, you can specify a different location for the report definition. For best results, use the default User Defined folders as detailed above for consistency and efficiency.

The following display shows the supplied report definitions that the Adapter Setup or Add Domain Category wizard uses for Day reports of the Server Disk domain category of the DT Perf Sentry adapter.
c. Select one or more report definitions that you want to add to the Performance Report transformation.

d. Click OK. The report definition appears in the Report Definitions table at the top of the Report Definitions tab.

To remove a report definition from the Report Definitions table, perform the following steps:

a. Select the report definition from the Report Definitions table at the top of the Report Definitions tab.
b. Click **Remove**. The report definition is removed from the **Report Definitions** table.

The **Properties of report definition** box provides additional information about the report definition that is selected in the **Report Definitions** table. The following display shows some of the properties that might be associated with a report definition.

**Note:** As shown in the following display, the properties of a report definition are also available from the **Extensions** tab of the report definition.

**Display 8.10  Properties of Report Definition Box of the Report Definitions Tab**

---

**T I P** Report definition names are unique within a domain category. However, they are not unique across all domain categories. The only means of distinguishing between two report definitions with the same name is by viewing their properties. You can use the information in the **Properties of report definition** box to confirm that you have selected the correct report definition for your report job.

**Table 8.1  Properties of Report Definitions on the Report Definitions Tab**

<table>
<thead>
<tr>
<th>Property</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report author</td>
<td>Specifies the user ID of the person who created the report definition. If the value is <strong>Supplied</strong>, then the report definition was supplied by SAS IT Resource Management and is used by the Adapter Setup and Add Domain Category wizards.</td>
</tr>
<tr>
<td>Property</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Domain category</td>
<td>Specifies the adapter and domain category for the report definition. For example, the value <strong>DTPerfSentry_ServerDisk</strong> indicates that the report definition corresponds to the Server Disk domain category of the DT Perf Sentry adapter. This value is a primary filter that is specified for the report definition in the ITRM Report Definition task. Verify that the adapter and domain category is correct for the IT data that you are using and the reports that you want to create.</td>
</tr>
<tr>
<td>Domain subcategory</td>
<td>(Optional) Specifies the domain subcategory that corresponds to the domain category for the report definition. This value is a primary filter that is specified for the report definition in the ITRM Report Definition task.</td>
</tr>
</tbody>
</table>
| Schedule frequency    | Specifies when the corresponding reports for the report definition should be scheduled to run. This value is a primary filter that is specified for the report definition in the ITRM Report Definition task.  
**Note:** This value is a report filter in metadata only. It does not affect the schedule for the corresponding report job. However, for best results, you should schedule the corresponding report job to run according to this filter. For example, if the schedule frequency is **Weekly**, then schedule the report job to run weekly. |
<p>| Keywords              | Specifies the keywords that the report definition assigns to the reports that it creates. Keywords are primary filters that are specified for the report definition in the ITRM Report Definition task. |
| Project               | Specifies the name of the SAS Enterprise Guide project that includes the ITRM Report Definition task that created the report definition. |
| Process flow          | Specifies the name of the process flow that includes the ITRM Report Definition task that created the report definition. |
| Report Definition     | Specifies the name of the ITRM Report Definition task that created the report definition. The ITRM Report Definition task and the report definition have the same name. |
| Data path             | (Optional) Specifies the path to the data source. |
| Data source           | Specifies the data source such as an information map. Verify that the data source is in the same folder as the report job. If it is not, verify that the data source is in the data path of the report definition or in the <strong>Data Source Folder</strong> of the Performance Report transformation. |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expire after</td>
<td>Specifies the number of days that the corresponding reports are stored in the SAS Content Server before they are expired. If a report is expired and its report job is run again, the expired report is deleted.</td>
</tr>
</tbody>
</table>

*Note:* The **Override Expiration Date** options in the Performance Report transformation can override this value.

For more information about the naming standards that SAS IT Resource Management uses for reporting components, see “About Naming Standards for SAS IT Resource Management Reporting Objects” on page 155.

The **Override Expiration Date** group box provides the ability to override the expiration date that is specified in the report definition.

**Display 8.11  Override Expiration Date Options on the Report Definitions Tab**

The following override options take effect the next time the report job is deployed and run.

- **Delete report content based on the expiration date in the report definition** causes the expiration date that is specified in the report definition to take effect. This option is the default.
- **Delete report content that is older than specified days** enables you to override the expiration data that is specified in the report definition. It enables you to enter the number of days that must elapse before the reports are deleted.

9. Click **OK**. The Performance Report transformation icon in the process flow diagram of the report job appears with a green check to indicate that it is complete and ready for execution.

10. Deploy and run the report job. For more information, see “About Report Jobs” on page 71.

**Edit a Performance Report Transformation**

To edit an existing Performance Report transformation, perform the following steps:

1. In the **IT Data Marts** tree of SAS IT Resource Management, double-click the job that contains the Performance Report transformation that you want to edit.

2. Right-click the Performance Report transformation in the process flow diagram and select **Properties**. A Properties dialog box is displayed and enables you to modify the various parameters that are specified for the Performance Report transformation and the code that it generates.

For more information about the specific parameters that are available for configuration in the Performance Report transformation, see the detailed steps in “Add a Performance Report Transformation to a Report Job” on page 78.

3. Click **OK** to save your changes.
4. Deploy and run the report job. For more information, see “About Report Jobs” on page 71.

Delete a Performance Report Transformation

To delete a Performance Report transformation from a job, perform the following steps:

1. In the IT Data Marts tree in SAS IT Resource Management, double-click the job that contains the Performance Report transformation that you want to delete.

2. Right-click the Performance Report transformation in the process flow diagram and select Delete. The Performance Report transformation object is deleted from the job.

3. Click OK to save your changes.

4. Deploy and run the report job. For more information, see “About Report Jobs” on page 71.

Specifying a Data Source Location

SAS IT Resource Management provides flexibility and portability of report jobs, Performance Report transformations, and report definitions by enabling you to specify the location of the source data for a report in various ways.

Here are the ways that you can specify the data source location and how the report job uses these paths to find the data source:

• In the Performance Report transformation and ITRM Report Definition task, do not specify a data path.

  A data source location might not be specified within the Performance Report transformation or report definition from an ITRM Report Definition task. In that case, the report job looks for the data source in the same IT data mart folder as the report job. This is the default and recommended scenario.

  **TIP** The Adapter Setup and Add Domain Category wizards store data sources (or information maps) in the same folder as their corresponding report jobs. Thus, a Performance Report transformation that the wizard creates does not include values in the Data Source Folder column. In addition, the report definitions that the wizard uses do not include data path locations. For consistency and portability of your reporting components, save your information maps in the same folder as their corresponding report jobs. In addition, do not specify a data source location in your Performance Report transformations or report definitions.

• In a Performance Report transformation, specify a data path by using the Data Source Folder field for a report definition. For more information, see “Add a Performance Report Transformation to a Report Job” on page 78.

  If you enter a data path in this field, then the report job uses this path, regardless of whether a data source location is specified in the report definition from the ITRM Report Definition task. If this field is blank, then the report job checks the corresponding report definition to identify a data source location.

  The default value is blank.
• In an ITRM Report Definition task, specify a data path by selecting Yes for the option Include data path in report definition. For more information, see “Create Report Definitions Using the ITRM Report Definition Task” on page 63.

If you select Yes to include the data path in the report definition, then the path is hard coded with the report definition. In addition, the data path appears in the Properties of report definition box of the Performance Report transformation. The report job uses this path, unless the corresponding Performance Report transformation includes a value for the Data Source Folder that overrides the report definition.

By default, the ITRM Report Definition task does not specify a data path in the report definition that it creates.

### About Templates and Style Sheets

#### What Are Templates and Style Sheets

The visual appearance of the reports that SAS IT Resource Management creates is controlled by the following two style components:

- **template**
  - describes the default visual aspects (colors, fonts, lines, markers, and so on) of the report graph. The template resides on the server.

- **style sheet**
  - describes the default visual aspect of report elements that are outside of the graph area such as borders, banners, titles, footnotes, and so on. The style sheet is a *.css file that resides on the client workstation and on the middle tier.

SAS IT Resource Management provides a default template and style sheet for your IT reports. The Adapter Setup and the Add Domain Category wizards and the supplied SAS Enterprise Guide projects use the default template and style sheet to specify the visual style of the reports that they create.

#### About the Default Template for SAS IT Resource Management Reports

SAS IT Resource Management provides a default template file named `tmplitrm.sas7bitm` that creates a default template named `ITRMDefault`. This default template includes updates to a parent template called `styles.analysis` that SAS provides. These updates include specifications for graph colors in charts and plots. You can make a copy and modify the source code if you want to create a modified version of the template.

During installation, SAS IT Resource Management saves the default template files and their source code in folders on the server tier.

Here are the locations of the source code for the templates, based on operating system:

- **Windows:** `<sashome>\SASFoundation\9.4\itrmmvadata\sasmisc`
- **UNIX:** `<sashome>/SASFoundation/9.4/misc/itrmmvadata`
- **z/OS:** `&prefix.ITRM.CPMISC`
Here are the locations of the template, based on operating system:

- **Windows**: `<sashome>\SASFoundation\9.4\itrmmvadata\sashelp`
- **UNIX**: `<sashome>/SASFoundation/9.4/sashelp`
- **z/OS**: `&prefix.mnnn.SASHHELP` where `mnnn` is the country encoding. For example, if `mnnn=ENW0` for English, then the location is `&prefix.ENW0.SASHHELP`.

### About the Default Style Sheets for SAS IT Resource Management Reports

Default style sheets for SAS IT Resource Management reports are named `ITRMDefault.css`. These style sheets include report specifications that are unique to SAS IT Resource Management. For example, the report banners represent SAS IT Resource Management and the title fonts as well as border colors complement the visual properties that are specified in the default template for SAS IT Resource Management reports.

SAS IT Resource Management provides two default style sheets. One style sheet specifies the properties for the reports that the supplied SAS Enterprise Guide projects generate. The other style sheet specifies the properties for batch reports. These two style sheets include identical specifications except for the report banner.

The default style sheet that is used in the supplied SAS Enterprise Guide projects includes a SAS IT Resource Management banner. This enables you to see the banner when you run reports interactively with SAS Enterprise Guide. This default style sheet is saved in the same location as the SAS Enterprise Guide style sheets on the client workstation. For example, for a Windows system, the location for the style sheet is in the `<SAS install location>\SAS\EnterpriseGuide<version>\Styles` folder (such as `C:\Program Files\SAS\EnterpriseGuide\6.1\Styles` for SAS Enterprise Guide 6.1 running on Windows).

The default style sheet that batch reports use is stored in the SAS Content Server, and it does not include specifications for a report banner. This enables the batch reports to be generated without a banner and thus be easier to view in the ITRM Report Center. This version of the style sheet is saved in the web application server directory on the middle tier at `<web application root>/SASContentServer/repository/default/sasdav/Stylesheets/ITRMDefault.css`.

For more information about how to include your own corporate logo in a banner on an interactive style sheet, see the “Editing Styles: Using Background and Banner Images” topic in the SAS Enterprise Guide Help.

### Working with Templates and Style Sheets

#### Overview

You can use the default templates and style sheets that SAS IT Resource Management provides or you can create your own. You can choose to create your own template or style sheet. If you do, use the defaults as a parent or model and make only the necessary adjustments for your custom needs.

**Tip** Before you modify a template, style sheet, or any other reporting component that SAS IT Resource Management provides, make a copy of the supplied component as a backup and modify the copy.
SAS IT Resource Management enables you to identify the templates and style sheets that you want to use for reports. However, these components are created and specified with other SAS products. For example, you can use Base SAS to create and specify a template by invoking and specifying the TEMPLATE procedure. You can use SAS Enterprise Guide to work with style sheets.

As you work with templates and style sheets for your IT reports, refer to the documentation in the appropriate SAS product for more information. For more information about how to work with templates, see the documentation for the TEMPLATE procedure in *SAS Output Delivery System: User’s Guide* at http:\\support.sas.com. For more information about how to work with style sheets, see the Help for SAS Enterprise Guide.

### Create or Specify a Different Template for Batch Reports

To create or specify a different template for batch reports, perform the following steps:

1. Use Base SAS to create a new template by modifying the template source file. For best results, save the new source file and template file with the new name in the same location as the default template at `<SAS install location>\SAS\SASFoundation\9.4\itrmvdata\sasmisc` (such as `C:\Program Files\SAS\SASFoundation\9.4\itrmvdata\sasmisc`) and `<SAS install location>\SAS\SASFoundation\9.4\itrmvdata\sashelp`.

   For more information about modifying a report template, see the documentation for PROC TEMPLATE at http:\\support.sas.com.

2. Modify the Performance Report transformation in your report jobs to specify the new template name.

3. Redeploy your report jobs.

*Note:* For best results, use the same template when working with SAS Enterprise Guide interactively. For more information about working with style sheets in SAS Enterprise Guide, see the Help for SAS Enterprise Guide.

### Create or Specify a Different Style Sheet for Batch Reports

If you want to use a style sheet other than the one that is already specified in your report jobs, perform the following steps:

1. Make a copy of the default style sheet and use a text editor or SAS Enterprise Guide to modify the style sheet specifications. For more information about working with style sheets in SAS Enterprise Guide, see the Help for SAS Enterprise Guide.

2. Copy your new style sheet to one of the following supported locations:
   - the web application server directory on your middle tier (such as `<webapp root>/SASContentServer`).
   - a folder on all clients where the web browser is initiated (such as `file://c:/program files/<folder name>/`).

   *Note:* For ease-of-use and portability of report jobs, use the web application server location.

3. Modify the Performance Report transformation in your report jobs to point to the new style sheet name and location.

4. Redeploy your report jobs.
Note: For best results, use the same style sheet when working with SAS Enterprise Guide interactively. For more information about working with style sheets in SAS Enterprise Guide, see the Help for SAS Enterprise Guide.
What Is ITRM Report Center? .......................................................... 97
Accessing ITRM Report Center Interface ................................. 100
  Log On as a Registered User .................................................. 100
  Log Off from ITRM Report Center ........................................ 101
How to Get Help and Documentation for ITRM Report Center .......... 101
Features of ITRM Report Center .............................................. 102
  How to Organize Reports ..................................................... 102
  How to View Reports ....................................................... 103
  Copying Reports into Albums and E-mailing Reports ............. 105

## What Is ITRM Report Center?

ITRM Report Center is a web application that enables users to view, organize, filter, and share SAS IT Resource Management performance and exception reports. From the workspace bar, you can access the **Home**, **Gallery**, **Resource**, and **Administration** workspaces.

The following list briefly describes the four workspaces and the general functions that ITRM Report Center provides. (The **Home**, **Gallery**, **Resource**, and **Administration** workspaces are described in more detail in the *SAS IT Resource Management: Report Center Guide*.)

- The **Home** workspace consists of three main sections: **Watch List**, **Alerts**, and **Recent Work**.
The **Home** workspace enables you to access your personal watch lists, alerts, and recent work. This workspace is accessible by all users. For more information, see Chapter 2, “Overview of the Home Workspace,” in the *SAS IT Resource Management: Report Center Guide*.

- The **Gallery** workspace enables you to access folders, galleries, and albums that are used to organize and share SAS IT Resource Management reports. This workspace is accessible by all users. For more information, see Chapter 3, “Overview of the Gallery Workspace,” in the *SAS IT Resource Management: Report Center Guide*.
The **Resource** workspace enables you to view SAS IT Resource Management reports from a hierarchical perspective for each resource in ITRM Report Center. This workspace is accessible only by users who are members of groups that are members in the IT Resource Management: User role or the IT Resource Management Administrators group. For more information, see Chapter 4, “Overview of the Resource Workspace,” in the *SAS IT Resource Management: Report Center Guide*.

**Display 9.3**  The Resource Workspace

As shown in the following display, the **Administration** workspace provides an administrator with the ability to view the folders in the SAS Content Server and to create locations where reports are stored and assign those locations for users’ reports in the SAS Content Server. You can also purge reports and refresh the cache.

The **Administration** workspace is where some ITRM Report Center administrative tasks are performed. These tasks include creating SAS Content Server locations and assigning access to those locations to ITRM Report Center User groups, purging reports, and refreshing the ITRM Report Center cache. This workspace is accessible by users who are members of the IT Resource Management Administrators group.
Accessing ITRM Report Center Interface

Log On as a Registered User

Starting with SAS IT Resource Management 3.4, access to some ITRM Report Center workspaces and functions is controlled by SAS metadata-based application roles. Permission to access SAS Content Server locations where IT Resource Management reports are available is controlled by SAS metadata-based application groups. Membership in roles and groups is established and maintained by your SAS administrator using SAS Management Console. For more information about groups and roles, see the SAS Management Console: Guide to Users and Permissions.

To log on to ITRM Report Center, perform the following steps:

1. In the address bar of your web browser, enter the URL for ITRM Report Center. For example, you might use the following URL to access your ITRM Report Center:

   \[http://<Middle-Tier-Server-Name>/ITRMReportCenter\]

   Alternatively, you might use this URL:

   \[http://<Middle-Tier:Port#/ITRMReportCenter\]

   *Note:* Contact your system administrator if you do not know the URL for ITRM Report Center.

   Then press Enter. The logon window for ITRM Report Center appears.
Display 9.5  ITRM Report Center Log On Window

2. Enter a user ID and password. Your user ID and password are case-sensitive.
3. Click Log On. The ITRM Report Center interface appears.

Log Off from ITRM Report Center

To log off from ITRM Report Center, click Log Off in the upper right corner of the user interface.

By default, if ITRM Report Center is open for 30 minutes with no activity, then a warning message appears. This message states that you will be logged off and the session will close unless you choose to continue the session.

How to Get Help and Documentation for ITRM Report Center

This section provides a brief overview and introduction to ITRM Report Center. However, more documentation is available for this application.

You can use the following two types of documentation to find more information about the features, benefits, and capabilities of ITRM Report Center:

Embedded Help

Help pop-ups and tooltips provide brief descriptions of various tasks and fields to help you use ITRM Report Center effectively.

To access a Help pop-up for more information about a current topic, click the Help icon (🔒) when it appears next to a field or area in the user interface. You can also place the mouse pointer over an element in the user interface to view the associated tooltip for more information.

SAS IT Resource Management 3.4: Report Center Guide

This document provides detailed information about the concepts and tasks that are related to using ITRM Report Center. To access this document, click Help ➔ User’s Guide (PDF) in the application.

Additional documentation and references are also available from the Help menu in ITRM Report Center. To access these resources, click Help in the ITRM Report Center application and select from the following menu options:

• SAS on the Web includes the following options:
• **SAS IT Resource Management Report Center 3.4** opens the SAS IT Resource Management documentation page on the web ([http://support.sas.com/itrm](http://support.sas.com/itrm)). This page provides access to all the documentation (PDF and HTML) for the SAS IT Resource Management solution.

• **SAS Customer Support** opens the SAS Customer Support page. This page provides access to the Knowledge Base, Support, Training and Bookstore, and more.

• **SAS Training** opens the Training and Bookstore page.


• **About SAS IT Resource Management Report Center 3.4** provides more information about the version of the application and related details.

---

**Features of ITRM Report Center**

**How to Organize Reports**

You can organize SAS IT Resource Management reports with the following components:

• **Albums**

*Albums* are containers for reports that you want easy access to. They can be thought of as point-and-click-galleries. When you open an album, it resembles and behaves like a gallery. Galleries and albums differ only in how they are created. A gallery is created with the **New Gallery** wizard. It is modified by using the **Edit Gallery** wizard. An album is created by selecting reports from existing galleries and using the Copy Link to Album icon ( ) that is available from the workspace bar. You do not use a wizard to create or edit it.

• **Galleries**

A **gallery** is a group of reports that share common filter values. You can organize SAS IT Resource Management reports by creating a gallery that includes all of the reports that meet a specific criterion. For example, you might create a gallery to include all available reports for a particular machine, adapter data source, or keyword.

ITRM Report Center also enables you to further subset or filter the reports in a gallery for viewing. Thus, you can quickly view a smaller set of reports in a gallery to measure and analyze the utilization, availability, performance, and statistical trends of IT resources for your enterprise.

• **Gallery Folders**

A **gallery folder** is a container for galleries, albums, and other gallery folders. These folders function like typical folders in a tree. You can use these folders to group related galleries, albums, and gallery folders. For example, you might create a single gallery folder to include all of your galleries for DT Perf Sentry reports.

• **Resources**

A **resource** can be a type of device, machine, system, environment, or other category of IT resources. In the **Resource** workspace, you can view reports hierarchically by the resource type.
How to View Reports

In ITRM Report Center, the **Gallery** and **Resource** workspaces provide four views of the reports that you select. Use the arrow on the taskbar to select the type of display that you want to view. In the following display, the flow view is chosen.

**Display 9.6  Taskbar with Flow Icon Circled**

- The grid (or table) view displays the reports and their associated metadata in a tabular format. You can quickly scan these reports for similarities and double-click an individual report to view a large image of it in a separate browser window.

  Click to display the reports in the grid view.

**Display 9.7  Reports in the Grid (or Table) View**

The tile view displays a thumbnail view of each report and enables you to minimize, expand, and arrange the reports in the gallery. Click to display the reports in the tile view.
Display 9.8  Reports in the Tile View

- The flow view displays the reports as moveable pages so that you can navigate through a sequence of reports that are stacked together.

Click [Flow] to display the reports in the flow view.

Display 9.9  Reports in the Flow View

- The Preview pane displays a shortened version of the grid view. You can double-click an individual report to view a thumbnail image of it in your current window.
Copying Reports into Albums and E-mailing Reports

ITRM Report Center enables you to copy reports of particular interest into albums. You can also e-mail reports that are in albums.
Part 3

Report Administration

Chapter 10

Administrative Tasks ...................................................... 109
Overview of Administrator Tasks

The SAS IT Resource Management administrator performs many tasks from ITRM Report Center. Some tasks, such as backing up the contents of the SAS Content Server, require access to the SAS Content Server.

For information about the SAS Content Server, see “Working with the SAS Content Server”.

Some administration tasks in ITRM Report Center require access to the Administration workspace. To access this workspace and to perform other administrative tasks, log on to ITRM Report Center with a user ID that is in the IT Resource Management Administrators group. For information about ITRM Report Center and the workspaces that it provides, see the SAS IT Resource Management 3.4: Report Center Guide.

The SAS IT Resource Management administrator can:

• Back Up Reports on the SAS Content Server on page 111
• Create a Location on the SAS Content Server on page 111
• Delete a Location from the SAS Content Server on page 114
Working with the SAS Content Server

What Is the SAS Content Server?

The SAS Content Server is a web-based Distributed Authoring and Versioning (WebDAV) server. It is a content repository that stores digital content (such as documents, reports, and images) that is created and used by several SAS client applications. SAS IT Resource Management, and other SAS products such as SAS Web Report Studio and SAS Information Delivery Portal, use the SAS Content Server for storage of their reports and supporting files.

How Does SAS IT Resource Management Use the SAS Content Server?

SAS IT Resource Management uses the SAS Content Server to store reports and report metadata that are output from Performance Report and Exception transformations.

The jobs that include these transformations must specify the repository folder path, relative to the SAS Content Server, in which to store the reports.

Performance reports and exception reports are stored on the SAS Content Server in corresponding subfolders of the `SASContentServer/repository/default/` folder.

The reports are stored in the following locations on the SAS Content Server:

- Performance reports: `SASContentServer/repository/default/sasdav/ <root-location>/<IT data mart name>_job name/report definition name`
- Exception reports: `SASContentServer/repository/default/sasdav/ <root-location>/<IT data mart name>_job name/Exception transformation name`

Note: The default value of the `root-location` is `ITRM`. However, if you have administrator privileges, you can add additional root locations to the SAS Content Server. For more information, see “How to Create and Assign Access to a SAS Content Server Location Using ITRM Report Center” on page 113.
Administrator Tasks

Back Up Reports on the SAS Content Server

To back up your SAS IT Resource Management reports, you must back up the SAS Content Server that stores the reports. If you are an administrator, then back up the SAS Content Server on a regular basis. The administrator should also back up the SAS Content Server before manually deleting any reports from the SAS Content Server.

For more information about backing up reports, see Appendix 10, “Best Practices and Troubleshooting Tips,” in the *SAS IT Resource Management 3.4: Administrators Guide*.

Create and Assign Access to SAS Content Server Locations

About Root Locations

All reports that are generated by Performance Report and Exception transformations are automatically stored in the SASContentServer/repository/default/sasdag/<root-location> folder. At installation, the default root location for SAS IT Resource Management is set as ITRM. Additional ITRM root locations can be created for use by SAS IT Resource Management. These root locations are useful when a site wants to grant different groups of users the access to view sets of SAS IT Resource Management reports.

*Note:* Additional root locations that you create are at the same hierarchical level in the SAS Content Server as the ITRM folder, which is the default location for reports.

By default, all ITRM Report Center groups (because they are members of the SASUSERS group) can access reports in the SASContentServer/repository/default/sasdag/ITRM location. When multiple SAS IT Resource Management root locations are used, you can change the location for SASUSERS to a general, or even empty, SAS Content Server folder location. (This technique might also be useful when reports from SAS IT Resource Management 3.3 or earlier are migrated because those reports are migrated to the default SAS IT Resource Management SAS Content Server folder.) When no reports will be shared between groups, do not write any reports to the default SAS Content Server location used by SAS IT Resource Management.

*Note:* All members of the IT Resource Management Administrators group have permission to access all SAS Content Server locations that are used by SAS IT Resource Management. Therefore, the IT Resource Management Administrator group does not appear in the User Group column of the Assign location to user group pane.

After you set up the additional root location, use the SAS IT Resource Management client to open the job that contains the Performance Report or Exception transformation whose reports you want to store in a specific root location. Right-click the transformation and select Properties. On the Server tab, select the root location that you added. This action ensures that your reports are stored in the selected root location, not in the default ITRM location on the SAS Content Server. To allow members of IT Resource Management Users groups in ITRM Report Center to have access to these reports, assign access to the SAS Content Server locations that you added to those user groups.
Working with Multiple SAS Content Server Locations

You might want to restrict access to certain sets of SAS IT Resource Management reports that are stored in the SAS Content Server. To do this, set up additional root locations on the SAS Content Server. For example, you might set up an additional root location called **ITRM_Sales** that contains reports for people who have privileges for viewing SAS IT Resource Management reports for IT resources allocated to the Sales division. Alternatively, you might want to set up a root location called **ITRM_Accounting** that permits access only by people who have privileges for viewing IT Resource Management reports for IT resources allocated to the Accounting division.

As shown in the following example, there are three ITRM Report Center user groups. Each of these groups has access to SAS Content Server locations that are used by SAS IT Resource Management. The ITRM_Sales and ITRM_Accounting groups are created as members of the IT Resource Management Users group. (The IT Resource Management Users group that is supplied by SAS IT Resource Management is a member of the IT Resource Management: User role and the IT Resource Management: Report Center Group role.)

- Members of the IT Report Center Viewers (SASUSERS) group have access to the SAS IT Resource Management reports written to the default ITRM Report Center SAS Content Server location.

- ITRM_Sales members have access to reports that are written to that location in the ITRM Report Center SAS Content Server. Because they are also members of the SASUSERS group, they also have access to reports that are written to the default ITRM Report Center SAS Content Server location.

- ITRM_Accounting members have access to reports that are written to that location in the ITRM Report Center SAS Content Server. Because they are also members of the SASUSERS group, they also have access to reports that are written to the default ITRM Report Center SAS Content Server location.

Display 10.1  Example of Multiple Accessing of SAS Content Server Locations

Note: If you want access to all of the SAS IT Resource Management reports in this example, then you need to be a member of both ITRM_Sales and ITRM_Accounting, or you need to be an IT Resource Management administrator.
How to Create and Assign Access to a SAS Content Server Location Using ITRM Report Center

To add an additional location to the SAS Content Server, you must be a member of the IT Resource Management Administrators group supplied when SAS IT Resource Management is installed. Then, log on to ITRM Report Center as a SAS IT Resource Management administrator and select the Administration workspace to access the following window.

Display 10.2 Administration Workspace

Then, perform the following steps:

Create a New SAS Content Server Location

1. Click Create Location. This dialog box appears:

Display 10.3 Create Location Dialog Box

2. On the Create Location dialog box, enter the Folder Name. Entering text in the Description box is optional.

3. In the Folder Name field, enter the name of the folder where you want to store your reports. (Only alphabetic characters, numbers, and the underscore character are valid when entering text into this field.)
• [Optional] Enter a description of the folder.
• Click Save.

When the new root location is created, the principal user (jcr:authenticated) is set to Yes for the newly created path for all permissions, such as Read, Write, and so on.

Note: You can verify this by navigating to the Permission page of the newly created location in the SAS Content Server.

**Assign the New Location to an IT Resource Management User Group**

4. Navigate to the Assign Location to User Group section of the workspace.

**Display 10.4 Assign Location to User Group**

Note: To assign a group to a SAS Content Server location, that group must be a member of the IT Resource Management: Report Center Group role.

Select the user group that you added. Then click Change Location.

5. The Change Location dialog box appears.

**Display 10.5 Change Location**

In the Change Location dialog box, click the arrow in the Location field. A list of all available SAS Content Server locations that are used by SAS IT Resource Management is displayed. Select the location to be assigned to the user group.

**Delete a Location from the SAS Content Server**

To remove a location from the SAS Content Server, perform the following steps:

1. Log on to SAS Management Console as a SAS administrator.
2. Click the Plug-ins tab. In the left panel, select Server Manager.
3. Right-click SAS Content Server and select Properties.
4. Click the Options tab. The following display appears:
5. From the Selected Items column, select the location that you want to delete.

6. Click Delete. Then click OK to return to the main window of SAS Management Console.

   Note: Deleting the location does not delete folders or reports from the SAS Content Server. This action only deletes the location so that it is not available in the SAS IT Resource Management client and in ITRM Report Center.

7. (Optional) The administrator can delete reports from the SAS Content Server by using the SCS Admin Console. For more information, see “Administering the SAS Content Server” in the SAS 9.4 Intelligence Platform Middle-Tier Administration Guide.

**Delete Reports from the SAS Content Server**

You might want to delete reports from your SAS Content Server. To do so, log on to the SAS Content Server Administration Console with the SAS metadata-based Metadata Server: Unrestricted role. Then perform the following steps:

1. Navigate to `http://<your-Middle-Tier-name>;<port-number>/SASContentServer/dircontents.jsp?path=/sasdav/ITRM_prod`. As shown in the following display, the reports are in a folder called DTPerfSentryReports_System_Daily_Reporting.
2. Select **DTPerfSentryReports_System_Daily_Reporting** from the list of items.

3. Click **Delete**.

   **CAUTION:**
   
   *Exercise caution when clicking the Delete box.* As soon as you click **Delete**, the selected objects are deleted.

   **Note:** Delete reports only at the package level. Do not delete individual reports. If you do so, the metadata for those reports is not deleted, and a link to the report is displayed as broken.

   Refresh the cache for the appropriate root location after the deletion. You can perform this action from the **Administration** workspace on ITRM Report Center. Deleting reports and refreshing the cache while users are logged on to ITRM Report Center can cause temporary unexpected results for users.

   **Note:** For more information, see Chapter 10, “Administering the SAS Content Server,” in the SAS 9.4 Intelligence Platform: Middle-Tier Administration Guide.

   **TIP**
   
   This method can also be used to delete folders from the SAS Content Server.

---

### Delete Sample Reports from the SAS Content Server

SAS IT Resource Management is installed with 34 sample reports. These sample reports provide examples of the type of reports that SAS IT Resource Management generates. The reports are located in a folder called **sasdav\ITRM\SampleReports** in the SAS Content Server.

After you have worked with the sample reports that SAS IT Resource Management provides, you might want to delete them from your SAS Content Server. To do so, perform the following steps:

1. Navigate to **http://<your-Middle-Tier-name>:<port-number>/SASContentServer/dircontents.jsp?path=/sasdav/ITRM**. (For more information, see Chapter 10, “Administering the SAS Content Server,” in the SAS 9.4 Intelligence Platform: Middle-Tier Administration Guide.)

   As shown in the following display, the sample reports are in a folder called **SampleReports**.
2. Select Sample Reports from the list of items.
3. Click Delete.

Display 10.9 Deleting Sample Reports

CAUTION: Exercise caution when clicking the Delete box. As soon as you click Delete, the selected objects are deleted.

Note: Delete reports only at the package level. Do not delete individual reports. If you do so, the metadata for those reports is not deleted, and a link to the report is displayed as broken.

Refresh the cache for the ITRM root location after the deletion. You can perform this action from the Administration workspace on ITRM Report Center. Make sure that the cache update is invoked when users are not logged on to ITRM Report Center.

Note: Deleting reports and refreshing the cache while users are logged on to ITRM Report Center can cause temporary unexpected results for users.

When the refresh is initiated by the administrator, this message is displayed to all users who are logged in: “Administrator has initiated refresh cache at location: /SASContentServer/repository/default/sasdav/<root-location>”.

When the refresh has completed, this message is displayed to all users who are logged in: “Refresh cache at location /SASContentServer/repository/default/sasdav/<root-location> is finished”.

TIP These messages are displayed at the bottom of the ITRM Report Center UI.

Note: For more information, see Chapter 10, “Administering the SAS Content Server,” in the SAS 9.4 Intelligence Platform: Middle-Tier Administration Guide.

**Purge Reports from the SAS Content Server**

To purge reports from the SAS Content Server, perform the following steps:
1. Log on to ITRM Report Center and navigate to the Content Server Locations section of the Administration workspace:

   **Display 10.10  Content Server Locations of the Administration Workspace**

   ![Content Server Locations](image)

2. Select the location whose reports you want to purge.

3. Click **Purge Reports**. The following dialog box appears:

   **Display 10.11  Purge Reports from the SAS Content Server**

   ![Purge Reports](image)

4. Click the option that indicates how to determine whether a report should be purged. Then click **Purge**. If you select the option to purge content that is older than the specified number of days, only those reports that satisfy those criteria are purged. Expired reports whose content is not older than the specified number of days are not purged.

   A note is displayed at the bottom of the window when the purge is finished.

   **Note:** If reports are deleted manually using SCS Admin Console, then you should click **Refresh Cache**.

---

**Refresh the ITRM Report Center Cache**

**About the ITRM Report Center Cache**

ITRM Report Center enables you to access, view, and manage all of the SAS IT Resource Management reports that are stored within the **root-location** folder or its subfolders. The **root-location** folder on the SAS Content Server is scanned and the report metadata that is retrieved is stored in the ITRM Report Center cache. Using this cache enables ITRM Report Center to retrieve reports from the SAS Content Server more quickly.

The cache is updated during the following events:

- when ITRM Report Center starts
- when a SAS IT Resource Management performance report or exception job is run
- when the SAS IT Resource Management administrator forces a cache update.
How to Refresh the ITRM Report Center Cache

To force a cache update, log on to ITRM Report Center and select the Administration workspace. The following display appears:

Display 10.12 Administration Workspace of ITRM Report Center

Select the location that you want to refresh. Then click Refresh Cache. When the cache is being updated, a message appears at the bottom of the UI.

Note: Refreshing the cache might cause a temporary disruption to users who are logged on.

Change the Maximum Number of Reports to Be Returned from the Create Gallery Filters

When you create a gallery in ITRM Report Center, you use primary and secondary filters to subset the reports that are on the SAS Content Server. By default, primary filters must reduce the number of reports to no more than 100,000 before you can continue with the next step to subset the reports further with secondary filters. Secondary filters must reduce the number of reports to no more than 3,000. In some cases, when galleries are created, the total number of reports returned from the primary and secondary filters might exceed 3,000 (or the SecondaryReportCount value). If so, then the reports that exceed that 3,000 limit are omitted from the gallery.

Note: The default SecondaryReportCount of 3,000 reports can be changed by a SAS administrator. Regardless of the value specified for this parameter, however, an absolute maximum of 5,000 reports, enforced by ITRM Report Center, can be displayed for a single gallery.

The default limits are specified to help manage the size of galleries and avoid unnecessarily large report sets that make it difficult to locate specific reports. However, you can specify the default limits to meet the needs of your organization if you need larger or smaller galleries.

To specify your own default limits, perform the following steps:
1. Open SAS Management Console with administrator login credentials. (To update the default report limits for the primary and secondary filters, use the SAS Administrative ID.)

2. On the Plug-ins tab, select Application Management ➔ Configuration Manager ➔ SAS Application Infrastructure.

   **Note:** The Configuration Manager is installed as part of the SAS Web Infrastructure Client. If you do not see this plug-in in SAS Management Console, then you can install it in the Software Deployment wizard. To do so, select Install Additional Software and select the SAS Web Infrastructure Client.

3. Expand SAS Application Infrastructure.

4. Right-click ITRM Report Center 3.4 and select Properties.

5. On the Advanced tab, the following window appears:

   **Display 10.13 Advanced Tab of ITRM Report Center Properties**

   ![Advanced Tab of ITRM Report Center Properties](image)

   Then specify the following parameters:

   - `itrmrc.PrimaryReportCount` specifies the limit for primary filters.

   **Note:** The value for these parameters can be any positive integer.

6. Click OK. Restart ITRM Report Center.

### Change the Number of Items to Be Included in the Watch List

By default, the number of items that can appear on the Watch List of the Home workspace is 25. To reset that number, perform the following steps:

1. Open SAS Management Console with administrator login credentials.
2. On the Plug-ins tab, select Application Management ➔ Configuration Manager ➔ SAS Application Infrastructure.
3. Expand SAS Application Infrastructure.
4. Right-click ITRM Report Center 3.4 and select Properties.
5. On the Advanced tab, the following window appears:
6. Look for `itrmrc.WatchItemCount` and specify the desired number of items.
7. Click OK. Restart ITRM Report Center.
1. Open SAS Management Console with administrator login credentials. (To update the default report limits for the primary and secondary filters, use the SAS Administrative ID.)

2. On the **Plug-ins** tab, select **Application Management ➔ Configuration Manager ➔ SAS Application Infrastructure**.

   **Note:** The Configuration Manager is installed as part of the SAS Web Infrastructure Client. If you do not see this plug-in in SAS Management Console, then you can install it in the Software Deployment wizard. To do so, select **Install Additional Software** and select the SAS Web Infrastructure Client.

3. Expand **SAS Application Infrastructure**.

4. Right-click **ITRM Report Center 3.4** and select **Properties**.

5. On the **Advanced** tab, the following window appears:

   **Display 10.14  Advanced Tab of ITRM Report Center Properties**

   Specify the following parameter:
   - **WatchListItemCount** specifies the limit for watch list items.

6. Click **OK**. The change takes effect immediately.

   **Note:** You can use this method to increase or decrease the number of items in the watch list.
Update the List of Available Alerts

At installation, SAS IT Resource Management supplies a list of notification types. This list is accessible to a SAS administrator. You can change the list of available alerts that are presented on this window.

**CAUTION:**

**Exercise caution with this procedure.** Removing alerts might adversely affect users who depend on receiving existing alerts.

To update the list of available alerts, perform the following steps:

1. Log on to SAS Management Console as the SAS administrator.
2. In the left pane, navigate to the Application Management section. Right-click **IT Resource Management 3.4** and select **Properties**.
3. Select the **Advanced** tab. The IT Resource Management 3.4 Properties dialog box appears.

   **Display 10.15  Application Management Properties Dialog Box**

   The list of available alerts is shown on the `itrm.AlertEvents` line of this dialog box. As the SAS administrator, you can edit the **ITRM AlertEvents** and **AlertPriority** items in the Property Value column shown in the previous display.

4. Click the Lock icon on the `itrm.AlertEvents` line to unlock that property.
5. Copy the list of properties for this item. (Do this so that you can add the existing alerts back to the Properties dialog box along with the additional alerts that you want to include.) Then, click Remove to delete the itrm.Alert.Event property.

6. Retrieve the copied list of alerts and add the new alerts to that list. Then click Add.

7. Click the Unlock icon to lock the property. Click OK.

**View the Content in the SAS Content Server**

To view reports in the SAS Content Server, do the following:

1. Log on to ITRM Report Center as a SAS IT Resource Management administrator.

2. Click the Administration tab. The Administration workspace appears.
3. Click **Open SCS Viewer Console**.

4. Select `sasdav` \(<\text{your-report-folder-name}>\).

The following display shows a list of reports in the folder called `SCOMSampleReports_New Job day` in the `/default/sasdav/ITRM` folder of the SAS Content Server:

**Display 10.18**  List of Reports on `/default/sasdav/ITRM` disk

- `DiskSpaceLowAvailabilityShiftForTheDay`
- `DiskResponseHighResponsePlotsIntervalForTheDay`
- `DiskQueueHighUsageChartShiftForTheDay`
- `DiskSpaceLowAvailabilityListForTheDay`
- `DiskTransferHighResponseChartShiftForTheDay`
- `DiskResponseHighResponseChartShiftForTheDay`
- `DiskResponseHighResponsePlotResourceForTheDay`
- `DiskQueueHighUsageBarLinesHoursForTheDay`
- `DiskSpaceLowAvailabilityPlotIntervalsForTheDay`
- `DiskQueueHighUsagePlotIntervalsForTheDay`
- `DiskQueueHighUsagePlotHoursForTheDay`
- `DiskResponseHighResponsePlotRectsForTheDay`
- `DiskQueueHighUsagePlotRectsForTheDay`
- `DiskSpaceLowAvailabilityTheHoursForTheDay`
- `DiskResponseHighResponseReportHoursForTheDay`
- `DiskResponseHighResponseBarLinesHoursForTheDay`
- `DiskResponseHighResponsePlotRectForTheDay`
- `DiskSpaceLowAvailabilityTheHoursOfTheDay`
- `DiskTransferHighResponseListForTheDay`
- `DiskSpaceLowAvailabilityChartIntervalsForTheDay`

5. Click the report that you want to view.
Part 4

Interactive Reporting and Using the SAS Portal and SAS BI Dashboard

Chapter 11
   About Interactive Reporting ................................................. 127

Chapter 12
   Using SAS Enterprise Guide Interactively ............................. 129

Chapter 13
   Using SAS Web Report Studio Interactively ......................... 133

Chapter 14
   Using SAS Add-In for Microsoft Office Interactively ............. 139

Chapter 15
   Using SAS Portal for Communicating IT Domain Intelligence .... 143

Chapter 16
   Using SAS BI Dashboard .................................................. 147

Chapter 17
   Working with SAS Visual Analytics ...................................... 151
Chapter 11
About Interactive Reporting

Overview of Interactive Reporting

The recommended method for generating, managing, and viewing SAS IT Resource Management reports is to run the report jobs that were created by the Adapter Setup or Add Domain Category wizard or by user-specified Performance Report transformations. The report jobs are typically run in batch mode and the resulting reports are managed and viewed in ITRM Report Center. However, there are situations that require reports to be generated interactively (for example, when performing specific IT performance analysis or when developing a new report). SAS provides the following solutions that enable you to run or view reports interactively:

- SAS Enterprise Guide
- SAS Web Report Studio
- SAS Add-In for Microsoft Office
- SAS Information Delivery Portal
- SAS BI Dashboard

These solutions are discussed briefly in the following chapters of this reporting guide.
Chapter 12
Using SAS Enterprise Guide
Interactively

Overview of SAS Enterprise Guide
How to Start SAS Enterprise Guide ............................. 129
Accessing IT Data Marts Using SAS Enterprise Guide .... 130
Accessing SAS IT Resource Management Projects with SAS Enterprise Guide . 130
Locating SAS Enterprise Guide Documentation ............ 131

Overview of SAS Enterprise Guide

What Is SAS Enterprise Guide?

SAS Enterprise Guide is a Microsoft Windows client application that provides a guided mechanism to exploit the power of SAS. SAS Enterprise Guide uses projects to manage a collection of related data, tasks, code, and results. With projects, you can run multiple tasks on the same group of data files and create interactive or ad hoc reports.

SAS Enterprise Guide provides comprehensive report tasks and reporting services that SAS IT Resource Management uses to generate analysis and intelligence about your IT resources. You can use the supplied IT Resource Management EG projects to run the supplied reports interactively or you can create your own. For more information, see “About the ITRM Report Definition Task” on page 61.

How to Start SAS Enterprise Guide


The Welcome to SAS Enterprise Guide dialog box appears.
You can select any of the options in the Welcome window.

*Note:* Make sure you have access to the project that you want to work with.

**Accessing IT Data Marts Using SAS Enterprise Guide**

Before you begin working with SAS Enterprise Guide projects, you must use the functions of SAS Enterprise Guide in order to perform the following tasks:

- Set up SAS Enterprise Guide so that it can work with SAS IT Resource Management data.
- Migrate SAS Enterprise Guide projects so that they can work with your SAS IT Resource Management 3.4 IT data marts, in which you created the report data

For more information about how to complete these tasks, see “Preparing to Work with SAS Enterprise Guide” on page 50.

**Accessing SAS IT Resource Management Projects with SAS Enterprise Guide**

The report projects that are supplied by SAS IT Resource Management are available on each client where SAS IT Resource Management is installed. They can be accessed by navigating to the location where you installed SAS IT Resource Management. The projects are located at `SASITResourceManagementSASEnterpriseGuideComponents\3.4`. For example, if you installed SAS IT Resource Management on a 64-bit machine, the projects might be located at `C:\Program Files\SASHome\SASITResourceManagementSASEnterpriseGuideComponents\3.4`.

Only copies of those projects that are supplied by SAS IT Resource Management should be edited. Copy the projects to a location on your client and then work with those projects by navigating to them in the Server List window. Then, double-click the project to open it.
Note: If the Server List window is not displayed on your desktop, click View on the SAS Enterprise Guide menu bar. From the drop-down list, select Server List.


Locating SAS Enterprise Guide Documentation

From the menu bar of SAS Enterprise Guide, you can click Help to access the Help and a getting started tutorial. You can also access the following resources by selecting Help SAS on the Web:

• the home page for SAS Enterprise Guide
• the product documentation page for SAS Enterprise Guide
• SAS online resources for statistics education
• SAS Technical Support resources
• the form for submitting feedback about any SAS product
• hotfixes for SAS Enterprise Guide
• the SAS home page

These web pages open in your default web browser.

For information about administrative tasks that are associated with SAS Enterprise Guide, use the A-Z index at http://support.sas.com/documentation/index.html to locate the documentation that is available for this product.
Chapter 13
Using SAS Web Report Studio Interactively

Overview of SAS Web Report Studio

About SAS Web Report Studio

Log On to SAS Web Report Studio as a Registered User

Access SAS IT Resource Management Information Maps to Generate a Report in SAS Web Report Studio

E-mailing SAS IT Resource Management Reports

Locating SAS Web Report Studio Documentation

Overview of SAS Web Report Studio

About SAS Web Report Studio

SAS Web Report Studio is a web-based query and reporting application that is provided by the business intelligence components of the SAS Intelligence Platform. It is designed for users who want to generate reports, view them, and share them with others on the web. The application provides several ways to create reports by using a wizard and templates. It can also execute stored processes.

SAS Web Report Studio uses as its reporting data source information maps that translate technical data structures into user-friendly business terminology. Specific to SAS IT Resource Management, information maps are supplied for most aggregated tables and can be created for any other tables available in the IT data mart. Information maps can be created through the SAS IT Resource Management Information Map transformation that is available from the SAS IT Resource Management client or directly through SAS Information Map Studio.

Log On to SAS Web Report Studio as a Registered User

To log on to SAS Web Report Studio, perform the following steps:

1. To display the SAS Web Report Studio logon window, click on the URL that is supplied by your system administrator or paste it into the address field of your browser. For example, you might enter http://server01.abc.com:8080/SASWebReportStudio. The following window appears.
2. In the **User name** field, enter your user ID.
   In the **Password** field, enter the password for the user ID that you just entered.

   **Note:** Your password is case-sensitive. Your user ID might be case-sensitive, depending on the operating system that is used to host the web application server. If you need assistance, contact your system administrator.

3. Click **Log On**.

   The following display shows the SAS Web Report Studio window that appears after you log on.
The following actions, which correspond to the numbers on the preceding display, can be invoked from this window:

1. Click **Log Off** to exit SAS Web Report Studio. When you select log off, you are logged off all environments, including the SAS OLAP server and other web environments.

2. Click **Preferences** to personalize your use of SAS Web Report Studio.

3. Select the **Help** menu to get help on using SAS Web Report Studio.

4. Click **New report** to create a new report using the **Edit** tab.

5. Click **New using Report Wizard** to access the Report Wizard. The wizard guides you in defining a query; selecting a table and graph for the layout; and adding optional features such as group breaks, a header, and a footer.

6. Click **New using Template** to access the Select a Template dialog box. When you select a template, you start creating your report with a predefined layout.

7. Click **More Reports** to access the Open dialog box. The **Open** dialog box enables you to search for reports, and it lists reports, stored processes, folders, and information maps.

8. Click **Open** to access the **Open** dialog box. The **Open** dialog box enables you to search for reports, and it lists reports, stored processes, and folders.

9. Click **New** to create a new report using the **Edit** tab.

10. Select the **File** menu to access task options, such as **Open and Manage Files**.

*Note:* For more information about these actions, see the *SAS Web Report Studio: User’s Guide*.

---

**Access SAS IT Resource Management Information Maps to Generate a Report in SAS Web Report Studio**

To create a report by using SAS Web Report Studio with an information map as the data source, perform the following steps:

1. From the menu bar of the Welcome window of SAS Web Report Studio, select **File → Open**. Alternatively, you can click **Open** on the Welcome window.

   The Open dialog box is displayed.
2. You can search in **Shared Data/SAS IT Resource Management/IT Data Marts** for the information map that you want to use as the data source. To navigate through these folders, select the folder and click **Open**. Alternatively, you can double-click the folder to display its contents.

3. Double-click the information map in the Open dialog box. The new report opens in View mode.

   **Note:** When the information map is run, it accesses the corresponding data items that are in the tables of aggregation data that are the input to the job that generated the information map.

---

**E-mailing SAS IT Resource Management Reports**

Reports can be shared with others or kept in private folders based on security settings. Certain pages of reports can be distributed to authorized users via e-mail. For information about how to e-mail reports, see Chapter 25, “Sharing Reports” in the *SAS Web Report Studio: User’s Guide*. 
There are two ways to access Help from within SAS Web Report Studio:

- Select **Help ➔ Contents** or **Help ➔ Using this Window**.
  
  Note: The **Contents** tab enables you to access the *SAS Web Report Studio: User's Guide*.

- Click **Help**, which is available from any SAS Web Report Studio dialog box or wizard page.

For information about administrative tasks that are associated with SAS Web Report Studio, use the A-Z index at [http://support.sas.com/documentation/index.html](http://support.sas.com/documentation/index.html) to locate the documentation that is available for this product.
SAS Add-In for Microsoft Office and SAS IT Resource Management Data

About SAS Add-In for Microsoft Office
How to Access SAS Add-In for Microsoft Office
Using SAS Add-In for Microsoft Office to Access SAS IT Resource Management Data
Use SAS Tools to Analyze Your Data in Microsoft Excel
Create Stored Processes
Execute a Stored Process from SAS Add-In for Microsoft Office
Publish Results to a Central Location
Locating SAS Add-In for Microsoft Office Documentation

Chapter 14
Using SAS Add-In for Microsoft Office Interactively

About SAS Add-In for Microsoft Office
The SAS Add-In for Microsoft Office extends the functionality of Microsoft Excel, Microsoft Word, and Microsoft PowerPoint by enabling you to access SAS analytics and SAS reporting functionality without any SAS programming experience.

The SAS add-in includes approximately 80 SAS tasks that enable you to perform a variety of analyses. Examples of analyses that you can perform include linear and nonlinear regressions, multivariate analyses, time series analyses, one-way frequencies, and summary statistics. The SAS add-in enables you to refresh these analyses so that your results include the most up-to-date information. You can also easily share the results with others at your site.

How to Access SAS Add-In for Microsoft Office
As the SAS IT Resource Management client is installed, the SAS add-in is installed on your computer. As such, a SAS tab is automatically integrated into the Ribbon in Microsoft Excel, Word, and PowerPoint 2010. The SAS tab enables you to access SAS analytics and reporting functionality directly from these Microsoft Office programs without having to open a separate SAS interface.

When you select the SAS tab from the Microsoft Excel menu bar, the Ribbon menu bar with SAS options and functionality is displayed:
As shown in the following two displays, similar functions and options are available when the SAS tab is selected from the menu bars of Microsoft Word and Microsoft PowerPoint.

![Display 14.1: SAS Tab Functionality in the Microsoft Excel Ribbon](image1)

![Display 14.2: SAS Tab Functionality in the Microsoft Word Ribbon](image2)

![Display 14.3: SAS Tab Functionality in the Microsoft PowerPoint Ribbon](image3)

**Note:** The instructions and screenshots in this chapter are specific to Microsoft Office 2007-2010. If you are using Microsoft Office 2000-2003, you can perform the tasks described in this chapter. However, the SAS options are located in the SAS menu rather than the SAS tab.


---

**Using SAS Add-In for Microsoft Office to Access SAS IT Resource Management Data**

**Use SAS Tools to Analyze Your Data in Microsoft Excel**

When you open Microsoft Excel 2010, you should see a SAS tab in the Ribbon. You access the SAS add-in from the menu options on this tab.

You can perform a variety of tasks using the SAS add-in. The following process briefly explains how you would run a SAS analysis:

1. Open Microsoft Excel.
2. Select the data source that you want to work with. In Excel, you can use data in an existing Excel worksheet or in a SAS data source. If you select a SAS data source, you can choose to filter and sort the data before the analysis.

   **Note:** If the SAS data source is open in an Excel worksheet, then the task uses the filter and sort criteria that you specified when opening the data source.

3. Select the analysis that you want to perform.
4. Select the options in the analysis that you want to use and then run the analysis.

5. Specify the location of the output. For example, in Excel, you can choose to include the results in the existing worksheet, in a new worksheet, or in a new workbook. The results automatically open in Excel in the location that you chose.

Note: The SAS add-in is also available in Microsoft Word and PowerPoint.

Create Stored Processes

SAS Add-In for Microsoft Office enables users to run stored processes and customize the appearance of results that are returned by Microsoft Word or Microsoft Excel. A stored process is a SAS program that is hosted on a server and described by metadata. Stored processes can be written by anyone who is familiar with the SAS programming language or with the aid of a SAS code generator such as SAS Enterprise Guide. The basic steps to creating a stored process are as follows:

- Write the stored process.
- Choose or define a server.
- Register the metadata.

For information about how to perform these steps to create a stored process, see the SAS 9.4 Stored Processes: Developer’s Guide, which can be found at http://support.sas.com/documentation/index.html. Use the A-Z index to locate this documentation.

Execute a Stored Process from SAS Add-In for Microsoft Office

To run a stored process from SAS Add-In for Microsoft Office, perform the following steps:

1. If you are using Microsoft Office 2007-2010, select the SAS tab in the Ribbon.
   If you are using Microsoft Office 2000-2003, select SAS ⇒ Reports.
   The Reports window appears.

2. Select the stored process that you want to run and click Open. If the stored process that you want to run is not available, you might want to refresh your list of stored processes.
   Note: You can also run the stored process by right-clicking the stored process and selecting Open from the pop-up menu.

3. Specify information for any prompts that appear. These prompts for user-supplied values are defined when the stored process is created.

After you have specified values for any required parameters, the results of the stored process open in the worksheet, document, or presentation.

Note: If the stored process produces streaming results and your image format is not set to ActiveX, then any graphs that the stored process generates cannot be displayed. For more information, see the Help for SAS Add-in for Microsoft Office.
Publish Results to a Central Location

By publishing a document, you can share it with others without having to e-mail it. If you publish the document to a metadata repository, then you can perform an impact analysis on the document. Impact analysis enables you to see where a data source came from and the items that are dependent on this source. This analysis enables you to know how changing a data source might affect other documents.

Note: To publish a document, the SAS support personnel at your site must have installed SAS Web Report Studio on the same metadata server.

Locating SAS Add-In for Microsoft Office Documentation

From the SAS Ribbon bar of Microsoft Word, Excel, or PowerPoint, you can click Help to access the SAS Help for the products that are included in SAS Add-In for Microsoft Office. In addition, SAS Add-In 6.1 for Microsoft Office: Getting Started in Microsoft Excel, Microsoft Word, and Microsoft PowerPoint can be found at http://support.sas.com/documentation/index.html.

Use the A-Z index to locate the documentation that is available for this product.
Overview of SAS Information Delivery Portal

About SAS Information Delivery Portal

The SAS Information Delivery Portal (or simply, the portal) is a web application that provides a single, easy-to-use interface from which you can access a broad range of enterprise information. This information includes reports, charts, web applications, documents, and links to internal or external web pages. The portal gives you access to information that is produced through the analytical capabilities of SAS, and provides a single access point to SAS output.

Your organization can use the portal to deliver important and timely business intelligence efficiently to employees, customers, partners, and vendors. The portal provides a secure environment for your business intelligence so that users see only the information that they have security rights to access.

The portal's personalization features enable you to create and customize your own web pages and content. You can organize your personal portal so that it contains only the information that you need, in the format that makes the most sense to you. From the portal, you can subscribe to publication channels that deliver continually updated information to your desktop. The portal also provides a secure environment for sharing information with other users.

How to Access SAS Information Delivery Portal

To open the SAS Information Delivery Portal, open your web browser and point it to the portal's URL. To obtain the URL, contact your administrator.

To identify yourself to the portal, you must log on with your user name and password. (If you do not have a user name and password, contact your administrator to obtain them.)
After you log on, you can do the following tasks:

- Personalize your view of the portal by adding pages, portlets, and content items and modifying or rearranging them to meet your unique needs. Each time you log on, your own personalized view of the portal is displayed.
- Search for and view protected content that your user name and password authorize you to access.
- Launch other applications that might be available from the portal, without the need to re-enter your user name and password.

The logon procedure varies depending on how your organization has installed the portal. Use either the portal logon procedure or the web server logon procedure, as appropriate.

- If your organization uses the portal’s logon feature, open your browser and point to the portal's URL. When the portal's logon page appears, enter your User Name and Password. Then click Log On to open your personal portal.
- Organizations that use the web server logon, have different logon procedures. After you have logged on to the web server, open your personal portlet by pointing your browser to the portal's URL.

Note: The portal supports only one user session per browser instance. Different portal users can have different sessions in separate browser instances, but not in separate tabs in the same browser instance.

**How to Log Off from the Portal**

When you are finished using the portal, you should log off in order to close your portal session. Logging off releases the system resources that you were using. (Your portal session continues to use system resources until the session expires, even if you closed the browser window.)

To log off, click Log Off in the banner. Then close the browser window.

**How to Content Is Organized in the Portal**

The following figure is an example of a portal.

Note: Your organization might customize the portal so that it looks different from the example shown here.
The navigation bar contains links for your portal web pages. You open a different page by clicking its name in the navigation bar. In the display, the portal's Home page is the active web page. Notice that the Home link is highlighted on the navigation bar.

Portlets are the rectangular display components of a portal page that contain links, graphs, reports, and other information that is available in the portal. You can edit the contents of some portlets. To edit, remove, or minimize a portlet, use the icons in the portlet title bar.

The banner provides links that enable you to customize your portal and personalize your portal by means of the Options button. The banner also provides search, log off, demonstration, and help features.

The portal links enable you to view information or launch applications that are available to you through the portal by clicking any active link that is displayed inside a portlet.

For information about the type of content that the portal can contain and how to add, view, and manage the portal's content, see the documentation that is available for SAS Information Delivery Portal.
Locating SAS Information Delivery Portal Documentation

To access Help from within SAS Information Delivery Portal, click Help in the banner.

For more information about SAS Information Delivery Portal, use the A-Z index at http://support.sas.com/documentation/index.html to locate the documentation that is available for this product.
**Chapter 16**

Using SAS BI Dashboard

---

**Overview of SAS BI Dashboard**

**About SAS BI Dashboard**

Dashboards provide a way to view data. Users can quickly view critical information in a compact, easy to interpret interface. Dashboards can display key performance indicators in one place to help users monitor information throughout an enterprise. By using the new dashboard designer and dashboard viewer, you can create a single dashboard that contains multiple indicators instead of creating a portal page with multiple dashboard portlets. Coordinating the look and feel of your dashboard and indicators is easier than ever.

A dashboard is a container that is nested within a portlet and that contains one or more indicators. An indicator is a composite of one or more related objects. Each indicator has a data source, one or more gauges, hyperlinks to additional information, and range settings for the gauges. Dashboards display critical information in such a way that the information can be interpreted and monitored at a glance. Dashboards can also contain links to other pertinent information, important summary and highlights, and personalized information such as weather, news, and stock news. Here is an example dashboard that contains three dashboards that use different data sources:
The SAS BI Dashboard enables users to use dashboards to monitor key performance indicators that convey how well an organization is performing. As shown in the preceding display, dashboards include graphics, text, colors, and hyperlinks. The preceding dashboard shows multiple indicators and each indicator has its own data model underneath. These indicators are driven by six different SQL queries, but the data models could be all information maps, all scorecards, or some combination of these types. This dashboard displays gauges, graphs, bar charts, line plots, and a map.

Dashboards are created, maintained, and viewed through an easy-to-use web-based interface. All content is displayed in a role-based, secure, customizable, and extensible environment. Information consumers and performance analysts can customize how information appears on their personal dashboards.

SAS BI Dashboard enables users to create their own dashboards from a variety of data sources, including information maps and SAS data sets. Users can link dashboards to SAS business intelligence objects or to external URLs, and users can customize the visualization of the data in a number of ways. For more information about the SAS BI Dashboard, see the SAS BI Dashboard: User’s Guide.

Log On to SAS BI Dashboard

The SAS BI Dashboard is accessed from within the SAS Information Delivery Portal. The current logon information from the portal is provided to the SAS BI Dashboard. Therefore, the SAS BI Dashboard appears immediately, without the need to log on. For more information, see the Help for SAS Information Delivery Portal.

To access SAS BI Dashboard, open the SAS Information Delivery Portal and log on. To do so, perform the following steps:
1. Open your web browser and point it to the portal's URL. To obtain the URL, contact your portal administrator.

2. To identify yourself to the portal, log on with your user name and password. If you do not have a user name and password, contact your system administrator to obtain them.

   The logon procedure varies depending on how your organization has installed the portal. Use either the portal logon procedure or the web server logon procedure, as appropriate.

3. If your organization uses the portal's logon feature, do the following:
   a. Open your browser and point to the portal's URL.
      
      Note: To obtain the web address, contact your portal administrator.
   b. On the logon page, enter your user name and password.
   c. Click Log On. Your personal portal opens. Typically, most portal users see a page that contains a collection portlet (My Collection) and a bookmark portlet (Bookmarks).

---

**Locating SAS BI Dashboard Documentation**

Online Help for the SAS BI Dashboard is available from within the product. For more information, see the *SAS BI Dashboard: User’s Guide*, which is available at [http://support.sas.com/documentation/index.html](http://support.sas.com/documentation/index.html). Use the A-Z index to locate the documentation for this product.
Chapter 17
Working with SAS Visual Analytics

SAS Visual Analytics customers can use SAS Visual Analytics to visually explore SAS IT Resource Management data. Customers can design and create reports. They can also view and interact with those reports on the web or on a mobile device such as a tablet. SAS Visual Analytics provides access to the SAS LASR Analytic Server, which is an in-memory engine specifically designed for analytic processing in a scalable manner.

Part 5

Appendixes

Appendix 1

Naming Standards for Reporting Objects ........................................ 155

Appendix 2

Reporting Standards for SAS IT Resource Management Reports . 161

Appendix 3

Troubleshooting and Debugging Tips ............................................. 169

Appendix 4

Best Practices ............................................................... 189

Appendix 5

Setting Up Web Links in Tile Charts ........................................... 199

Appendix 6

Report Conversion Guide ....................................................... 205
Appendix 1

Naming Standards for Reporting Objects

About Naming Standards for SAS IT Resource Management Reporting Objects

SAS IT Resource Management uses specific naming conventions and locations when naming and saving the various reporting components that it supplies and creates. These conventions simplify the management and maintenance of the objects that are interrelated for IT reporting in SAS Enterprise Guide, the SAS IT Resource Management client, and the ITRM Report Center.

For consistency and efficiency, if you choose to create or edit SAS Enterprise Guide projects, report definitions, Performance Report transformations, or any other reporting component for your IT resource data, then use the same naming and storage conventions that SAS IT Resource Management uses.

Naming Standards and Location of Objects

Information Maps

The following table describes the standard naming conventions and storage locations that SAS IT Resource Management uses when creating and saving the various objects that are associated with information maps.
<table>
<thead>
<tr>
<th>Object</th>
<th>Naming Convention</th>
<th>Location</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>information map</td>
<td>An information map has the same name as its corresponding source table. (Example: MonthShiftDisk)</td>
<td>In the IT Data Marts tree: <code>&lt;IT data mart name&gt; &lt;adapter type&gt;&lt;number&gt; &lt;Domain Categories &lt;domain category&gt;</code></td>
<td></td>
</tr>
<tr>
<td>information map</td>
<td>Includes descriptive words that show the performance area first, then a descriptor, the type of metric, and a statistic. (Examples: MemoryUsagePctW Mean, PagesFreedRateMax)</td>
<td>In the Information Map transformation that is part of the information map job. Information map filters are available on the Information Map Parameters tab of the Information Map transformation properties.</td>
<td>Mixed case with no spaces.</td>
</tr>
<tr>
<td>Object</td>
<td>Naming Convention</td>
<td>Location</td>
<td>Notes</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------</td>
<td>----------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| information map filter (statistic type) | Includes descriptive words and components that are based on the following guidelines:  
- The first two characters (if the filter is based on a rank column from a joined table) show which level the column comes from. For example, D_ for Day level table, W_ for Week level table, M_ for Month level table, or nothing when it is not from a joined table.  
- The text string Top or Bot corresponds to ascending or descending order.  
- The data item name on which the column is based, when appropriate, is included.  
- The text string DescRank or AscRank is included to show the rank order when appropriate.  
(Examples: BotMemoryAvailable MB, TopCpuBusyPct) | In the Information Map transformation that is part of the information map job. Information map filters are available on the Information Map Parameters tab of the Information Map transformation properties. | Mixed case with no spaces. |

<p>| information map job | &lt;domain category&gt; Information Map (Example: Disk Information Map) | In the IT Data Marts tree: &lt;IT data mart name&gt; &lt;adapter type&gt;&lt;number&gt; Domain Categories ⇝ &lt;domain category&gt;. |</p>
<table>
<thead>
<tr>
<th>Object</th>
<th>Naming Convention</th>
<th>Location</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information Map transformation</td>
<td>&lt;time period&gt;&lt;measurement category&gt;</td>
<td>An active Information Map transformation is in the information map job. A template to create your own Information Map transformation is in the Transformations tree in SAS IT Resource Management.</td>
<td>• The same name as the aggregation table that it uses.</td>
</tr>
<tr>
<td></td>
<td>(Example: MonthShiftDisk)</td>
<td></td>
<td>• Cannot contain double quotation marks.</td>
</tr>
</tbody>
</table>

**Supplied SAS Enterprise Guide Projects**

The following table describes the standard naming conventions and storage locations that SAS IT Resource Management uses to name and save the various objects that are associated with the supplied SAS Enterprise Guide projects.

<table>
<thead>
<tr>
<th>Object</th>
<th>Naming Convention</th>
<th>Location</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(Example: DTPerfSentryServerSystem.egp)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>process flow</td>
<td>&lt;TimePeriod&gt;Job&lt;DataSourceName&gt;</td>
<td>An active Performance Report transformation is in the reporting job. A template to create your own Performance Report transformation is in the Transformations tree in SAS IT Resource Management.</td>
<td>Transformation names cannot contain double quotation marks.</td>
</tr>
<tr>
<td></td>
<td>(Example: DayJobDetailSystem)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ITRM Report Definition task</td>
<td>&lt;Resource&gt;&lt;FilterDescription&gt;&lt;GraphType&gt;&lt;TimePeriod&gt;</td>
<td>The last object in a branch of a process flow in a SAS Enterprise Guide project.</td>
<td>The ITRM Report Definition task name is the same as the report definition that it creates.</td>
</tr>
<tr>
<td></td>
<td>(Example: SystemCpuHighUsagePlotForTheDay)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Performance Report Transformations and Report Jobs**

The following table describes the standard naming conventions and storage locations that SAS IT Resource Management uses to name and save Performance Report transformation, report jobs, and their reporting components.

<table>
<thead>
<tr>
<th>Object</th>
<th>Naming Convention</th>
<th>Location</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>reporting job</td>
<td><code>&lt;domain category&gt; &lt;time period&gt; Reporting</code> (Example: Disk Monthly Reporting)</td>
<td>In the IT Data Marts tree: <code>&lt;IT data mart name&gt; &lt;adapter type&gt; &lt;number&gt; &lt;Domain Categories &lt;domain category&gt;</code></td>
<td></td>
</tr>
</tbody>
</table>
## Appendix 2
### Reporting Standards for SAS IT Resource Management Reports

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Reporting Standards for SAS IT Resource Management Reports</td>
<td>161</td>
</tr>
<tr>
<td>Standards for SAS IT Resource Management Report Elements</td>
<td></td>
</tr>
<tr>
<td>Titles</td>
<td>162</td>
</tr>
<tr>
<td>Footnotes</td>
<td>163</td>
</tr>
<tr>
<td>Axis</td>
<td>164</td>
</tr>
<tr>
<td>Colors</td>
<td>164</td>
</tr>
<tr>
<td>Group BY</td>
<td>165</td>
</tr>
<tr>
<td>Reference Lines</td>
<td>165</td>
</tr>
<tr>
<td>Fonts</td>
<td>165</td>
</tr>
<tr>
<td>Formats</td>
<td>165</td>
</tr>
<tr>
<td>Symbols</td>
<td>165</td>
</tr>
<tr>
<td>Standard Specifications for Report Tasks</td>
<td>166</td>
</tr>
<tr>
<td>Line Plots</td>
<td>166</td>
</tr>
<tr>
<td>2XY Plots</td>
<td>166</td>
</tr>
<tr>
<td>Needle Plots</td>
<td>166</td>
</tr>
<tr>
<td>Box Plots</td>
<td>167</td>
</tr>
<tr>
<td>Bar Lines</td>
<td>167</td>
</tr>
<tr>
<td>Bar Charts</td>
<td>167</td>
</tr>
<tr>
<td>List Data</td>
<td>167</td>
</tr>
</tbody>
</table>

### About Reporting Standards for SAS IT Resource Management Reports

SAS IT Resource Management uses several reporting standards to design and specify the properties for various types of report. These conventions provide a consistency in the look of SAS IT Resource Management reports while espousing best practices for rendering IT reports. The reports that SAS IT Resource Management supplies include the types of reporting standards:

- standards for report elements
- standard specifications for report tasks

For best results, if you choose to create or edit your own IT reports, then use the same reporting standards that SAS IT Resource Management uses for consistency and efficiency.
Standards for SAS IT Resource Management
Report Elements

Titles

Many reports have the following two titles:

• Title1 shows the report metrics.
• Title2 provides information about the level of data that is being reported.

Note: The BY line and the axis of the report also help the report viewer determine the level of data that is being reported.

The following figure provides an example of Title1 and Title2 in a SAS IT Resource Management report with a BY Line.

Figure A2.1  Titles and BY Line in a SAS IT Resource Management Report

The following table provides information about how Title2 standards map to the aggregation level for the report.

<table>
<thead>
<tr>
<th>Job</th>
<th>Title2 Sample</th>
<th>Aggregation Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day Job</td>
<td>Intervals for the Day</td>
<td>Detail</td>
</tr>
<tr>
<td></td>
<td>Hours for the Day</td>
<td>DayHour</td>
</tr>
<tr>
<td></td>
<td>Hours for last 3 Days</td>
<td>DayHour</td>
</tr>
<tr>
<td></td>
<td>Hours for last 7 Days</td>
<td>DayHour</td>
</tr>
<tr>
<td></td>
<td>Shifts for the Day</td>
<td>DayShift</td>
</tr>
<tr>
<td></td>
<td>For the Day</td>
<td>Day</td>
</tr>
<tr>
<td>Job</td>
<td>Title2 Sample</td>
<td>Aggregation Level</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Week Job</td>
<td>Daily Hours for the Week</td>
<td>DayHour</td>
</tr>
<tr>
<td></td>
<td>Daily Peak Hours for the Week</td>
<td>DayHour</td>
</tr>
<tr>
<td></td>
<td>Daily Shifts for the Week</td>
<td>DayShift</td>
</tr>
<tr>
<td></td>
<td>Days for the Week</td>
<td>Day</td>
</tr>
<tr>
<td></td>
<td>Days for last 4 Weeks</td>
<td>Day</td>
</tr>
<tr>
<td></td>
<td>Weekly Hours for last 4 Weeks</td>
<td>WeekHour</td>
</tr>
<tr>
<td></td>
<td>Weekly Hours for the Week</td>
<td>WeekHour</td>
</tr>
<tr>
<td></td>
<td>By Shift and Week</td>
<td>WeekShift</td>
</tr>
<tr>
<td></td>
<td>For the Week</td>
<td>Week</td>
</tr>
<tr>
<td></td>
<td>By Week</td>
<td>Week</td>
</tr>
<tr>
<td>Month Job</td>
<td>Daily Hours for the Month</td>
<td>DayHour</td>
</tr>
<tr>
<td></td>
<td>Daily Peak Hours for the Month</td>
<td>DayHour</td>
</tr>
<tr>
<td></td>
<td>Daily Shifts for the Month</td>
<td>DayShift</td>
</tr>
<tr>
<td></td>
<td>Days for the Month</td>
<td>Day</td>
</tr>
<tr>
<td></td>
<td>Days for last 2 Months</td>
<td>Day</td>
</tr>
<tr>
<td></td>
<td>Monthly Hours for the Month</td>
<td>MonthHour</td>
</tr>
<tr>
<td></td>
<td>Monthly Hours for last 3 Months</td>
<td>MonthHour</td>
</tr>
<tr>
<td></td>
<td>By Shift and Month</td>
<td>MonthShift</td>
</tr>
<tr>
<td></td>
<td>For the Month</td>
<td>Month</td>
</tr>
<tr>
<td></td>
<td>By Month</td>
<td>Month</td>
</tr>
</tbody>
</table>

**Footnotes**

Use a footnote to indicate that a filter was used to subset the report data. Here are some examples:

- Server with high CpuBusyPctWMean for the day
- Server with high CpuBusyPctWMean for the week
- Server with high CpuBusyPctWMean for the month
Appendix 2 • Reporting Standards for SAS IT Resource Management Reports

- Server with high CpuBusyPctWMean for one or more days
- Servers with highest CpuBusyPctWMean for the day
- Servers with highest CpuBusyPctWMean for one or more days

Use the following default as the second line of the footnote:

Generated on %TRIM(%QSYSFUNC(DATE(), NLDATE20.)) at %SYSFUNC(TIME(), NLTIMAP20.)

The following figure provides an example of a footnote in a SAS IT Resource Management report.

Display A2.1  Footnote in a SAS IT Resource Management Report

Server with high CpuBusyPctWMean for the week
Generated on May 22, 2012 at 01:52:56 PM

Axis

To imitate the axis standards for SAS IT Resource Management reports, implement the following specifications:

- Specify a generic axis label for reports that contain legends, when you are plotting multiple statistics, or when the default labels on the axis are ambiguous.
- Turn off minor tick marks.
- For reports with hour on the horizontal axis, use 0 to 23 by 1.
- For reports with hour on the vertical axis, use 0 to 24 by 2.
- For reports with time on the horizontal axis, use "00:00"t to "24:00"t by "02:00"t.
- For reports with percentages on the vertical axis, use 0 to 100 by 20.

Colors

A template named ITRMDefault is used for default colors in SAS IT Resource Management reports. However, most reports do not require that colors be specified explicitly in the report task.

Most of the colors that are defined in the ITRMDefault template were selected from the autumn color scheme and from a set of the SAS Enterprise Guide window default colors.

If you want to specify a color in a report task, the following colors (in SAS Enterprise Guide) complement the colors in the ITRMDefault template:

- blue gray
- dark yellow
- light orange
- teal
- pale blue
- lavender
Standards for SAS IT Resource Management Report Elements

- tan
- gold
- light yellow
- lime
- light green

Use black for needle plots that include a symbol for a standard deviation metric.

**Group BY**

Be consistent with the placement of BY variables in your reports. SAS IT Resource Management reports use the following order to place BY variables in reports:

1. date, if used
2. date-related ID columns such as DayOfDay
3. other classification columns

**Reference Lines**

To imitate the reference line standards for SAS IT Resource Management reports, implement the following specifications:

- Use reference lines when possible.
- When plotting two metrics on the left and right axis, use a reference line for the most important metric that is plotted on the left vertical axis.
- Use values 20, 40, 60, 80 and 100 when using a reference line for a percent metric.
- Do not specify values when using reference lines if you do not know the minimum and maximum values for the metric.
- Use the style **Dashed**.
- Use the color **Gray - 25%**.
- Include a footnote about the reference if needed.

**Fonts**

SAS IT Resource Management reports use the default fonts for SAS Enterprise Guide.

**Formats**

SAS IT Resource Management reports use the default formats that are inherited from their aggregation tables or information maps.

**Symbols**

To imitate the symbols standards for SAS IT Resource Management reports, implement the following specifications:

- Use the dot symbol with size 8.
- Use the triangle symbol when plotting a standard deviation statistic.
• Use symbols when they do not overcrowd the graph.

---

**Standard Specifications for Report Tasks**

**Line Plots**

To imitate the standards for SAS IT Resource Management line plots, implement the following specifications:

• Use line width of 3.

• Break the plot line at missing values.

• Use the symbol dot with size 8 when plotting a small number of points.

**2XY Plots**

To imitate the standards for SAS IT Resource Management 2XY plots, implement the following specifications:

• Use a standard line plot, not an overlay.

• Plot the most important variable on the left. If both variables are important, plot percent variables on the left.

• Specify a corresponding color in the task for the labels of axis variables, if appropriate.

**Needle Plots**

To imitate the standards for SAS IT Resource Management needle plots, implement the following specifications:

• Use needle plots when you want to plot two or three statistics of a single metric.

• Do not use needle plots if you expect a small number of points, such as in a current week report that can have as few as one point on the first day of the week.

Needle plots are used in the following two formats: One that shows two statistics and one that shows three:

• needle plots that show two statistics.

  For the reports that show two statistics, use the following guidelines:

  • Both statistics should be needle lines with a size of 12 to 16.
  
  • The size should be as large as possible without bleeding onto the axis line.
  
  • The variable with the larger number should always be first. The variable with the smaller number should be second. For example, **Maximum** is always larger than or equal to **Mean**, which is equal to or larger than **Minimum**.

• needle plots that show three statistics.

  For reports that show three statistics, use the following guidelines:

  • The two most important statistics should be needle lines with a size of 12 to 16.
• The size should be as large as possible without bleeding onto the axis line.
• The statistic with the larger number should be first. The smaller statistics should be second. The third statistic, such as the standard deviation, should have an interpolation of scatter. For example, **Maximum** is always larger than or equal to **Mean**, which is equal to or larger than **Minimum**.
• Use the dot symbol when plotting a standard deviation. The dot should be black and size 9 to 12. The dot symbol should be narrower than the needle width.

**Box Plots**

To imitate the standards for SAS IT Resource Management box plots, implement the following specifications:

• Use extreme high and low for the whisker length percentile.
• Specify the color in the task to be light orange.

**Bar Lines**

To imitate the standards for SAS IT Resource Management bar lines, implement the following specifications:

• Use bar lines when you want to plot two statistics of a single metric or of two different metrics, where the bar is the most important statistic or metric.
• Specify complementary colors in the task for the variable labels because a legend is not available.
• Chart the most important statistic or the percent statistic on the left hand side, if possible.
• Verify the statistic that is used in the advanced window.
• Use line width of 3.
• Use the symbol dot with a size of 8.

**Bar Charts**

To imitate the standards for SAS IT Resource Management bar charts, implement the following specifications:

• Chart one bar for each discrete variable.
• When the bar chart has a subgroup or is an interleave bar chart, you can add code to the task to include a legend. Use the insert code feature to add the code.

**List Data**

To imitate the standards for a SAS IT Resource Management data list, modify the labels to add spaces between capitalized words. This ensures that the header row of the HTML page can wrap and that the columns can resize as you enlarge and shrink the HTML page.
Appendix 3
Troubleshooting and Debugging Tips

How to Verify the SAS IT Resource Management Enterprise
Guide Installation and Configuration ........................................ 170
  Where Is SAS IT Resource Management Installed? ................. 170
  Verifying the Presence of the ITRM Style Sheet, ITRM Banner, and EG Options Components in Your SAS Enterprise Guide Installation .................................. 170
  Verifying the Correct Location of the ITRM Templates ............ 171

Why SAS Enterprise Guide Reports Do Not Display Correctly ........ 172
  Determining Why the Report’s Style Sheet, Banner, or Template Are Incorrect  172
  Determining Why Java Applet Graphs Do Not Display Correctly ...... 173
  Determining Why ActiveX Graphs Do Not Display Correctly ....... 177

Why Are Reports Missing from ITRM Report Center? ............... 179
  Are the ITRM Report Center Filters Defined Correctly? .......... 179
  Are the Reports Stored in the SAS Content Server? ............... 180
  Does the Cache Need to Be Refreshed? ............................. 181
  Did the Report Jobs Run Correctly? ................................ 182

Why Report Jobs Are Not Generating Reports ......................... 182
  Overview of Report Jobs Not Generating Reports ................. 182
  Possible Causes of Missing Data ................................... 182
  How to Determine Why Data Is Missing ............................ 183

Removing Duplicate Reports That Are Stored in the SAS Content Server .... 184

Error Message: Select a SAS Content Server .......................... 184

How to Debug a Middle-tier Connection Problem in a Report Job .......... 185

How to Access ITRM Report Center Reports in the SAS Content Server .... 186

How to Refresh the Cache for ITRM Report Center Reports .......... 187

How to Back Up Reports ................................................... 187

Technical Support .......................................................... 187
How to Verify the SAS IT Resource Management Enterprise Guide Installation and Configuration

Where Is SAS IT Resource Management Installed?

The SAS IT Resource Management installation loads several files into locations that are needed for reporting functions. The files that are discussed in the following topic are installed in multiple subfolders in these two locations for 64-bit installations:

- C:\Program Files\SASHome\SASITResourceManagementSASEnterpriseGuideComponents\3.4
- C:\Program Files\SASHome\SASITResourceManagementReportDefinitionTaskforEnterpriseGuide\3.4

The files are then copied to the locations that are listed as follows where they are used by the product.

Verifying the Presence of the ITRM Style Sheet, ITRM Banner, and EG Options Components in Your SAS Enterprise Guide Installation

The following values for EGRoot, UserProfile, and SASRoot pertain to the 64-bit version of SAS Enterprise Guide on Windows 7. They show the default paths that are used to locate the following objects that are needed for SAS Enterprise Guide:

- ITRM style sheet
- ITRM banner
- EG Options file
- dynamic link library (DLL)
- helpfiles
- EG projects

EGRoot = C:\Program Files\SASHome\SASEnterpriseGuide\6.1
UserProfile = C:\Users\<MyUserID>
SASRoot = C:\Program Files\SASHome

Note: Substitute the locations for EGRoot, UserProfile, and SASRoot based on your installation of SAS IT Resource Management for the values in the paths shown here for the ITRM style sheet, ITRM banner, and EG options components.

Default location for the ITRM Style Sheet

<EGRoot>\Styles\ITRMDefault.css

Note: For information about style sheets, see “About the Default Style Sheets for SAS IT Resource Management Reports” on page 94.

Default location for the ITRM Banner file

<EGRoot>\Styles\ITRMBanner.png

Note: For information about banners, see “About the Default Style Sheets for SAS IT Resource Management Reports” on page 94.
Default location of the EG Options file

\texttt{<EGRoot>\EGOptions.xml}

1. Open the \texttt{EGOptions.xml} file with a text editor and verify that it contains the string \texttt{ITRMDefault}.

2. If the string \texttt{ITRMDefault} is not found, open SAS Enterprise Guide. Select \texttt{Tools} \to \texttt{Options} and click \texttt{Reset All}. This action applies the options that are recommended by SAS IT Resource Management.

3. Find the version of \texttt{EGOptions.xml} that was created during the installation of SAS IT Resource Management. Then, install it into the location above.

\textit{Note:} For information about the location of these subfolders, see “Where Is SAS IT Resource Management Installed?” on page 170.

Default location for ITRM Report Definition Task and Help Files

\texttt{<EGRoot>\Custom\ITRMGallery.dll}

\texttt{<EGRoot>\Custom\itrm_Gallerytask.chm}

Default location for ITRM EG Projects

\texttt{<SASRoot>\SASITResourceManagementSASEnterpriseGuideComponents\3.4}

\textit{Note:} For information about these topics, see “Accessing SAS IT Resource Management Projects with SAS Enterprise Guide” on page 130.

\subsection*{Verifying the Correct Location of the ITRM Templates}

SAS IT Resource Management provides a default template file named \texttt{tmplitrm.sas7bim} that creates a default template named \texttt{ITRMDefault}. This default template includes updates to a parent template called \texttt{styles.analysis} that SAS provides. These updates include specifications for graph colors in charts and plots.

\textit{Note:} For information, see “About the Default Template for SAS IT Resource Management Reports” on page 93.

The following value for \texttt{SASServerRoot} pertains to SAS Enterprise Guide on Windows 7:

\texttt{SASServerRoot = C:\Program Files\SASHome\SASFoundation\9.4}

Verify that your installation of SAS IT Resource Management includes this component. The default location for this file is here: \texttt{<SASServerRoot>\itrmmvadata\sashelp\tmplitrm.sas7bim}.

\textit{Note:} Substitute the location of the templates based on your installation of SAS IT Resource Management for the value of \texttt{SASServerRoot}. 
Why SAS Enterprise Guide Reports Do Not Display Correctly

Determining Why the Report’s Style Sheet, Banner, or Template Are Incorrect

If your reports do not use the correct style or colors, you might not have the correct SAS Enterprise Guide ITRM files installed, or they might not be installed correctly. To determine whether this is the problem, perform the following steps:

Verify that you are using the correct version of the SAS Enterprise Guide options file.

1. From the menu bar of SAS Enterprise Guide, select Tools ➔ Options.
2. Select Tasks ➔ Custom Code.
3. Verify that the Insert custom SAS code box before task and query code is checked.
4. Click the Edit button that is associated with the Insert custom SAS code box before task and query code check box.

Display A3.1 Custom Code Dialog Box

/* insert custom code before task code here */
cds path cuser.templat (update) sashelp.tmplITRM (read) sashelp.tmplmt (read);
5. Verify that the following ODS path statement is present in the Edit window (as shown in the previous step):

```plaintext
ods path sasuser.templat (update) sashelp.tmplITRM (read)
   sashelp.tmplmst (read);
```

6. If you do not see the ODS path statement, you might not have the correct SAS Enterprise Guide options file installed, or it might not be installed correctly. If this is the case, verify that the ITRM style sheet, ITRM banner, and EG Options components for your SAS Enterprise Guide are installed correctly. To do so, see “Verifying the Presence of the ITRM Style Sheet, ITRM Banner, and EG Options Components in Your SAS Enterprise Guide Installation” on page 170.

**Verify that you are using the SAS IT Resource Management style sheet and banner.**

1. From the menu bar of SAS Enterprise Guide, select **Tools ➔ Style Manager**. The following window appears:

![Style Manager Window of SAS Enterprise Guide](display-a3.2 Style Manager Window of SAS Enterprise Guide)

2. In the Style Manager window, verify that the following conditions are satisfied:
   - In the Style List group box, **ITRMDefault** is selected as the default style sheet.
   - In the Preview pane, the ITRM banner is displayed.
3. If ITRMDefault does not appear in the list of available styles, see “Verifying the Presence of the ITRM Style Sheet, ITRM Banner, and EG Options Components in Your SAS Enterprise Guide Installation” on page 170.

**Determining Why Java Applet Graphs Do Not Display Correctly**

If your Java Applet graphs are not displaying correctly, the problem might be caused by an incorrect codebase, version of JRE, or graph format.
Verify that you are using the correct codebase.

1. From the menu bar of SAS Enterprise Guide, select **Tools ➜ Options**. Then click **Graph**.

2. Set the **Graph Format** to **Java** and make sure that the **URL for archive** field is set to **http://www2.sas.com/codebase/graph/v94**.

3. If you do not have access to the external web or if you encounter performance issues using the default path, then change the URL to point to your local middle tier, such as **http://Your_Middle_Tier:Port_Number/sasweb/graph**.

4. Make sure that the graph format is set back to your default format. Then click **OK** to save your settings.

Verify that the Java Console is enabled.

1. Navigate to the Java Control Panel that is available from the location where Java is installed.
Display A3.4 Java Control Panel

Java in the browser is enabled.  

See the Security tab

2. Select the Advanced tab to display the following screen:
3. Click **Show console**.
   
   *Note:* If you need more help locating this window, contact your system administrator.

4. Click **OK** to close the Java Console Panel.

**Generate the Java graph.**

To generate a Java graph, perform the following steps:

1. Perform one of the following actions:
   
   - In the Results > Graph window of your EG Options file, set **Graph Format** to **Java**. Click **OK** to save **Java** as the default graph format. Then, in the report task Properties window, check **Use preferences from Tools -> Options**.
   
   - In the report task Properties window, check **Customize result formats, styles, and behavior** and set the **Graph Format** to **ActiveX**.
Note: For best results, also check the HTML box and select the ITRMDefault style sheet.

2. Generate your Java graph.

3. If you are not able to view your Java graph, find the Java Console Panel. The panel displays the version of Java that you are using. Correct any errors or exceptions that are displayed.

Determine whether you are using the version of the Java Runtime Environment (JRE) that SAS recommends for your version of SAS. See the SAS Third-Party Software Reference at [http://support.sas.com/resources/thirdpartysupport/](http://support.sas.com/resources/thirdpartysupport/).

**Determining Why ActiveX Graphs Do Not Display Correctly**

If your ActiveX graphs are not displaying correctly, the problem might be caused by an incorrect codebase, version of ActiveX, or graph format.

**Verify that you are using the correct codebase.**

1. From the menu bar of SAS Enterprise Guide, select **Tools** ⇒ **Options**. Then click **Graph**.

2. Set the **Graph Format** to ActiveX and make sure that the **URL for the codebase** field is set to this path: [http://www2.sas.com/codebase/graph/sasgraph.exe#version=9,4](http://www2.sas.com/codebase/graph/sasgraph.exe#version=9,4).
3. If you do not have access to the external web or if you encounter performance issues using the default path, then change the URL to point to your local middle tier. For example, your middle tier location might be: \http://Your_Middle_Tier:Port_Number/sasweb/graph/sasgraph.exe#version=9,4.

4. Make sure that the Graph Format is set back to your default. Then click OK to save your settings.

**Generate the ActiveX graph.**

To generate an ActiveX graph, perform the following steps:

1. Perform one of the following actions:
   
   - In the Results > Graph window of your EG Options file, set Graph Format to **ActiveX**, as shown in the preceding display. Then in the report task Properties window, check Use preferences from Tools -> Options. Click OK to save **ActiveX** as the default graph format.
   
   - In the report task Properties window, check Use preferences from Tools -> Options, as shown in the following display:
Why Are Reports Missing from ITRM Report Center?

To determine why reports are missing from ITRM Report Center, consider the following potential resolutions.

**Are the ITRM Report Center Filters Defined Correctly?**

1. Log off from ITRM Report Center and then log on again.

2. In the **Gallery** workspace, invoke the new Gallery wizard to create a new gallery that shows at least one report that should have been generated by the report job.

   a. On page 2 of the wizard, select one domain category, one subcategory, one schedule frequency, and one keyword (if applicable) that matches one of the reports in your report job.

**Display A3.8  Use Preferences from Tools - Options**

![Display A3.8](image)

*Note:* For best results, also check the **HTML** box and select the **ITRMDefault** style sheet.

2. Generate your ActiveX graph.

   *Note:* If ActiveX Control is not installed on your machine, you are prompted to install it. Accept the prompt.

Additional information can be found here:

b. On page 3 of the wizard, note how many reports are found. If one or more reports are found, click Next. On step 4 of the wizard, note how many reports are found.

If no reports are found, go to the previous step and increase the number of occurrences to 999 and repeat. (For information about how to change the number of occurrences, see Step 3 of the “Create a Gallery” topic in SAS IT Resource Management 3.4: Report Center Guide.)

3. If the number of reports displayed in a gallery is less than the quantity expected, do the following steps:

a. Verify that the ITRM Report Center user who is viewing the gallery is a member of the groups that are authorized to access the SAS Content Server folder locations where the reports in that gallery are stored.

b. Review the SecondaryReportCount value that is set in the SAS Management Console. (That value controls the maximum number of reports that are displayed for a gallery.) For information, see “Change the Maximum Number of Reports to BeReturned from the Create Gallery Filters” on page 119.

If you are still not able to find any reports that should be generated from your report job, perform the following steps:

1. Try to determine whether ITRM Report Center can find any reports or whether the problem is limited to a subset of reports.

2. For more troubleshooting suggestions, see “Are the Reports Stored in the SAS Content Server?”

Are the Reports Stored in the SAS Content Server?

1. If you are a SAS Administrator, you can use the SCS Admin Console to traverse the SAS Content Server folder structure to search for at least one report that should be generated by the report job. (The SCS Admin Console is located at http://<YourMidTierName>:<Port Number>/SASContentServer/dircontents.jsp?path=/sasdav/<your-root-location>. Log on using any user ID that has Read access to the SAS Content Server.)

2. Traverse the folder structure until you reach the folder that contains the actual report.

Display A3.9 SCS Administration Console Contents

3. If the report is not in the SAS Content Server, check the report job log to make sure that the reports generated without errors. Investigate and eliminate the cause of the errors and rerun the report job. For more troubleshooting suggestions, see “Why Report Jobs Are Not Generating Reports” on page 182. You might have to rerun the report job with debugging turned on. Save the report job log and contact SAS Technical Support.

• For more information about how to turn debugging on for ITRM Report Center, see “How to Debug a Middle-tier Connection Problem in a Report Job” on page 185.
4. If the report is in the SAS Content Server, perform the following steps:
   a. Refresh the cache only under the specific root location where the report is stored. (Use the Open SCS Viewer Console to determine the location of the root folder.) For information about how to do this, see “How to Refresh the Cache for ITRM Report Center Reports” on page 187.
   b. Check whether there are errors in the ITRM Report Center log. (The log is located at <YourSASConfigFolder>\Level\Web\Logs\SASServer10_1\ITRMReportCenter3.4.log.) If there are errors in the ITRM Report Center log, save a copy of the log and contact SAS Technical Support. For information about how to do so, see “Technical Support” on page 187.

Does the Cache Need to Be Refreshed?

ITRM Report Center maintains an internal index, or cache, of the reports that are stored in the SAS Content Server. The reports that are associated with ITRM Report Center are only those that are generated by SAS IT Resource Management report jobs. When SAS IT Resource Management report jobs run successfully, the cache is updated correctly. However, in some cases, such as network connection failures, you might not be able to see new reports. Similarly, you might see a 404 error message that refers to reports that were deleted because the cache was not updated correctly.

Display A3.10  Example of an HTTP Status of 404

To force an update of the cache, see “How to Refresh the Cache for ITRM Report Center Reports” on page 187.
**Did the Report Jobs Run Correctly?**

Check the report job log to make sure that the reports were generated without errors. Investigate and eliminate the cause of the errors and rerun the report job. For more troubleshooting suggestions, see “Why Report Jobs Are Not Generating Reports”.

---

**Why Report Jobs Are Not Generating Reports**

**Overview of Report Jobs Not Generating Reports**

If your report jobs are not generating reports, the following conditions might need to be resolved:

- You might be experiencing a problem with your middle-tier connection. For information about how to correct this problem, see “How to Debug a Middle-tier Connection Problem in a Report Job” on page 185.
  
  *Note:* If your server and network are experiencing problems, make sure those problems are resolved before you rerun the report job.

- An information map might have been moved. To resolve this problem, make sure that the information maps that are used by the report job are accessible and referencing the correct data source.

  To locate the information map, review the report job log and find the report definition that is associated with the first error. Search backward in the log until you find the following text string:

    --- Report: ReportDefinitionNameHere

  Continue searching backward until you find the source code for the report definition. The source code of the report definition identifies the information map that is the data source for this report definition. The source code begins with the following comment:

    /*---- Report: ReportDefinitionNameHere ----*/

- Data that is required by the report is missing from the data source. To resolve this problem, see Possible Causes of Missing Data.

**Possible Causes of Missing Data**

Warnings or error messages in your SAS log can help determine why your report jobs fail to generate reports. Any one of the following three scenarios can produce a warning or an error message in the SAS log. To determine which of these scenarios is responsible for causing the problem, see “How to Determine Why Data Is Missing” on page 183.

- A report definition is using an information map with a filter that subsets data that occasionally results in an empty data set.

  Most of the report definitions that SAS IT Resource Management supplies use information map filters to subset the data for reporting. In some cases, the filters result in missing data and some SAS/GRAPH procedures generate warnings or errors that can be prevented only by rerunning the report when data is available.
For example, most report definitions that are designed to run on a weekly basis are
designed to run at the beginning of the week for the previous week. When the IT data
mart does not contain any data for the previous week, the report definition does not
produce any reports. The same is true for monthly reports. Most monthly reports are
designed to be run at the beginning of a month for the previous month. In these
cases, you should wait until the IT data mart contains the data for the designated time
period before scheduling the job.

- A report definition is using a filter that always results in missing data for a particular
  report.
  In this case, you might need to update or eliminate the filter to ensure that data is
  available for a specific report definition.
- A report definition reports on a specific metric that is not collected at a particular
  site.
  In this case, you should modify the report to use a metric that is available or
  eliminate the report definition from the report job.

### How to Determine Why Data Is Missing

Warnings or error messages that are written to your SAS log can help you resolve why
data is missing. To locate the problem, perform the following steps:

1. Review the report job log and find the report definition that is associated with the
   first error. Search backward in the log until you find the following text string:

   ```
   --- Report: ReportDefinitionNameHere
   ```

2. If you find data in the aggregation table for the data items that are used by the report
   definition, you need to determine whether an information map filter is responsible
   for the absence of data. To do so, perform the following actions:
   
   a. Find the supplied project, process flow, and ITRM Report Definition task that
      was used to create the report definition.
      
      You can find this information in the SAS log. Continue searching backward until
      you find the source code for the report definition. The source code begins with
      the following comment:
      ```
      /*---- Report: ReportDefinitionNameHere ----*/
      ```
   
   b. Using a copy of the supplied project, connect to your data source.
      
      Note: You might need to use the migration wizard if the project was not
      previously used to connect to the data source.
      
      For information about this wizard, see “Migrating SAS Enterprise Guide Projects
to Work with SAS IT Resource Management 3.4” on page 52.
   
   c. In SAS Enterprise Guide, run the branch that includes the report definition that
      caused the warning or error.
      
      If you see the same warning or error, then open the data source that is used in the
      report task that caused the warning or error.
   
   d. If the data source is empty, you need to determine whether a filter is responsible
      for the missing data. To do so, modify the information map, remove all filters,
      and rerun the information map and the report task. Check the resulting output to
      see whether the data is now present in the data set.
e. If eliminating the filter solves the problem, then you need to determine which of the following courses of action you want to take:
   • eliminate one or more of the filters
   • modify the expression of the filter
   • process additional dates of data
f. If eliminating the filter still produces no data, then determine whether the measure is not being processed and make necessary adjustments to the report definition. For example, use another measure or eliminate the report definition from the report job.
g. Make any required changes. Then, create a user-defined report definition, update the report job to use the new report definition, and redeploy the report job.

Removing Duplicate Reports That Are Stored in the SAS Content Server

If you rerun a report job multiple times in a day without processing additional days of data in between, then the report job generates multiple instances of the same reports in the SAS Content Server. These reports remain in the SAS Content Server until they expire and the corresponding report job is rerun.

To eliminate duplicate reports from the SAS Content Server, you can perform one of the following tasks:

• Allow the duplicate reports to expire as you continue to run the report job that added them.
• Remove the reports manually by using the SCS Admin Console. (Only a SAS administrator can perform this action.) For more information, see the chapter about administering the SAS Content Server in the SAS 9.4 Intelligence Platform: Middle Tier Administration Guide.

Note: Update the cache after deleting reports from the SAS Content Server. For more information about how to do this, see “How to Refresh the Cache for ITRM Report Center Reports” on page 187.

• Override the expiration date by using the Performance Report transformation and rerunning the job. Use caution when implementing this option. Depending on your settings, this implementation can delete duplicates as well as all previous versions of the report that were created by the report job.

Error Message: Select a SAS Content Server

When a report job runs, it creates reports and stores reports in the SAS Content Server. If a copy of a report job is made, and an attempt is made to open the copy of the report job, the following error message is displayed: Select a SAS content server.

Note: The error can also occur for a report job of a data mart that is imported.

The message is issued because the association to a valid SAS Content Server is lost. To correct this situation, perform the following steps:
1. Double-click the new job to open it in the **Diagram** tab of the Job Editor.
2. Right-click the Performance Report transformation in the process flow and select the **Server** tab.
3. Specify the name and location of the SAS Content Server for the Performance Report transformation.
4. Click **OK** and save the job.

---

**How to Debug a Middle-tier Connection Problem in a Report Job**

**CAUTION:**

The command to restart services should be issued only by a SAS IT Resource Management administrator. Everyone using ITRM Report Center is affected by this action.

If your report job shows an error that appears to be related to a middle-tier connection problem, verify that the SAS Content Server is available. To do so, Connect to the SCS Admin Console at `http://<YourMiddle-TierName>:<port number>/SASContentServer/dircontents.jsp?path=/sasdav`. If you are not able to connect to the SAS Content Server Administrative Console, check the SAS Content Server log. If necessary, restart the managed servers that are associated with your mid-tier on the web application server.

**Note:** The names of these servers depend on the setup of the middle tier. They are typically named SASServer1, SASServer2, SASServer10, and so on.

If you had to restart any services, then rerun the report job. If you continue to see the same middle-tier connection errors after restarting the middle-tier connection services, then follow the steps below to continue debugging the middle tier using a small, temporary report job.

**TIP** To simplify debugging, perform these steps using a small, temporary report job.

Then run the jobs, save the logs, and contact SAS Technical Support. For information about how to do so, see “Technical Support” on page 187.

If after restarting any services, you encounter a different type of error, then see “Why Report Jobs Are Not Generating Reports” on page 182.

1. In the SAS IT Resource Management client, open your IT data mart. Then navigate to the folder that contains the report job that caused the error.
2. Create a new report job in the same folder. Add any report definition from the original job.
3. Click the **Code** tab in the Job Editor. Click **Code generation mode** and select **User written body**.
4. Search through the SAS log for the following text:

```sas
/* setup */
%global ITRMErr;
%global ITRMDebug;
```

Add the following debugging statements after the previous `%global ITRMDebug;` code.

```sas
/* Add debugging statement */
%let ITRMDebug=1;
/
```

Then, run the report job. Save the log.

5. Make a copy of the ITRM Report Center log and the SAS Content Server log that contain time stamps that correspond to the time at which you ran your report job.

6. Save the logs and contact SAS Technical Support. For information about how to do so, see “Technical Support” on page 187.

---

**How to Access ITRM Report Center Reports in the SAS Content Server**

To view individual reports directly that are stored on the SAS Content Server, access the ITRM Report Center Administration workspace and click the Open SCS Viewer Console button.
How to Refresh the Cache for ITRM Report Center Reports

ITRM Report Center maintains an internal index or cache of the SAS IT Resource Management reports that are stored in the SAS Content Server. Refreshing the cache might resolve issues with reports not appearing in ITRM Report Center. For example, if you remove reports manually from the SAS Content Server, you need to refresh the cache.

Note: Refreshing the cache might cause a temporary disruption to users who are logged on.

CAUTION: ITRM administrators are the only users who can refresh the cache. Refreshing the cache affects everyone using ITRM Report Center. Make sure that this command is invoked when users are not logged on to ITRM Report Center.

You can refresh the cache for ITRM Report Center reports in either of these two ways:

• Log on to ITRM Report Center as an administrator. In the Administration workspace, click Refresh Cache. (This action refreshes the cache for only one location.)

• Restart the ITRM Report Center service. (This action refreshes the cache for all locations.)

Note: For more information, see the chapter about administering the SAS Content Server in the SAS 9.4 Intelligence Platform: Middle-Tier Administration Guide.

How to Back Up Reports

To back up your SAS IT Resource Management reports, you must back up the SAS Content Server that stores the reports. For more information about backing up reports, see "How to Back Up SAS IT Resource Management" in the Best Practices Appendix of the SAS IT Resource Management 3.4: Administrator’s Guide.

Technical Support

• If you need assistance with the software, we ask that only the on-site SAS support personnel call SAS Technical Support. For U.S. and Canadian customers, support is provided from our corporate headquarters in Cary, North Carolina. You can call (919) 677-8008, Monday through Friday. Customers outside of the U.S. can obtain local-language technical support through the local office in their countries. Customers in these locations should contact their local office for specific support hours. See http://support.sas.com/techsup/contact/index.html for contact information for local offices.

• Before calling, you might want to explore the SAS Technical Support website at http://support.sas.com/techsup/. The SAS Technical Support website
offers a Knowledge Base, FAQs, Technical Support Documents and more that can answer your questions. This website also provides a mechanism for reporting problems.
Run Report Jobs at Night or during Low Usage Periods .......................... 189
Add a User-Defined Report Occurrence to ITRM Report Center ............ 190
Managing SAS Enterprise Guide Projects for SAS IT Resource Management . 192
  About SAS Enterprise Guide Projects for SAS IT Resource Management . . . 192
  Add, Update, or Delete Report Definitions ........................................ 193
Designing Reports for Batch Jobs ..................................................... 195
Create Tile Charts with Web Links ................................................... 195
Override Report Expiration Dates to Purge Reports from the
SAS Content Server ................................................................. 196
Back Up Your Data and Reports ..................................................... 196
Schedule Report Jobs Based on the Available Data ............................ 196
Override the Graph Type .............................................................. 197

Run Report Jobs at Night or during Low Usage Periods

The beginning and end of SAS IT Resource Management reporting code includes a flag
to inform ITRM Report Center that the report job has started and ended. If you run
multiple jobs during the day while you are also working with ITRM Report Center, the
report job runs might overlap. In that case, the subsequent ITRM Report Center cache
updates can be delayed as they overlap.

For best results, run multiple report jobs at night or when there is little activity on ITRM
Report Center. This ensures that there is little or no overlap of separate report jobs
running, which can delay the update of the cache.

Note: Run your report jobs only after the corresponding aggregation jobs are complete.
Add a User-Defined Report Occurrence to ITRM Report Center

To add a user-defined report occurrence such as `StartofQtr` or `StartOfYear` as filter options to ITRM Report Center, perform the following steps:

1. Open SAS Management Console with SAS administrator login credentials.
2. On the Plug-ins tab, expand Application Management ⇒ Configuration Manager ⇒ SAS Application Infrastructure.
   
   Note: The Configuration Manager is installed as part of the SAS Web Infrastructure Platform client. If you do not see this plug-in in SAS Management Console, then you can install it in the Software Deployment Wizard by selecting Install Additional Software and selecting the SAS Web Infrastructure Platform client.

   Adding the columns in SAS Management Console enables them to be available in ITRM Report Center. However, they are enabled only to select from if there are reports in SAS Content Server that contain these values. Therefore, you can add any label if you also use it in your reports.

3. Expand SAS Application Infrastructure.
4. Right-click ITRM Report Center 3.4 and select Properties.
5. On the Advanced tab, add the user-defined report occurrence to the `itrmrc.DateByVariables` parameter. As shown in the following example, you can add `StartOfQtr` and `StartOfYear` to the Property value field.

   Note: SAS IT Resource Management is installed with these BY variables in place on this tab: `Date`, `StartOfWeek`, and `StartOfMonth`. 


6. Restart the ITRM Report Center web application.

7. In the Create Gallery and Edit Gallery wizards, you can select these additional date-based periods to use as filters for the gallery that you are working with. Therefore, you can display the corresponding date-based BY variable in that gallery.

*Note:* To do so, you must have reports in the SAS Content Server that contains these Date By variables.
The reports that are available from ITRM Report Center and used for the purposes of performance management and capacity planning have their beginnings in SAS Enterprise Guide projects. These projects and their tasks produce reports that must be managed to ensure the integrity of the operational reporting environment for SAS IT Resource Management.

SAS makes the following recommendations as best practices for managing the SAS Enterprise Guide projects that SAS IT Resource Management provides at installation. These best practices assume that the SAS Enterprise Guide projects are maintained by several people referred to as “report developers” in this appendix.

The best practices described here provide suggestions for managing the following two sources of SAS Enterprise Guide projects:

supplied projects  
Supplied projects, also called supplied SAS Enterprise Guide projects, are delivered with the SAS IT Resource Management solution. These projects are installed on each client machine to which SAS Enterprise Guide is deployed during the installation of SAS IT Resource Management.
The projects can be accessed by navigating to the location where you installed SAS IT Resource Management. The projects are located at C:\Program Files \SASHome\SASITResourceManagementSASEnterpriseGuideComponents \3.4.

Supplied projects are assumed to be owned and managed by SAS. When updates to the SAS IT Resource Management solution are released, the entire contents of this folder might be overwritten to deliver product enhancements.

user projects

User projects are those SAS Enterprise Guide projects that are created by users of the SAS IT Resource Management solution and stored in a location other than that of the supplied projects.

The report definitions that are created by these SAS Enterprise Guide projects differ in the following ways:

- Supplied report definitions that are delivered with the SAS IT Resource Management solution are written to the SAS Metadata Server and are stored in folders such as Shared Data/SAS IT Resource Management/3.4 IT Report Definitions/<Adapter Name>/Supplied/<Time Period>.

- User report definitions that are generated from user projects should be written to a location other than that of the supplied report definitions. A suggested location is /Shared Data/SAS IT Resource Management/3.4 IT Report Definitions/<Adapter Name>/User Defined/<Time Period>.

Note: As SAS releases updates to supplied SAS Enterprise Guide projects and corresponding report definitions, you can run the jobs that the Adapter Setup and the Add Domain Category wizard generates. You can then view the report output in ITRM Report Center. Any updates that SAS delivers can be incorporated into your production reporting jobs by executing the best practices that are described in the following topic.

Add, Update, or Delete Report Definitions

The following steps enable you to add, update, or delete report definitions that SAS IT Resource Management uses:

- In SAS Enterprise Guide, you can use the ITRM Report Definition task to add or update report definitions. You can also delete an ITRM Report Definition task.

- In the SAS IT Resource Management client, you can add, update, or delete report definitions that are in your report jobs.

1. Locate the SAS Enterprise Guide projects that are used to produce reports from the operational SAS IT Resource Management System.

2. Make copies of the supplied SAS Enterprise Guide projects and establish a set of master SAS Enterprise Guide projects for your site. Store these master copies of the projects in a location that is accessible by all report developers.

3. Use the Migration Wizard for SAS Enterprise Guide to update the mapping to the information map or SAS table that serves as the source data for the report. For more information, see “Preparing to Work with SAS Enterprise Guide” on page 50.

4. Use any method of version control to manage a set of master SAS Enterprise Guide projects. All report developers can use the master copies to make their own copies of the projects and publish their results after they have implemented and promoted changes to the report definitions that they produce.
5. Report developers perform the following steps when working with a SAS Enterprise Guide project:
   a. Check out a copy of a master SAS Enterprise Guide project.
   b. In SAS Enterprise Guide, select File ⇒ New ⇒ Notes to create a version notes file of the project. If a notes file already exists, then open the existing file.
   c. Add the following entries to this notes file:
      • Project Updated By
      • Date of Changes
      • Tasks Modified

6. You can perform these actions:
   • use the ITRM Report Definition task to create new or update existing report definitions
   • delete an ITRM Report Definition task or a report
     
     Note: Deleting the ITRM Report Definition task does not delete the corresponding report definition.

After you implement your changes, validate them.

7. If you added or modified ITRM Report Definition tasks, publish the corresponding report definitions to the SAS Metadata Server. To do so, perform the following steps:

     Note: The suggested path for new report definitions is /Shared Data/SAS IT Resource Management/3.4 IT Report Definitions/<Adapter Name>/User Defined/<Time Period>.

   a. Right-click an ITRM Report Definition task and select Modify <ITRM Report Definition task name>.
   b. Click Next to navigate to page 2 of the ITRM Report Definition task wizard.
   c. Click Deploy. The new report definition is created and published to the SAS Metadata Server.

     Note: This step is not needed if you deleted an ITRM Report Definition task.

8. Save and close the SAS Enterprise Guide project.

     Note: If your site uses a method of version control to manage a set of master SAS Enterprise Guide projects, make sure that you check in the project.


     Use the IT Data Marts tree to navigate to the report job in the appropriate IT data mart, adapter, and domain category folders. This location should be where you want to perform one of the following actions:
     • select a new report definition in the report job
     • deselect a report definition in the report job

10. Open the report job.

     Right-click the Performance Report transformation and select Properties.

11. • If you are selecting a new report definition, select the Report Definitions tab and add the report definition as needed.
     • If you are deselecting a report definition, select the Report Definitions tab and delete the report definition as needed.
12. Select the Notes tab and add the following entries to the notes:
   - Transformation Updated By
   - Date of Changes
   - Report Definition Changes (such as Added: <report definition name>, Updated: <report definition name>, or Deleted: <report definition name>)

13. Save and close the Performance Report transformation.

---

**Designing Reports for Batch Jobs**

When you design reports and create a report definition that runs in a batch job, consider the following questions:

- Is the report definition intended to run in a daily, weekly, or monthly job?
- How long do you want to keep the generated report in the SAS Content Server?

Based on your answers to these questions, specify the appropriate values in the ITRM Report Definition task.

For example, if you design a report that should run daily and replace the previous version in the SAS Content Server, then specify the following values in the ITRM Report Definition task:

- On Page 1 of the ITRM Report Definition task, specify a path for the report definition that includes the subfolders User Defined and Day.
- On Page 2 of the ITRM Report Definition task, specify the following values:
  - Select Daily in the Job Schedule Frequency field.
  - Specify a value of 1 for the Expire Reports After field.

Specifying these values help you find daily report definitions when creating report jobs. These values in the report definition also help you find the desired reports when viewing them with ITRM Report Center.

---

**Create Tile Charts with Web Links**

The tile chart task in SAS Enterprise Guide supports web links. However, when you specify the URL for a web link, you must use a known location for the root URL.

For example, if your root URL is http://www.MySite/BaselineReports/, then the following URLs are valid web link URLs:

- http://www.MySite/BaselineReports/{&1}
- http://www.MySite/BaselineReports/{&2}
- http://www.MySite/BaselineReports/{&1}/{&2}
Override Report Expiration Dates to Purge Reports from the SAS Content Server

By default, report jobs generate reports and purge expired versions of the same reports. You can use the Performance Report transformation in report jobs to disregard report expiration dates and remove reports based on their generation date.

To override report expiration dates for all reports in a report job, perform the following steps:

1. Open the report job for the reports that you want to purge.
2. Open the appropriate Performance Report transformation.
3. On the Report Parameters tab, select Delete report content that is older than specified days: and specify the value as 1.
4. Save and close the report job.
5. Redeploy the report job.

The next time the report job runs, it generates a new version of the reports and remove all reports that are more than one day old.

Back Up Your Data and Reports

For more information about backing up your data and reports, see Appendix 10, “Best Practices and Troubleshooting Tips” in the SAS IT Resource Management: Administrator's Guide.

Schedule Report Jobs Based on the Available Data

Before you run report jobs, ensure that the available data in your IT data mart is sufficient and complete for the type of report job that you want to run. Here are some recommendations to ensure that you have an appropriate set of available data to run various report jobs:

- Ensure that the aggregation jobs that a report job depends on has executed and completed.
- Schedule weekly report jobs to run at the beginning of the week to generate reports for the previous week.
- Schedule monthly report jobs to run at the beginning of the month to generate reports for the previous month.
- Ensure that you have data in your data mart for the last week and the last month before you schedule weekly and monthly jobs.
Override the Graph Type

If you want to override the type of graphics device for your reporting jobs without redeploying your reporting jobs, use the SAS Graph DEVICE option. This is the syntax for the DEVICE system option:

```
DEVICE= device-driver-specification
```

This option specifies the device driver that is used by SAS/GRAPH to generate graphic output. For more information about the DEVICE option, see *SAS System Options: Reference*.

You can set the DEVICE option in two ways:

- as a global SAS option when you invoke the reporting job
- in the SAS configuration file

The graph device is determined from this list in the following order:

1. the graph type that is specified by the DEVICE system option and set as a global option or in the SAS configuration file
2. the graph type that is specified in the Graph format override field of the Report Parameters tab of a Performance Report transformation
3. the graph type that is specified in the Graph Format field that was set on the Options page of the ITRM Report Definition task.
4. ActiveX is the default graph type when using the ITRM Report Definition task to create your own report definitions. (Most supplied report definitions are set to ActiveX. However, JAVA and PNG are also used.)

*Note:* The supported graph devices are **JAVA**, **ACTIVEX**, and **PNG**. However, on MVS and UNIX, ActiveX is not supported, because the related **ACTIVEX** Image format is not available.
Appendix 5

Setting Up Web Links in Tile Charts

Tile charts (or treemaps) that are created using the SAS Enterprise Guide tile chart task include a web link to SAS IT Resource Management reports. To add a web link to SAS IT Resource Management reports, use the servlet that SAS IT Resource Management provides. The servlet associates the JAVA-based tile chart classification variables with an ITRM report that has matching BY variables.

Using the servlet, you specify tile chart web link parameters that enable you to drill down from that tile chart to ITRM reports that are stored on the SAS Content Server.

To implement this feature, perform the following steps:

1. Ensure that you have an IT data mart that contains all of the data sources that you want to work with.
2. Open SAS Enterprise Guide and select the information map that you want to work with.
3. Select the tile chart task to define the tile chart report.
   a. Carefully consider the classification variables when you are exploring the data. These values are used to identify the ITRM reports by their BY variables that are used for the tile chart web links.
   b. From the Properties dialog box of the tile chart task, select Results. Set the graph type to JAVA.
   c. Run the report interactively and confirm that the drill down criteria are defined correctly.

The following display shows a tile chart task with two columns identified as classification variables: Date and Machine:
4. Using the same information map data source, create the report that you want to access using web links from the tile chart.
   a. The BY variables of this report must match the class variables that were used in the tile chart.
   b. Run the report interactively and confirm that the BY variables are defined correctly.

The following display shows a pie chart task with two columns identified as BY variables: Date and Machine:

**Display A5.2 Setting Up BY Variables: Date and Machine**

5. When you are satisfied that both reports are defined correctly, add an ITRM report definition task for each report task that you defined. In addition, create the report definitions on the SAS Metadata Server by deploying the ITRM report definition tasks:
a. Carefully consider the report definition names that you specify so that they are easy to identify because you will use them as parameter values in the servlet provided by ITRM.

b. For the ITRM report definition task that is associated with the tile chart, set the graph type to JAVA.

c. Consider using a keyword to help easily find the reports using ITRM Report Center when verifying the report output. You can define your own keyword for this purpose.

6. In the SAS IT Resource Management client, create a report job to run the two report definitions that you created in the previous steps. Run the job interactively and confirm that the report output looks correct. You can use ITRM Report Center to view the reports.

   Note: You can use ITRM Report Center to create a gallery from which you can view the reports.

7. When you are satisfied that the reports that are generated by the report job are correct, use SAS Enterprise Guide to add the web link URL to the tile chart task and redeploy the report definition.

   On the Advanced window of the SAS Enterprise Guide tile chart task, enter a web link label and a URL. The web link label is displayed as the tile chart web link. Specify the URL with the following components:

   • The middle-tier server name where ITRM Report Center is running
   • The case-sensitive SAS IT Resource Management servlet name
   • The case-sensitive SCSRootPath for the SAS IT Resource Management reports to which the tile charts link

   The SCS root path consists of the SAS sasdat path, the ITRM root path, and the folder location where the web link should search for reports.

   • One or more web link parameters

Here is an example:
Middle-tier server name: http://MyMiddleTier.com

Servlet name: ITRMReportCenter/weblink/externalViewReport.jsp

SCSRootPath: /SASContentServer/repository/default/sasav/ITRMRoot/DataMartName_JobName/ITRMReportDefinitionName

Classification and BY variable names (for example, &VariableName1={&1} &VariableName2={&2})

The previous instructions yield this URL: http://MyMiddleTier.com/ITRMReportCenter/weblink/externalViewReport.jsp?SCSRootPath=/SASContentServer/repository/default/sasav/MyRoot/MyDataMart_MyJob/MyReportDefinition&VariableName1={&1}&VariableName2={&2}

8. The following display shows the Advanced dialog box for the tile chart task where the information from the previous step is entered:

Display A5.4  Dialog Box with Updated URL

9. Each SAS Enterprise Guide tile chart with a unique set of web links must be associated with its own report definition. In other words, the following statements apply:

- A tile chart task can have more than one web link.
- All tile charts that are associated with a report definition must share the same (one or more) web links.

The following display shows the resulting tile chart with the web link enabled. When you are right-clicking a tile, the web link launches the SAS IT Resource Management bar chart that meets the established criteria.
Due to known limitations, you must also make a manual format change to any date columns that are used as tile chart classification variables. If you use a DATE column in the tile chart classification list, perform the following steps:

1. Attach a program node task to the same branch.

2. Copy the tile chart task code into the program node. You can open the last submitted code window to access the tile chart-generated code.

3. In the program node code, find the PROC GTILE statement and add a format statement for any date columns that are used as tile chart classification variables. The format statement is `Format Date MMDDYY10.;`.

4. (Optional) To eliminate macro variable warnings, search the code that generates the tile chart for the string `MENUVALUE” = ...`. Replace the double quotation marks around the http parameter with single quotation marks.
5. Navigate to the Properties window of the **program node** task. In the Results section, set the graph type to **JAVA**.

6. Add a manual link from the **import SAS information map** task to the program node task.

7. Right-click to modify the report definition task for the tile chart. On page 2 of the Report Definition Task wizard, deselect the tile chart task, select the program node task, and redeploy the report definition.

The following display shows the result of the previous steps:

**Display A5.8 Remapped Tile Chart Report Definition Task**

8. Rerun your report job interactively and verify that the tile chart drill-down feature works correctly. If you are going to run the job in batch mode, you should deploy or redeploy the job.
# Appendix 6
Report Conversion Guide

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Converting Reports</strong></td>
<td>206</td>
</tr>
<tr>
<td>About Converting Reports</td>
<td>206</td>
</tr>
<tr>
<td>Global and Individual Report Tasks and Options</td>
<td>208</td>
</tr>
<tr>
<td>Stack Columns Task (Reference 1)</td>
<td>210</td>
</tr>
<tr>
<td>Custom User Code to Accumulate Stacked Data (Reference 2)</td>
<td>211</td>
</tr>
<tr>
<td><strong>Creating Bar and Pie Charts Using SAS Enterprise Guide</strong></td>
<td>213</td>
</tr>
<tr>
<td>About Bar and Pie Charts</td>
<td>213</td>
</tr>
<tr>
<td>Bar Chart and Pie Chart Notes</td>
<td>214</td>
</tr>
<tr>
<td>Example 1</td>
<td>216</td>
</tr>
<tr>
<td>Example 2</td>
<td>217</td>
</tr>
<tr>
<td>Example 3</td>
<td>218</td>
</tr>
<tr>
<td>Example 4</td>
<td>219</td>
</tr>
<tr>
<td>Example 5</td>
<td>220</td>
</tr>
<tr>
<td>Example 6</td>
<td>221</td>
</tr>
<tr>
<td>Example 7</td>
<td>222</td>
</tr>
<tr>
<td>Example 8</td>
<td>223</td>
</tr>
<tr>
<td>Example 9</td>
<td>224</td>
</tr>
<tr>
<td><strong>Creating Line and Other Plots Using SAS Enterprise Guide</strong></td>
<td>225</td>
</tr>
<tr>
<td>About Line and Other Plots</td>
<td>225</td>
</tr>
<tr>
<td>Line and Other Plot Notes</td>
<td>226</td>
</tr>
<tr>
<td>Example 10</td>
<td>227</td>
</tr>
<tr>
<td>Example 11</td>
<td>228</td>
</tr>
<tr>
<td>Example 12</td>
<td>229</td>
</tr>
<tr>
<td>Example 13</td>
<td>230</td>
</tr>
<tr>
<td>Example 14</td>
<td>231</td>
</tr>
<tr>
<td>Example 15</td>
<td>232</td>
</tr>
<tr>
<td>Example 16</td>
<td>233</td>
</tr>
<tr>
<td>Example 17</td>
<td>234</td>
</tr>
<tr>
<td>Example 18</td>
<td>235</td>
</tr>
<tr>
<td>Example 19</td>
<td>236</td>
</tr>
<tr>
<td>Example 20</td>
<td>237</td>
</tr>
<tr>
<td><strong>Creating Tabular Reports Using SAS Enterprise Guide</strong></td>
<td>237</td>
</tr>
<tr>
<td>About Tabular Reports</td>
<td>237</td>
</tr>
<tr>
<td>Example 21</td>
<td>239</td>
</tr>
<tr>
<td>Example 22</td>
<td>240</td>
</tr>
<tr>
<td>Example 23</td>
<td>241</td>
</tr>
<tr>
<td>Example 24</td>
<td>242</td>
</tr>
<tr>
<td>Example 25</td>
<td>243</td>
</tr>
<tr>
<td>Example 26</td>
<td>244</td>
</tr>
<tr>
<td>Example 27</td>
<td>245</td>
</tr>
</tbody>
</table>
Converting Reports

About Converting Reports

SAS IT Resource Management incorporates the world-class data management, reporting, and report distribution capabilities that are available from SAS. In previous releases, SAS IT Resource Management relied upon a custom reporting interface to perform the following tasks:

• Summarize data by time periods that were specified at report generation time.
• Define and set report options.
• Generate a specific set of report types.

SAS Enterprise Guide has long been available to SAS IT Resource Management customers as a reporting tool option, but the primary reporting capability was the IT Resource Management report macros. Beginning with SAS IT Resource Management 3.1.1, SAS Enterprise Guide became the primary reporting tool for the SAS IT Resource Management solution. Legacy report macros for SAS IT Resource Management are no longer delivered.

This document provides a guideline for converting reports that are generated by the SAS IT Resource Management 2.7 reporting tools (the report macros) to new and enhanced reports using SAS IT Resource Management 3.2 (and later versions of the solution) and the SAS Enterprise Guide reporting tool.

Here are some similarities between using the SAS IT Resource Management 2.7 reporting tool and using SAS IT Resource Management 3.2 (and later versions of the solution) and SAS Enterprise Guide to generate reports:

• Both reporting tools provide an interface that enables you to generate reports quickly and easily without requiring SAS programming skills.
• Both reporting tools enable you to write and submit SAS code to generate reports.
• Both reporting tools support a variety of SAS graph types and options.
• Both reporting tools generate the SAS code that is necessary to create the desired reports.
• Both reporting tools support the creation of report definitions that can be run in batch mode.

However, there are differences between using the SAS IT Resource Management 2.7 reporting tool and using SAS IT Resource Management 3.2 (and later versions of the solution) and SAS Enterprise Guide to generate reports:

• The SAS IT Resource Management 2.7 reporting tools performed data manipulation tasks that were sometimes time consuming. Whenever possible, data manipulation tasks are now accomplished while data is staged and aggregated by SAS IT Resource Management. This results in information map data sources that are report ready and can serve as input to SAS Enterprise Guide and SAS Web Report Studio.
• SAS Enterprise Guide delivers a user-friendly interface from which a significant set of report tasks and task options are selected. The user interface for SAS Enterprise Guide is far superior to the SAS IT Resource Management 2.7 user interface for report generation.

• SAS Enterprise Guide supports a much larger set of report types and options than those that are available in the SAS IT Resource Management 2.7 report macros. It also offers many data management and analytical procedures that are not available in SAS IT Resource Management 2.7.

SAS Enterprise Guide supports reporting from report-ready data that is accessible through information maps. Using information maps is the recommended method for accessing data in SAS IT Resource Management 3.2 (and later versions of the solution).

The following table shows the SAS IT Resource Management 2.7 macros and the SAS Enterprise Guide tasks that can be used to generate equivalent reports in SAS IT Resource Management 3.2 (and later versions of the solution). Much of the existing functionality that is available through SAS IT Resource Management 2.7 reporting macros is provided by SAS Enterprise Guide. The data manipulation capabilities are now handled by staging and aggregation processes of SAS IT Resource Management.

Table A6.1  SAS Enterprise Guide Report Tasks for SAS IT Resource Management 2.7 Report Macros

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>%CPCHART</td>
<td>Bar chart and pie chart tasks</td>
</tr>
<tr>
<td>%CPCCHRT</td>
<td>Bar chart and pie chart tasks</td>
</tr>
<tr>
<td>%CPPL0T1</td>
<td>Line plot, scatter plot, area plot, and box plot tasks</td>
</tr>
<tr>
<td>%CPPL0T2</td>
<td>Line plot task</td>
</tr>
<tr>
<td>%CPTABRPT</td>
<td>Summary tables task</td>
</tr>
<tr>
<td>%CPPRINT</td>
<td>List data task</td>
</tr>
<tr>
<td>%CPSRCRPT</td>
<td>Program Node task</td>
</tr>
<tr>
<td>%CPG3D</td>
<td>3-D Scatter plot task</td>
</tr>
<tr>
<td>%CPGTP0L0T</td>
<td>Document builder feature</td>
</tr>
<tr>
<td>%CPSETHAX</td>
<td>SAS Enterprise Guide report option for selected reports</td>
</tr>
<tr>
<td>%CPIDTOPN</td>
<td>Information map filter or Query task</td>
</tr>
<tr>
<td>%CPRUNRPT</td>
<td>Stored process feature</td>
</tr>
<tr>
<td>%CPSPEC</td>
<td>Tile chart task</td>
</tr>
</tbody>
</table>
Global and Individual Report Tasks and Options

About Report Tasks and Options
To create reports with SAS Enterprise Guide, use the report task that is associated with the report that you want to create. You can set the options for the report in one of the following three ways:

- Set global options in the Options window. These options apply to all tasks in the SAS Enterprise Guide project.
- Set options in each individual report task.
- Set options in the ITRM Report Definition task when working with report definitions that are to run in batch mode.

The report options and their respective functions are labeled clearly and are described in the Help for SAS Enterprise Guide. Report tasks with similar options use similar Options windows.

Global Report Task Options
In SAS Enterprise Guide, there are a few report task options that can be set for all report tasks in your project. To set one of these options, select Tools ⇒ Options from the menu bar. Then, on the left pane of the Options window, select the category of report options that you want to configure. The following list shows some of the global options that you can set.

- **Graph** enables you to specify the graph format (such as ActiveX or PNG) and graph dimensions (such as height and width).
- **Tasks General** enables you to specify the report title and footnote.
- **Viewer** enables you to specify how you want to view report output (such as SAS Enterprise Guide or your local browser).
- **Custom Code** enables you to specify options related to using custom code.
**Global Color, Pattern, and Symbol Options Using SAS Templates**

In SAS Enterprise Guide, pattern and symbol options can be set at the individual report task level. However, you can set these options once for the entire project using SAS templates and style sheets. Global options can be set using this method and can still be overridden in an individual report task for a specific task. To set these global graph options, perform the following steps:

1. Use SAS to create your custom SAS template.
2. Use SAS Enterprise Guide to create your custom style sheet with the same name as your custom SAS template.
3. Set the custom style sheet as the default style.
4. Run your report tasks.

Reports whose have graph options are not set for the report task will use the colors, patterns, and symbols that are set in your SAS template. For details about how to create a custom SAS Template and style sheet, see “About Templates and Style Sheets” on page 93.

**Individual Report Task Options**

Most report task options are set individually by specifying values for each report task. To set values for the report task options in an individual report task, perform the following steps:

1. Right-click a report task and select **Modify <report task name>**.
2. Select from the various menu options in the left pane, and specify values for the corresponding parameters.

Click **Help** to view the Help on any specific option in the current window.

**Top N and Bottom N Reporting**

In SAS IT Resource Management 2.7, some report types support the Top N and Bottom N reporting option. For other report types, using the macro `%CPIDTOPN` is required.

You can use SAS Enterprise Guide to report on the top or bottom contributors for a specific column in SAS IT Resource Management 3.2 (and later versions of the solution). To do so, you can use a filter to select the top or bottom contributors for a specific rank column that is created when data is aggregated by SAS IT Resource Management. Information map filters can be defined (using Information Map transformations in SAS IT Resource Management or using SAS Information Map Studio) and selected (using the **Filter** tab of the Information Map window) in SAS Enterprise Guide. Filters can also be specified within SAS Enterprise Guide Query tasks.

**Report Output**

In SAS Enterprise Guide, you can generate graph output to the SAS Enterprise Guide window or to a local browser. You can specify your preference by selecting **Tools \* Options** from the menu bar. You can also generate graph output by publishing to a web server or to a file system.

You can use the ITRM Report Definition task to create report definitions that are submitted in report jobs. The report jobs generate reports in the SAS content server and are displayed with ITRM Report Center.

You can also use SAS Management Console to define channels and then select a channel when publishing from SAS Enterprise Guide. In addition, if you use the SAS Report format, a report can be published to a repository and SAS Web Report Studio. For more
information about publishing SAS Enterprise Guide reports, see SAS Enterprise Guide Help.

**Print a Report**

To print a report from the SAS Enterprise Guide window select File ⇒ Print or right-click the SAS Enterprise Guide report window and select Print. You can also use your web browser print capabilities to print reports when viewing them from a browser in SAS Enterprise Guide, SAS Information Delivery Portal, and ITRM Report Center.

**Stack Columns Task (Reference 1)**

The Stack Columns task in SAS Enterprise Guide enables you to stack your data so that multiple columns of data can become multiple rows of data. This step is required for recreating certain charts and plots that are available in SAS IT Resource Management 2.7.

The following example shows where two analysis variables are stacked. Assign the variables from the **Variables to assign** box to the appropriate role in the **Task roles** box.

Next, select **Column Naming** to open the Column Naming window and change the default column names and labels for the new columns that are created. This step is optional. However, changing the default column labels is recommended because they are very long and can cause unexpected errors for some graph types.
For more information about working with the Stack Columns task, see the SAS Enterprise Guide Help.

Custom User Code to Accumulate Stacked Data (Reference 2)

The Stack Columns task in SAS Enterprise Guide enables you to reshape your data so that multiple columns of data can become multiple rows of data. This step is required for re-creating certain charts and plots that are available in SAS IT Resource Management 2.7.

However, custom user code is required if you also want to accumulate the data. This step is required for re-creating stacked plots that are available in SAS IT Resource Management 2.7.

You can add custom user code to the Stack Columns task by selecting **Preview code** ⇒ **Insert Code**. Your custom code must follow the RUN statement that follows the TRANSPOSE procedure code that is generated by SAS Enterprise Guide.

The following image shows the User Code window. You can insert custom user code wherever an “insert code” icon appears. The “insert code” icon at the bottom of the image shows where you should insert your custom user code to accumulate your data.
The custom user code that is required to accumulate your data is a DATA step that accumulates the output from PROC TRANSPOSE. The next display shows a code fragment that includes PROC TRANSPOSE and a DATA step for accumulating your stacked data.

Note that when writing the DATA step, some information is derived from PROC TRANSPOSE. The following information is derived from PROC TRANSPOSE:

- The list of BY variables must equal the list of BY variables of PROC TRANSPOSE.
- The required variable for the FIRST function will be derived from the BY variable list of PROC TRANSPOSE. The variable that is selected determines how your data is accumulated. Use the following rules to determine which variable to select for the FIRST function:
  - If you want to accumulate analysis variables (as shown in “Example 16” on page 233), then select the last BY variable from PROC TRANSPOSE for the FIRST function of your DATA step.
• If you want to accumulate a class variable (as shown in “Example 18” on page 235), then use the next to last BY variable from PROC TRANSPOSE for the FIRST function of your DATA step.

The following example shows how to accumulate an analysis variable.

```
data LAST ;
set LAST ;
by Date Stemam Machine;
retain SaveVal ;
if FIRST Machine then SaveVal = 0 ;
Average = sum/Average SaveVal ;
saveval = Average ;
drop saveval ;
run ;
```

Creating Bar and Pie Charts Using SAS Enterprise Guide

This section discusses the means by which bar and pie charts were created with SAS IT Resource Management 2.7 and the recommended means by which they are created using SAS IT Resource Management 3.2.

About Bar and Pie Charts

The following table shows the eight chart types that are available in SAS IT Resource Management 2.7 and the corresponding SAS Enterprise Guide task that is available to generate those chart types in SAS IT Resource Management 3.2 (and later versions of the solution).

<table>
<thead>
<tr>
<th>Chart Type</th>
<th>SAS Enterprise Guide Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Bar</td>
<td>Bar Chart task</td>
</tr>
<tr>
<td>Horizontal Bar</td>
<td>Bar Chart task</td>
</tr>
<tr>
<td>Vertical Bar 3-D</td>
<td>Bar Chart task</td>
</tr>
<tr>
<td>Horizontal Bar 3-D</td>
<td>Bar Chart task</td>
</tr>
<tr>
<td>Pie</td>
<td>Pie Chart task</td>
</tr>
<tr>
<td>Chart Type</td>
<td>SAS Enterprise Guide Task</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>Pie 3-D</td>
<td>Pie Chart task</td>
</tr>
<tr>
<td>Star</td>
<td>Bar Chart task - Appearance Options, Shape</td>
</tr>
<tr>
<td>Block</td>
<td>Bar Chart task - 3-D vertical bar chart</td>
</tr>
</tbody>
</table>

In SAS Enterprise Guide, the bar orientations (vertical and horizontal) are task subtype options that are available in the Bar Chart task. The bar dimensions (two-dimensional and three-dimensional) are appearance options in the Bar Chart and Pie Chart tasks.

This section provides more details about the SAS IT Resource Management 2.7 macros that create various types of bar and pie charts and the equivalent SAS Enterprise Guide steps that are required to re-create these types of reports.

The `%CPCHART` macro creates the following three bar chart types:
- one analysis column and one class column (“Example 1” on page 216)
- one analysis column, one class column, and one group column (“Example 2” on page 217)
- one analysis column, one class column, and one subgroup column (“Example 3” on page 218)

The `%CPCCHRT` macro creates the following four bar chart types:
- multiple analysis columns (“Example 4” on page 219)
- multiple analysis columns and one group column (“Example 5” on page 220)
- multiple analysis columns, one group column, and one subgroup column (“Example 6” on page 221)
- multiple analysis columns, one group column, and one stack column (“Example 7” on page 222)

The `%CPCHART` macro creates a pie chart of one analysis column and one class column (“Example 8” on page 223).

The `%CPCCHRT` macro creates a pie chart type of multiple analysis columns (“Example 9” on page 224).

The following sections show how to re-create these bar chart and pie chart types using SAS Enterprise Guide.

**Bar Chart and Pie Chart Notes**

Here are some notes that you might consider when working with bar charts and pie charts:

- Do not confuse the **Group bars by** role that is available in some chart tasks, with the **Group charts by** role. The **Group charts by** role is a role that is available in most report tasks. It enables you to create a different report page for each value of the **Group charts by** column.

- The Transpose task can be substituted for the Stack Columns task. For more information about the differences between the Stack Columns task and the Transpose task, see SAS Enterprise Guide Help.
• The graph examples in the following sections typically show two analysis columns wherever multiple analysis columns are supported.

• Some graph titles might refer to SAS IT Resource Management 2.7 terminology to help you make the transition from SAS IT Resource Management 2.7 to SAS IT Resource Management 3.2 (and later versions of the solution). For example, a class column that is assigned to a subgroup role in SAS IT Resource Management 2.7 might be assigned to a stack role in SAS IT Resource Management 3.2 (and later versions of the solution). This technique would achieve the same results.
Example 1

**Bar Chart with One Analysis Column and One Class Column**

1. Select the Bar Chart task.
2. Select the **Simple Vertical Bar** chart type.
3. Assign one analysis column to the **Sum of** role.
4. Assign one class column to the **Column to chart** role.
5. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 2

Bar Chart with One Analysis Column, One Class Column, and One Group Column

1. Select the Bar Chart task.
2. Select the **Grouped Vertical Bar** chart type.
3. Assign one analysis column to the **Sum of** role.
4. Assign one class column to the **Column to chart** role.
5. Assign one class column to the **Group bars by** role.
6. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 3

**Bar Chart with One Analysis Column, One Class Column, and One Subgroup Column**

1. Select the Bar Chart task.
2. Select the *Stacked Vertical Bar* chart type.
3. Assign one analysis column to the *Sum of* role.
4. Assign one class column to the *Column to chart* role.
5. Assign one class column to the *Stack* role.
6. (Optional) Assign one or more class columns to the *Group charts by* role.
Example 4

Bar Chart with Two Analysis Columns

1. Select the Bar Chart task.
2. Select the Multiple Measures Vertical Group chart type.
3. Assign the columns that you want to chart to the Sum of role.
4. (Optional) Assign one or more class columns to the Group charts by role.
Example 5

**Bar Chart with Two Analysis Columns and One Group Column**

1. Select the Bar Chart task.
2. Select the **Multiple Measures Vertical Group** chart type.
3. Assign the columns that you want to chart to the **Sum of** role.
4. Assign one class column to the **Column to chart** role.
5. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 6

**Bar Chart with Two Analysis Columns, One Group Column, and One Subgroup Column**

1. Select the Stack Columns task located in the Data category to transpose your data.
2. Assign the two analysis columns that you want to chart to the **Columns to Stack** role.
3. Assign all of the class columns used in your report (including **Group charts by columns**) to the **Group Analysis by** role.
4. Rename your new column labels. For information about how to do this, see “Stack Columns Task (Reference 1)” on page 210.
5. Run the Stack Columns task to transpose your data.
6. Select the Bar Chart task.
7. Select the **Grouped/Stacked Vertical Bar** chart type.
8. Assign the new transposed analysis column to the **Sum of** role.
9. Assign the new transposed class column to the **Column to chart** role.
10. Assign one class column to the **Group bars by** role.
11. Assign one class column to the **Stack** role.
12. (Optional) Assign one or more class columns to the **Group charts by** role.

**Note:** The difference between this bar chart example and “Example 7” is in the column role assignments.
Example 7

Bar Chart with Two Analysis Columns, One Group Column, and One Stack Column

1. Select the Stack Columns task located in the Data category to transpose your data.
2. Assign the two analysis columns that you want to chart to the Columns to Stack role.
3. Assign all of the class columns used in your report (including Group charts by columns) to the Group Analysis by role.
4. Rename your new column labels. For information about how to do this, see “Stack Columns Task (Reference 1)” on page 210.
5. Run the Stack Columns task to transpose your data.
6. Select the Bar Chart task.
7. Select the Grouped/Stacked Vertical Bar or the Grouped/Stacked Horizontal Bar chart type.
8. Assign the new transposed analysis column to the Sum of role.
9. Assign one class column to the Column to chart role.
10. Assign one class column to the Group bars by role.
11. Assign the new transposed class column to the Stack role.
12. (Optional) Assign one or more class columns to the Group charts by role.

Note: The difference between this bar chart example and “Example 6” on page 221 is in the column role assignments.
Example 8

Pie Chart with One Analysis Column and One Class Column

1. Select the Pie Chart task.
2. Select the Simple Pie chart type.
3. Assign one analysis column to the Sum of role.
4. Assign one class column to the Column to chart role.
5. (Optional) Assign one or more class columns to the Group charts by role.
Example 9

Pie Chart with Two Analysis Columns

1. Select the Stack Columns task located in the Data category to transpose your data.
2. Assign the two analysis columns that you want to chart to the **Columns to Stack** role.
3. Assign all of the class columns used in your report (including **Group charts by** columns) to the **Group Analysis by** role.
4. Rename your new column labels. For information about how to do this, see “Stack Columns Task (Reference 1)” on page 210.
5. Run the Stack Columns task to transpose your data.
6. Select the Pie Chart task.
7. Select the **Simple Pie** chart type.
8. Assign the new transposed analysis column to the **Sum of** role.
9. Assign the new transposed class column to the **Column to chart** role.
10. (Optional) Assign one or more class columns to the **Group charts by** role.
Creating Line and Other Plots Using SAS Enterprise Guide

This section discusses the means by which line and other plots were created with SAS IT Resource Management 2.7. It also discusses the recommended means by which they are created using SAS IT Resource Management 3.2 (and later versions of the solution).

About Line and Other Plots

The following table shows the 15 plot types or options that are available in SAS IT Resource Management 2.7 and the corresponding SAS Enterprise Guide tasks that are available to generate those chart types in SAS IT Resource Management 3.2 (and later versions of the solution).

Table A6.3  SAS IT Resource Management 2.7 Plot Types and Corresponding SAS Enterprise Guide Tasks

<table>
<thead>
<tr>
<th>Plot Type</th>
<th>SAS Enterprise Guide Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>2XY</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Line</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Join</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Needle</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Smooth</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Spline</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Standard Deviation</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Step Center</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Percent</td>
<td>Line Plot task</td>
</tr>
<tr>
<td>Scatter</td>
<td>Scatter Plot task</td>
</tr>
<tr>
<td>Stack</td>
<td>Area Plot task</td>
</tr>
<tr>
<td>Stack Percent</td>
<td>Area Plot task</td>
</tr>
<tr>
<td>Box Plot</td>
<td>Box Plot task</td>
</tr>
<tr>
<td>Hi-Low plot</td>
<td>Box Plot task</td>
</tr>
<tr>
<td>Regression</td>
<td>Various regression plots in the Analyze category of plots</td>
</tr>
</tbody>
</table>
This section provides more detail about the SAS IT Resource Management 2.7 macro that creates various types of plots and the equivalent SAS Enterprise Guide steps that are required to re-create these types of reports.

The `%CPPLOT1` macro is used to create the following plot types:

- one analysis column and one class column as shown in the following examples:
  - line plot ("Example 10" on page 227)
  - step plot ("Example 11" on page 228)
  - box plot ("Example 12" on page 229)
  - hi-low plot ("Example 13" on page 230)
- multiple analysis columns (scatter plot – "Example 14" on page 231)
- multiple analysis columns and one class column as shown in the following examples:
  - line plot ("Example 15" on page 232)
  - line stack plot ("Example 16" on page 233)
- one analysis column, one class column, and one group column as shown in the following examples:
  - line plot ("Example 17" on page 234)
  - line stack plot ("Example 18" on page 235)

The `%CPPLOT2` macro creates a line plot that is named 2XY Plot with Multiple Analysis Columns and One Class Column ("Example 19" on page 236).

**Line and Other Plot Notes**

Here are some notes that you might consider when working with plot reports:

- Do not confuse the Group role that is available in some plot tasks, with the Group charts by role. The Group charts by role is a role that is available in most report tasks. It enables you to create a different report page for each value of the Group charts by column.
- The graph examples in the following sections typically show two analysis columns wherever multiple analysis columns are supported.
Example 10

**Line Plot with One Analysis Column and One Class Column**

1. Select the Line Plot task.
2. Select the Line Plot subtask.
3. Assign one analysis column to the **Vertical** role.
4. Assign one date or time class column to the **Horizontal** role.
5. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 11

Step Plot with One Analysis Column and One Class Column

1. Select the Line Plot task.
2. Select the Step Plot subtask.
3. Assign one analysis column to the Vertical role.
4. Assign one date or time class column to the Horizontal role.
5. (Optional) Assign one or more class columns to the Group charts by role.
Example 12

Box Plot with One Analysis Column and One Class Column

1. Select the Box Plot task.
2. Select the Box Plot subtask.
3. Assign one analysis column to the Vertical role.
4. Assign one date or time class column to the Horizontal role.
5. (Optional) Assign one or more class columns to the Group charts by role.
Example 13

Hi-Low Plot with One Analysis Column and One Class Column

1. Select the Box Plot task.
2. Select the Hi-Low subtask.
3. Assign one analysis column to the **Vertical** role.
4. Assign one date or time class column to the **Horizontal** role.
5. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 14

Scatter Plot with Two Analysis Columns

1. Select the Scatter Plot task.
2. Select any of the Scatter Plot subtasks.
3. Assign one analysis column to the **Vertical** role.
4. Assign one analysis column to the **Horizontal** role.
5. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 15

**Line Plot with Two Analysis Columns and One Class Column**

1. Select the Line Plot task.
2. Select the Multiple vertical column line plots using overlay subtask.
3. Assign two analysis columns to the **Vertical** role.
4. Assign one date or time class column to the **Horizontal** role.
5. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 16

Stack Plot with Two Analysis Columns and One Class Column

1. Select the Stack Columns task located in the Data category to transpose and accumulate your data.

2. Assign the two analysis columns that you want to plot to the Columns to Stack role.

3. Assign all of the class columns used in your report (including Group charts by columns) to the Group Analysis by role.

4. Rename your new column labels. For information about how to do this, see “Stack Columns Task (Reference 1)” on page 210.

5. Insert SAS custom code to accumulate your data. See “Custom User Code to Accumulate Stacked Data (Reference 2)” on page 211.

6. Run the Stack Columns task to transpose and accumulate your data.

7. Select the Area Plot task.

8. Select the Multiple area plots by group column subtask.

9. Assign the new transposed analysis columns to the Vertical role.

10. Assign the new transposed class column to the Group role.

11. Assign one date or time class column to the Horizontal role.

12. (Optional) Assign one or more class columns to the Group charts by role.
**Example 17**

*Line Plot with One Analysis Columns, One Class Column, and One Group Column*

1. Select the Line Plot task.
2. Select the Multiple line plots by group column subtask.
3. Assign one analysis column to the **Vertical** role.
4. Assign one date or time class column to the **Horizontal** role.
5. Assign one class column to the **Group** role.
6. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 18

Stack Plot with One Analysis Columns, One Class Column, and One Group Column

1. Select the Stack Columns task located in the Data category to transpose and accumulate your data.
2. Assign one analysis column that you want to plot to the Columns to Stack role.
3. Assign all of the class columns used in your report (including Group charts by columns) to the Group Analysis by role. Ensure that the class column that you want to accumulate in Step 5 is the last column in the list.
5. Insert SAS Custom Code to accumulate your data. See “Custom User Code to Accumulate Stacked Data (Reference 2)” on page 211.
6. Run the Stack Columns task to transpose and accumulate your data.
7. Select the Area Plot task.
8. Select the Multiple area plots by group column subtask.
9. Assign the new transposed analysis columns to the Vertical role.
10. Assign one date or time class column to the Horizontal role.
11. Assign one class column to the Group role.
12. (Optional) Assign one or more class columns to the Group charts by role.
Example 19

2XY Plot with Two Analysis Columns and One Class Column

1. Select the Line Plot task.
2. Select the Line Plot subtask.
3. Assign one analysis column to the **Vertical** role.
4. Assign one analysis column to the **Vertical (Right)** role.
5. Assign one date or time class column to the **Horizontal** role.
6. (Optional) Assign one or more class columns to the **Group charts by** role.
Example 20

Three-Dimensional Graph
The three-dimensional graph that is available in SAS IT Resource Management 2.7 differs from the three-dimensional graph that is generated with SAS Enterprise Guide. In SAS Enterprise Guide, the columns for the horizontal, vertical, and depth task role must be numeric. In SAS IT Resource Management 2.7, a class column is supported.

You can use the Line Plot task in SAS Enterprise Guide to generate a plot that shows all of the information that is available in the three-dimensional graph from SAS IT Resource Management 2.7. To create this graph, see “Example 17” on page 234.

Creating Tabular Reports Using SAS Enterprise Guide

This section discusses the means by which tabular reports were created with SAS IT Resource Management 2.7 and the recommended means by which they are created using SAS IT Resource Management 3.2.

About Tabular Reports
The following table shows the six tabular report types that are available in SAS IT Resource Management 2.7 and the corresponding SAS Enterprise Guide task that is available to generate those report types in SAS IT Resource Management 3.2 (and later versions of the solution).
Table A6.4  SAS IT Resource Management 2.7 Report Types and Corresponding SAS Enterprise Guide Tasks

<table>
<thead>
<tr>
<th>Tabular Report Type</th>
<th>SAS Enterprise Guide Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis X Statistic</td>
<td>Summary Tables task</td>
</tr>
<tr>
<td>Class (value) X Analysis (Statistic)</td>
<td>Summary Tables task</td>
</tr>
<tr>
<td>Class (value) X Statistic (Analysis)</td>
<td>Summary Tables task</td>
</tr>
<tr>
<td>Class (value) X Analysis (Sum)</td>
<td>Summary Tables task</td>
</tr>
<tr>
<td>Class values X Class (Analysis (Statistic))</td>
<td>Summary Tables task</td>
</tr>
<tr>
<td>Class values X Analysis (Statistic)</td>
<td>Summary Tables task</td>
</tr>
</tbody>
</table>

SAS IT Resource Management 2.7 uses the macro %CPTABRPT to create all of the variations that are shown in the preceding table. In SAS Enterprise Guide, you can create any of these variations with the Summary Tables task.

The following examples show the report output and the Summary Tables task for each of the preceding variations. To create any of the reports in examples 21–27, perform the following steps:

1. Select the Summary Tables task located in the Describe menu.
2. In the Task Roles window, assign the analysis columns that you want to include in your report to the Analysis columns task role.
3. In the Task Roles window, assign the class columns that you want to include in your report to the Classification columns task role.
4. In the Summary Tables window, drag and drop the analysis columns and the classification columns to the appropriate section of the Box Area. The second display of each example below provides a guide for where to drag and drop the variables.
5. (Optional) In the Task Roles window, assign one or more class columns to the Pages role.
Example 21

Tabular Report Analysis X Statistic

![Tabular Report Analysis X Statistic]

Generated on September 01, 2009 at 3:17 PM
Example 22

Tabular Report Class (Value) X Analysis (Statistic)

Generated on September 01, 2009 at 3:17 PM
Example 23

Tabular Report Class (Value) X Statistic (Analysis)

Single Class Variable, Multiple Statistics, Multiple Analysis Variables

<table>
<thead>
<tr>
<th>Machine</th>
<th>Mean</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BytesIn</td>
<td>BytesOut</td>
</tr>
<tr>
<td>Machine1</td>
<td>21.45</td>
<td>9.57</td>
</tr>
<tr>
<td>Machine2</td>
<td>21.62</td>
<td>9.59</td>
</tr>
<tr>
<td>Machine3</td>
<td>21.78</td>
<td>9.23</td>
</tr>
</tbody>
</table>

Generated on September 01, 2009 at 3:17 PM
Example 24

**Tabular Report Class (Value) X Analysis (Sum)**

<table>
<thead>
<tr>
<th>Machine</th>
<th>BytesIn Sum</th>
<th>BytesOut Sum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine1</td>
<td>3860.44</td>
<td>1794.27</td>
</tr>
<tr>
<td>Machine2</td>
<td>3892.05</td>
<td>1726.17</td>
</tr>
<tr>
<td>Machine3</td>
<td>3920.70</td>
<td>1661.09</td>
</tr>
</tbody>
</table>

Generated on September 01, 2009 at 3:17 PM
Example 25

Tabular Report Class Values X Class (Analysis (Statistic))

<table>
<thead>
<tr>
<th>Machine</th>
<th>Site1</th>
<th>Site2</th>
<th>Site3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BytesIn</td>
<td>BytesOut</td>
<td>BytesIn</td>
</tr>
<tr>
<td></td>
<td>Sum</td>
<td>Mean</td>
<td>Sum</td>
</tr>
<tr>
<td>Machine</td>
<td>1238.70</td>
<td>21.48</td>
<td>627.56</td>
</tr>
<tr>
<td>Machine1</td>
<td>1364.39</td>
<td>20.91</td>
<td>591.20</td>
</tr>
<tr>
<td>Machine2</td>
<td>1350.13</td>
<td>22.50</td>
<td>553.78</td>
</tr>
</tbody>
</table>

Generated on September 01, 2009 at 3:17 PM
Example 26

**Tabular Report Class Values X Analysis (Statistic)**

<table>
<thead>
<tr>
<th>SiteName</th>
<th>Machine</th>
<th>BytesIn</th>
<th></th>
<th>BytesOut</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Mean</td>
<td>Sum</td>
<td>Mean</td>
<td>Sum</td>
</tr>
<tr>
<td>Site1</td>
<td>Machine1</td>
<td>21.48</td>
<td>1298.70</td>
<td>10.46</td>
<td>627.56</td>
</tr>
<tr>
<td></td>
<td>Machine2</td>
<td>20.91</td>
<td>1254.89</td>
<td>9.85</td>
<td>601.20</td>
</tr>
<tr>
<td></td>
<td>Machine3</td>
<td>22.50</td>
<td>1350.13</td>
<td>9.23</td>
<td>653.78</td>
</tr>
<tr>
<td>Site2</td>
<td>Machine1</td>
<td>21.97</td>
<td>1318.39</td>
<td>10.04</td>
<td>602.42</td>
</tr>
<tr>
<td></td>
<td>Machine2</td>
<td>22.95</td>
<td>1322.76</td>
<td>9.81</td>
<td>688.57</td>
</tr>
<tr>
<td></td>
<td>Machine3</td>
<td>22.52</td>
<td>1351.47</td>
<td>9.19</td>
<td>651.54</td>
</tr>
<tr>
<td>Site3</td>
<td>Machine1</td>
<td>20.89</td>
<td>1253.36</td>
<td>9.40</td>
<td>604.30</td>
</tr>
<tr>
<td></td>
<td>Machine2</td>
<td>21.91</td>
<td>1314.40</td>
<td>9.11</td>
<td>646.30</td>
</tr>
<tr>
<td></td>
<td>Machine3</td>
<td>20.32</td>
<td>1219.09</td>
<td>9.25</td>
<td>655.76</td>
</tr>
</tbody>
</table>

Generated on September 01, 2009 at 3:17 PM
**Example 27**

**Print Report**
SAS IT Resource Management 2.7 uses the macro `%CPPRINT` to create print reports. In SAS Enterprise Guide, you can create a print report, known as a listing report, using the List Data task that is available in the **Describe** category of report tasks.

To create a print report, perform the following steps:

1. Select the List Data task that is located in the **Describe** category of report tasks.
2. In the **Task Roles** box, assign the analysis columns and classification columns that you want to include in your report to the **List columns** task role.
3. (Optional) In the **Task Roles** box, assign one or more class columns to the **Page by** role.
Example 28

Source Code
SAS IT Resource Management 2.7 uses the macro %CPSRCRPT to submit SAS code that is stored in a catalog source file. In SAS Enterprise Guide, you submit SAS code by creating and submitting a Program node task. The code that you write is saved in the task within the SAS Enterprise Guide project.

To create a Code task to run source code, perform the following steps:
1. Select File ➔ New ➔ Code from the menu bar.
2. Enter your SAS code in the Code window.
3. Right-click and select Run to submit the code.

Working with SAS IT Resource Management

Dynamically Summarized Reporting
SAS IT Resource Management 3.2 and later versions of the solution enable you to perform all of the data transformations that are necessary to produce analysis and report-ready data before generating reports. You can use the SAS technologies that are available in the SAS IT Resource Management client that are specifically designed for data integration to prepare IT data for analysis and reporting. This improves the performance of SAS IT Resource Management reporting and the system as a whole.

In earlier versions of SAS IT Resource Management, the performance data warehouse (PDB) structure limited the solution to predefined time period summarizations. In response, SAS IT Resource Management 2.7 reporting macros evolved to perform special time-based summarizations that were calculated at the time of report generation. In SAS IT Resource Management 3.2 (and later releases of the solution), the IT data mart structure replaces the PDB and enables you to summarize data by means of transformations. Therefore, dynamic summarization capabilities are no longer provided by the %CP report macros.

The SAS IT Resource Management Adapter Setup wizard provides several of the summarized aggregations that were typically created at the time of report generation by SAS IT Resource Management 2.7 report macros.

SAS IT Resource Management 3.2 (and later releases of the solution) include formulas that support various time periods. By choosing the aging columns for your summarized aggregations that use these new formulas, you can create summarized aggregations that provide the equivalent dynamic summarization that is available in SAS IT Resource Management 2.7 reporting. For more information about creating custom aggregations, see the “Creating Aggregation Tables with the Summarized Aggregation Table Wizard” topic in the SAS IT Resource Management: Administrator’s Guide.

Working with Migrated PDBs
With few exceptions, column names and labels are preserved when migrating a SAS IT Resource Management 2.7 PDB to an IT data mart in SAS IT Resource Management 3.2
(and later releases of the solution). Therefore, user-written SAS code that is not dependent on SAS IT Resource Management 2.7 report macros can be submitted to re-create existing reports with minimal changes.

Here are a few tips for re-creating existing reports:

- The DATETIME column that was required in SAS IT Resource Management 2.7 is no longer required in SAS IT Resource Management 3.2 (and later releases of the solution). In summarized aggregations, the columns DAYDATE, WEEKDATE, MONTHDATE, and YEARDATE are used instead. The labels for these columns are Date, StartOfWeek, StartOfMonth, and StartOfYear, respectively.

- Table names have changed. The level name is now appended to the original name. For example, a table with the original name SARDEV in the DETAIL library is now named SARDEV_DETAIL.

- Additional columns are created in the staged table to convert COUNT, TIME, and TIMETICKS type variables into rates. The rate variables are what should be specified in the summarized aggregation for computing statistics that are compatible with SAS IT Resource Management 2.7 reporting.

For more details about these changes and for more information about migrating PDBs and working with migrated PDBs, see the *SAS IT Resource Management: Migration Guide*. 
Index

**Numbers**
2XY plots  
   example 236  
   standards 166

**A**
Adapter Setup wizard 10  
   defined 19  
   deploying and running jobs 23  
   domain categories 24  
   Performance Report transformations  
      created 78  
      report jobs 20, 72  
      report types created 25  
   using 20  
   adapters 4  
   axis standards for reports 164

**B**
backups  
   data and reports 196  
   reports on SAS Content Server 111  
   bar chart standards 167  
   Bar Chart task 213  
      examples 216  
   bar line standards 167  
   batch reporting 10  
   creating new reports from scratch 42  
   creating or modifying batch reports 31  
   designing reports 195  
   modifying data sources 32  
   modifying report definitions 38  
   modifying the appearance of batch reports 34  
   style sheets for 95  
   templates 95  
   using a supplied project as a template 40  
   viewing reports 25  
   box plot standards 167  
   Box Plot task examples 229  
   BY variables in reports 165

**C**
color standards for reports 164  
   converting reports 206

**D**
data sources  
   modifying for batch reporting 32  
   specifying location 92  
   documentation  
      SAS Add-In for Microsoft Office 142  
      SAS BI Dashboard 149  
      SAS Enterprise Guide 131  
      SAS Information Delivery Portal 146  
      SAS Web Report Studio 137  
   domain categories 24  
   dynamically summarized reporting 246

**F**
fonts and formats for reports 165  
   footnotes for reports 163

**H**
Help  
   SAS Add-In for Microsoft Office 142  
   SAS BI Dashboard 149  
   SAS Enterprise Guide 131  
   SAS Information Delivery Portal 146  
   SAS IT Resource Management 6  
   SAS Web Report Studio 137  
   Hi-Low subtask 230
I
information maps
creating reports in SAS Web Report Studio 135
for batch reporting 12
modifying for batch reporting 32
naming conventions 155
interactive reporting 127
IT data marts
accessing with SAS Enterprise Guide 130
ITRM Report Center 5
cache 118
copying and e-mailing reports 105
logging on 100
organizing reports 102
overview 97
viewing reports 103
ITRM Report Definition task
accessing and navigating 62
deleting user-defined report filter values 69
for batch reporting 12
managing user-defined report filters 67
modifying report definitions 70
sharing user-defined report filter values 69
working with in SAS Enterprise Guide 61

L
line plot standards 166
Line Plot task 225
examples 227, 232, 234, 236
list data standards for reports 167
listing report example 245

M
Microsoft Office 5, 139
migration wizard 52
prerequisites 52
running 52

N
naming conventions
information maps 155
Performance Report transformations 81, 159
report jobs 159
reporting 155, 159
SAS Enterprise Guide projects 158
needle plot standards 166

O
online Help
See Help
options for report tasks 208
output for reports 209

P
PDBs 246
Performance Report transformations 13, 76
adding to report jobs 78
created by Adapter Setup wizard 78
deleting 92
editing 91
editing properties 74
naming conventions 81, 159
properties 77
Pie Chart task 213
examples 223
plots 225
portal
See SAS Information Delivery Portal
print report example 245
printing reports 210
projects, SAS Enterprise Guide 45, 192
publishing reports 142

R
reference line standards for reports 165
report definitions 12
creating with ITRM Report Definition task 61
modifying for batch reports 38
modifying with ITRM Report Definition task 70
report jobs 13, 71
adding Performance Report transformations 78
copying 74
created by Adapter Setup wizard 20, 72
creating 73
deleting 75
deploying and running 75
modifying 74
naming conventions 159
scheduling 196
report tasks 207
Bar Chart 213
Hi-Low 230
Line Plot 225
options 208
Pie Chart 213
Stack Columns 210, 233
Step Plot 228
Index 251

reporting
batch 10
dynamically summarized 246
interactive 127
naming conventions 155, 159
standards 161
Top N and Bottom N 209

reports
2XY plot standards 166
axis standards 164
backing up 187
backing up on SAS Content Server 111
bar chart standards 167
bar line standards 167
box plot standards 167
BY variables in 165
color standards 164
converting 206
copying 105
created by Adapter Setup wizard 25
creating new batch reports from scratch 42
creating with information maps in SAS Web Report Studio 135
designing for batch jobs 195
duplicate 184
e-mailing 105, 136
fonts and formats 165
footnotes 163
generating with SAS Enterprise Guide projects 46
interactive 127
line plot standards 166
list data standards 167
managing user-defined settings for filters 67
missing 181, 182
modifying in SAS Enterprise Guide projects 58
needle plot standards 166
organizing 102
output 13, 209
overriding expiration dates 196
printing 210
publishing 142
purging from SAS Content Server 196
reference line standards 165
running during low usage periods 189
standards 161
symbol standards 165
titles 162
viewing 103

S
SAS Add-In for Microsoft Office 5, 139
SAS BI Dashboard 5, 147
documentation 149
Help 149
logging on 148
SAS Business Intelligence Platform 5
SAS Content Server 110
backing up reports 111
duplicate reports 184
purging reports 196
storage of report output 13, 110
SAS Data Integration Studio 4
SAS Enterprise Guide 5, 129
accessing IT data marts 130
accessing SAS IT Resource Management projects 130
accessing SAS Metadata Repository 50
documentation 131
Help 131
managing projects 192
migrating projects 52
modifying reports in supplied projects 58
naming conventions for projects 158
preparing to work 50
projects for batch reporting 12, 36
report tasks 207
running source code 246
setting up for ITRM data 50
starting 129
working with ITRM Report Definition task 61
working with supplied projects 45
SAS High Performance Forecasting 6
SAS Information Delivery Portal 5, 143
accessing 143
documentation 146
Help 146
logging off 144
organization of content 144
SAS Information Map Studio 5
SAS IT Resource Management
accessing data with SAS Add-In for Microsoft Office 140
accessing projects with SAS Enterprise Guide 130
benefits 4
defined 3
Help 6
operation 4
SAS Metadata Repository 5
accessing for SAS Enterprise Guide 50
SAS Statistics and Econometric Time Series 6
SAS Web Report Studio 5, 133
creating reports with information maps 135
documentation 137
Help 137
logging on 133
Scatter Plot task example 231
scheduling report jobs 196
source code
running in SAS Enterprise Guide 246
Stack Columns task example 210
example 233
Stack Plot task examples 235
standards for reporting 161
Step Plot subtask 228
stored processes 141
style sheets 93
default 94
for batch reports 95
symbol standards for reports 165

tabular reports 237
examples 239
templates 93
default 93
for batch reports 95
for color, pattern, and symbol options 209
three-dimensional graph example 237
tile charts with web links 195
titles for reports 162
Top N and Bottom N reporting 209
troubleshooting
duplicate reports on SAS Content Server 184
middle-tier connection 185
reports missing from ITRM Report Center 181
reports missing when running report jobs 182
SAS Content Server 184
user permissions 179

W
web links for tile charts 195